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About This Guide

The Novell Vibe 4 Installation Guide covers the installation and configuration of Novell Vibe. The
guide is divided into the following sections:

¢ Part I, “Product Overview,” on page 11

+ Chapter 3, “What's New in Vibe 4.0,” on page 33

+ Part Il, “Basic Installation,” on page 37

+ Part lll, “Advanced Installation and Reconfiguration,” on page 89
+ Part IV, “Multi-Server Configurations and Clustering,” on page 123
+ PartV, “Upgrade,” on page 163

+ Part VI, “Migrate,” on page 191

+ Part VII, “Appendixes,” on page 201

Audience

This guide is intended for Novell Vibe administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the comment on this topic feature at the bottom of each page
of the online documentation.

Documentation Updates

For the most recent version of this manual, visit the Novell Vibe 4 Documentation website (http://
www.novell.com/documentation/vibe4).

Additional Documentation

You can find more information in the Novell Vibe documentation, which is accessible from the Novell
Vibe 4 Documentation website (http://www.novell.com/documentation/vibe4).

To access the Novell Vibe User Guide from within Vibe, click the Settings icon, then click Help.

About This Guide
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I Product Overview

+ Chapter 1, “What Is Novell Vibe?,” on page 13
+ Chapter 2, “Vibe System Requirements,” on page 17
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12 Novell Vibe 4.0 Installation Guide



1.1

111

1.1.2

What Is Novell Vibe?

Novell Vibe is an enterprise collaboration tool designed to increase individual productivity, team
effectiveness, and organizational success by providing the right set of tools to the right people.
+ Section 1.1, “Vibe Capabilities,” on page 13
+ Section 1.2, “Vibe Components,” on page 14

+ Section 1.3, “Vibe Configurations,” on page 15

Vibe Capabilities
Novell Vibe users fall into three basic groups:

¢ Section 1.1.1, “Content Consumers,” on page 13
+ Section 1.1.2, “Content Providers,” on page 13

¢ Section 1.1.3, “Administrators,” on page 14

Content Consumers

Content consumers use Novell Vibe to work with important information that pertains to them. Content
consumers:

+ Maintain their personal workspaces, including setting up a personal Blog, Calendar, Files,
Guestbook, Photo Album, and Tasks folder

+ Participate in team workspaces set up for content providers, in order to better collaborate with
colleagues and facilitate their work assignments

+ Search the Vibe site for people, places, and other information that pertains to their personal work
assignments

+ |dentify subject-matter experts to assist them in their personal work assignments
The typical tasks performed by content consumers are covered in the Novell Vibe 4.0 User Guide.

In many cases, content consumers quickly become content providers.

Content Providers

Content providers use Novell Vibe to create and manage teams, customize the Vibe environment,
and import data into the Vibe site for use by other Vibe users. Content providers:

+ Create and manage team workspaces and folders

+ Control user access to their team workspaces

+ Establish unique branding for workspaces and folders to clearly differentiate them from other
places on the Vibe site

+ Create landing pages for workspaces that consolidate the most necessary workspace
information into a single page

What Is Novell Vibe?
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14

1.2

12.1

1.2.2

+ Customize data entry forms for gathering information from users
+ Create workflows to automate otherwise time-consuming manual processes

The typical tasks performed by content providers are covered in the Novell Vibe 4.0 User Guide.

Administrators

A Novell Vibe administrator is responsible for installing the Vibe software and setting up the Vibe site.
This Novell Vibe 3.4 Installation Guide provides instructions for Vibe software installation. After
installation, the Vibe site administrator can:

+ Set up user access to the Vibe site

+ Create initial workspaces and populate them with information that is of interest to Vibe users

+ Control user access to workspaces and folders

+ Configure email integration, so that Vibe users can receive notifications of updated information
on the Vibe site and post to the Vibe site by using email messages

+ Set up mirrored folders to make large sets of data that are already available on disk more easily
available through the Vibe site

+ Set up software extensions (add-ons) that enhance the power and usefulness of the Vibe site

+ Set up remote applications that deliver data from a remote location, such as a remote database,
for easy access on your Vibe site

+ Manage users, workspaces, and folders as the Vibe site grows and evolves
+ Perform regular backups to safeguard the data stored in the Vibe site

The typical tasks performed by Vibe site administrators are covered in the Novell Vibe 4.0
Administration Guide.

Vibe Components

A Novell Vibe site consists of four major components:

+ Section 1.2.1, “Vibe Software,” on page 14
+ Section 1.2.2, “Vibe Database,” on page 14
+ Section 1.2.3, “Vibe File Repository,” on page 15

¢ Section 1.2.4, “Lucene Index,” on page 15

Vibe Software

The Vibe software is a customized version of Apache Tomcat. This software provides the web-based
functionality you use as you access the Vibe site through your web browser.

Vibe Database

The Vibe database is used for storing the following information about the Vibe site and its users:

¢ Structural information about workspaces, folders, and entries (for example, their location in the
workspace tree)

Novell Vibe 4.0 Installation Guide


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo

1.2.3
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1.3

+ |dentification information about workspaces, folders, and entries (for example, titles,
descriptions, dates of creation/modification, and users associated with creation/modification)

+ User profile information (for example, full name, phone number, and email address)

The Vibe database disk space requirements are relatively modest, because the database is not used
for storing files.

Vibe File Repository

The Vibe file repository holds all files that are imported into Vibe, information related to the imported
files (such as thumbnails and HTML renderings), and the search engine index.

The Vibe file repository disk space requirements depend on the size of the Vibe site. For a large Vibe
site, disk space requirements can be substantial.

Lucene Index
The Lucene Index Server is a high-performance Java search engine. The Lucene index contains

pointers to the actual data stored in the Vibe file repository. The index enables the Lucene search
engine to perform very fast searches through large quantities of Vibe data.

Vibe Configurations

You can configure Novell Vibe to run on a single server or multiple servers, depending on the size and
needs of your Vibe site.

Configuration Description

Single Server By default, the Vibe Installation program installs all Vibe components on the same
server.

Remote Database For better performance and scalability, you can install the Vibe database on a remote

Server server.

Remote Lucene Index For better performance and scalability, you can install the Lucene index on a remote
Server server.

Multiple Vibe Servers By running Novell Vibe on multiple servers, you can achieve high availability, including
failover and load balancing, depending on how you configure your servers.

Multiple Remote Your Novell Vibe site depends on the Lucene Index Server for full functionality.

Lucene Servers Running multiple Lucene Index Servers provides high availability, so that if one Lucene
Index Server goes down, Vibe users can still access the Vibe site because other
Lucene Index Servers are still available.

Multiple Remote Each of the three databases supported by Vibe has its own approach to clustering the
Database Servers database server. Information about clustering database servers is available on the
Internet.

For more information about which configuration type will best achieve the needs of your organization,
see Section 2.6, “Recommended Hardware Configurations Based on System Performance,” on
page 24.

For more information about how to set up these configurations, see Part IV, “Multi-Server
Configurations and Clustering,” on page 123.

What Is Novell Vibe? 15
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Vibe System Requirements

You, as a Novell Vibe site administrator, must ensure that your system meets Vibe system
requirements, so that your Vibe site can be set up successfully. After your Vibe site is set up, you
must ensure that users’ browsers and office applications meet Vibe user requirements, so that users
can access the Vibe site successfully.

+ Section 2.1, “Vibe Server Requirements,” on page 17

¢ Section 2.2, “Vibe User Requirements,” on page 20

¢ Section 2.3, “Desktop Requirements,” on page 22

¢ Section 2.4, “Mobile Requirements,” on page 22

¢ Section 2.5, “Supported Environments,” on page 23

+ Section 2.6, “Recommended Hardware Configurations Based on System Performance,” on

page 24

For the latest system requirements details, see the Novell Vibe 4 Readme (http://www.novell.com/
documentation/vibe4/vibe4 _readme_novell/data/vibe4 _readme_novell.html).

2.1 Vibe Server Requirements

¢ Section 2.1.1, “Hardware Requirements,” on page 17

¢ Section 2.1.2, “Operating System Requirements,” on page 18

¢ Section 2.1.3, “Database Server Requirements,” on page 18

+ Section 2.1.4, “Java Developer Kit (JDK) Requirements,” on page 19

¢ Section 2.1.5, “Java Cryptography Extension (JCE) Requirements,” on page 19
+ Section 2.1.6, “Directory Service Requirements,” on page 19

¢ Section 2.1.7, “Disk Space Requirements,” on page 20

¢ Section 2.1.8, “Other Requirements,” on page 20

2.1.1 Hardware Requirements

Item Requirement

Processor * x86-32 or x86-64
¢ Minimum 2 GHz

* Multi-CPU systems preferred

Server Memory + Atleast 3 GB RAM for an x86-32 processor
+ Atleast 4 GB RAM for an x86-64 processor
See Section 2.6, “Recommended Hardware Configurations Based on

System Performance,” on page 24 and Section 4.2.3, “Vibe Server Memory,”
on page 41.
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2.1.2 Operating System Requirements

Platform Requirement

Linux + Novell Open Enterprise Server 11 or later, plus the latest Support Pack

¢ SUSE Linux Enterprise Server (SLES) 11 or SLES 12, plus the latest
Support Pack

When using the MySQL database on SLES 12, MySQL is not
automatically patched. In this environment, you need to patch MySQL
manually.

NOTE: On SLES, the X Window System is required by the GUI Vibe
installation program. However, it is not required in order to run Vibe after
installation, or for text-based installations or silent installations.

Windows + Windows Server 2008, or Windows Server 2012, plus the latest Service
Pack

* Windows Server 2008R2, or Windows Server 2012R2, plus the latest
Service Pack

See Section 2.5.4, “Virtualization Support,” on page 23 for information about support for running Vibe
in a virtualized environment.

2.1.3 Database Server Requirements

Platform Requirement

Linux + MySQL 5.1 or later server and client

NOTE: MySQL is included with SLES, but you need to install and configure
it. For more information, see Section A.3, “MySQL Database Server,” on
page 206.

+ Oracle 11g or Oracle 12c

Windows + MySQL 5.1 or later server and tools

+ Microsoft SQL Server 2012 or SQL Server 2014, plus the latest Service
Pack

* Microsoft SQL Server 2008R2 or SQL Server 2012R2, plus the latest
Service Pack

+ Oracle 11g or Oracle 12c

More information about MySQL is available in Section A.3, “MySQL Database Server,” on page 206.
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2.14

2.15

2.1.6

Java Developer Kit (JDK) Requirements

Platform Requirement

Linux + |IBM JDK (latest version)

Java scripting must be enabled for proper Vibe site functionality.

+ Oracle JDK (latest version)

Windows + Oracle JDK (latest version)

More information about JDKs is available in “Java Development Kit (JDK)” in Appendix A, “Vibe
System Requirements Assistance,” on page 203.

Java Cryptography Extension (JCE) Requirements

Platform Requirement
Linux * Unrestricted SDK JCE policy files
Windows + Unrestricted SDK JCE policy files

More information about JDKs is available in “Java Cryptography Extension (JCE)” in Appendix A,
“Vibe System Requirements Assistance,” on page 203.

Directory Service Requirements

Platform Requirement

Linux Novell eDirectory 8.8 or later, plus the latest Support Pack

For information about eDirectory, see the Novell eDirectory 8.8 Documentation
website (http://www.novell.com/documentation/edir88).

Windows Microsoft Active Directory, plus the latest Service Pack; or Novell eDirectory 8.8 or
later, plus the latest Support Pack

For information about Active Directory, see Windows Server 2003 Active Directory
(http://www.microsoft.com/windowsserver2003/technologies/directory/
activedirectory) or Windows Server 2008 Active Directory (http://
www.microsoft.com/windowsserver2008/en/us/active-directory.aspx).

Vibe System Requirements
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2.1.7 Disk Space Requirements

Item

Requirement

Vibe software

Database server software

Vibe file repository

Database content

At least 500 MB for a new installation

When you update an existing Vibe system, ensure that your server has at
least twice the amount of disk space available in the following directory, plus
an additional 500 MB:

Linux: /var/opt/novell/teaming
Windows: c:\Program Files\Novell\Teaming
At least 500 MB for a new installation

When you update an existing Vibe system, ensure that your server has at
least twice the amount of disk space available in the following directory, plus
an additional 500 MB:

Linux: /var/opt/novell/teaming
Windows: c:\Program Files\Novell\Teaming
Depends on the anticipated size of the Vibe site
Substantially less than the Vibe file repository

See Section 4.6, “Planning the Vibe Database,” on page 48 to plan for the
disk space needs of your Vibe site.

2.1.8 Other Requirements

Requirement

Additional Information

Tomcat 7.0.55

TrueType fonts

Tomcat 7.0.55 is included with Vibe on Linux and Windows.

If you are installing Vibe in a non-GUI Linux environment, you might need to
manually install the TrueType fonts if they are not already installed. TrueType
fonts enable Stellent converters to function properly for document conversions.
For more information, see “Understanding and Configuring Document
Conversions with Oracle Outside-In Technology” in the Novell Vibe 4.0
Administration Guide.

2.2 Vibe User Requirements

+ Section 2.2.1, “Browser Requirements,” on page 21

+ Section 2.2.2, “Office Application Requirements,” on page 21

+ Section 2.2.3, “Collaboration Client Requirements,” on page 21
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2.2.1 Browser Requirements

Platform Requirement
Linux Mozilla Firefox (latest version); Google Chrome (latest version)
Windows Microsoft Internet Explorer 9, 10, or 11 (must not have the Google Chrome

Frame plug-in installed); Mozilla Firefox (latest version); Google Chrome
(latest version)

Mac Safari (latest version); Mozilla Firefox (latest version); Google Chrome (latest
version)

IMPORTANT: When using the Google Chrome browser, the following functionality is not available:

+ The ability to edit documents in place (as described in “Editing Files” in the Novell Vibe 4.0 User
Guide)

+ The workflow graphical designer

For more information about these issues, see “Edit-in-Place and Other Applets No Longer Work on
Chrome” (https://www.novell.com/documentation/vibe4/vibe4 _readme_novell/data/
vibed4_readme_novell.html#blav62tv) in the Novell Vibe 4.0 Readme (https://www.novell.com/
documentation/vibe4/vibe4 _readme_novell/data/vibe4 _readme_novell.html#)

2.2.2 Office Application Requirements

Platform Requirement

Linux OpenOffice.org/LibreOffice (latest version)

Windows Microsoft Office 2010 or later; OpenOffice.org/LibreOffice (latest version)
Mac Microsoft Office for Mac 2011; OpenOffice.org/LibreOffice (latest version)

OpenOffice and LibreOffice are used synonymously throughout the Novell Vibe documentation.
Functionality and issues that apply to OpenOffice also apply to LibreOffice.

2.2.3 Collaboration Client Requirements

Platform Requirement

Linux * GroupWise 2014 with the latest Support Pack
* GroupWise 2012 with the latest Support Pack

Windows + GroupWise 2014 with the latest Support Pack
* GroupWise 2012 with the latest Support Pack
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2.3

2.4

24.1

2.4.2

Desktop Requirements

You can download Windows and Mac desktop applications that allow you to work with Vibe files
directly from the file system on your computer. The following operating systems are supported:

Platform Requirement
Windows Windows 7 and later
Mac Mac OSX 10.9 and later

Mobile Requirements

You can download a native application for your iPhone, iPad, Android, or BlackBerry device. These
applications have a more polished user interface and don’t require you to sign in each time you
access Vibe. However, the mobile app for Vibe does not store information on your device; information
can be viewed only when you have an Internet connection.

Other devices can access the Vibe mobile interface by using a mobile browser that meets the
requirements listed in Section 2.4.2, “Mobile Browser Requirements,” on page 22.

¢ Section 2.4.1, “Mobile App Requirements,” on page 22
+ Section 2.4.2, “Mobile Browser Requirements,” on page 22

Mobile App Requirements

Novell Vibe mobile apps are available for the following mobile operating systems:

+ iOS (native application is available for both the iPhone and iPad for a free download in the Apple
App Store--for iOS 7 or later)

+ Android (native application is available for a free download in the Google Play App Store--
formerly known as the Android Market--for Android 2.3 or later)

+ Windows Phone 8.1

+ Kindle Fire (native application is available for a free download in the Amazon Appstore for
Android)

+ BlackBerry Z10 and PlayBook (native application is available for a free download in the
BlackBerry World store)

Ensure that your device’s browser meets the requirements described in Section 2.4.2, “Mobile
Browser Requirements,” on page 22.

Mobile Browser Requirements

To access Vibe from a browser on a mobile device, your device’s browser must support the following:

¢ HTML 4
+ JavaScript
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2.5

2.5.1

2.5.2

2.5.3

254

Supported Environments

+ Section 2.5.1, “File Viewer Support,” on page 23

+ Section 2.5.2, “IPV6 Support,” on page 23

¢ Section 2.5.3, “Clustering Support,” on page 23

+ Section 2.5.4, “Virtualization Support,” on page 23

+ Section 2.5.5, “Single Sign-On Support,” on page 24

+ Section 2.5.6, “Linux File System Support,” on page 24

File Viewer Support

In Novell Vibe, file viewing capabilities are provided by Oracle Outside In viewer technology. See
“Oracle Outside In Technology 8.3 Supported Formats” (http://www.oracle.com/us/026956.pdf) for a
list of the supported file formats. See “Oracle Outside In Technology” (http://www.oracle.com/
technologies/embedded/outside-in.html) for background information about the Oracle viewer
technology included in Vibe.

The file viewers also support data indexing by the Lucene Index Server.

IPV6 Support

Novell Vibe supports the IPV6 protocol when it is available on the server. If the protocol is available,
Vibe detects it and supports IPV6 by default, along with IPV4.

Clustering Support

You can install Vibe components on multiple servers to provide failover support, as described in
Part IV, “Multi-Server Configurations and Clustering,” on page 123.

Virtualization Support

You can install Vibe in virtual environments where a software program enables one physical server to
function as if it were two or more physical servers.

Novell tests the Vibe software on both Xen and VMware platforms. Vibe is supported on these
platforms, as well as other virtualization platforms, such as Microsoft Hyper-V. If you encounter an
issue that cannot be duplicated in a Novell test environment, you may be responsible for following up
with the provider of your virtualization software.

For more information about XEN virtualization support, see the Open Enterprise Server 2
Virtualization Documentation website (http://www.novell.com/documentation/oes11/
virtualization.html#virtualization) and the SLES Virtualization Technology Documentation website
(http://lwww.novell.com/documentation/vmserver).

For more information about VMware virtualization support, see the VMWare website (http://
www.vmware.com).
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255 Single Sign-On Support

Novell Access Manager can be used to provide single sign-on capabilities for your Vibe site. For
setup instructions, see Section 10.9, “Configuring Single Sign-On with Novell Access Manager,” on
page 99.

25.6 Linux File System Support

24

The following file systems are supported for Vibe running on Linux:

+ ext3 (recommended in most cases)

NOTE: The maximum number of file entries in a Vibe File folder cannot exceed 31,998 when
using the ext3 file system.

+ NSS (recommended if you are running OES Linux and need the feature-rich environment of
NSS)

+ reiser3

2.6 Recommended Hardware Configurations Based
on System Performance

Because of the wide variety of ways you can use Vibe, the recommendations given in this section are
only guidelines.

The hardware configuration that you set up for your Novell Vibe site should be based on the following
considerations:

+ Number of active users that the Vibe site must support: Users who have accounts in the
Vibe system but do not log in to the system should not be considered in this number. For
example, if there are 1,000 users in the Vibe system but only 300 access the system on a regular
basis, the number of active users is 300.

+ Content the users will add: The type of content that is shared and stored on your Vibe site.
The number of active users in the system is a good indicator of what the hardware configuration
of your system should be, but you should also keep in mind that the type of content that is
shared and stored on your Vibe site has a significant effect on the amount of disk space and
memory that is required.

For example, your users might add the following types of content:

+ Multimedia documents, such as CAD and PowerPoint documents (requires the most
system resources)

+ Other documents, such as text documents and photos
+ Vibe entries that do not contain attachments, such as blog entries and discussion entries
(requires the least amount of system resources)

For example, if you have a Vibe installation with only 400 active users, but those users often upload
and share CAD files, you might want to configure a dedicated SQL server where those files can be
stored. In addition, provide a larger CPU, increased memory, and a larger Java heap to more
efficiently upload and search for the files.
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2.6.1

Server machines can be physical or virtual.

+ Section 2.6.1, “Configuration Based on Installation Size,” on page 25

+ Section 2.6.2, “Test Installation,” on page 26

+ Section 2.6.3, “Small Installation,” on page 26

¢ Section 2.6.4, “Medium Installation,” on page 27

+ Section 2.6.5, “Large Installation,” on page 28

+ Section 2.6.6, “Very Large Installation,” on page 30

Configuration Based on Installation Size

The following table shows the recommended hardware configuration based on the size of the Vibe

installation. For more detailed information about each type of installation, click the installation size in
the column header.

Test Installation Small Medium Large Very Large
Installation Installation Installation Installation

Single Server
Only

Remote
Database
Server

Remote Vibe
Desktop
Server

Remote Vibe
Add-In or
WebDAV
Server

Remote Lucene
Index Server

Remote File
Repository

Multiple Vibe
(Tomcat)
Servers

Multiple
Remote Lucene
Servers

Multiple
Remote
Database
Servers

Multiple
Remote Vibe
Desktop
Servers

X X
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2.6.2

2.6.3

Test Installation Small Medium Large Very Large
Installation Installation Installation Installation

Multiple X
Remote Vibe
Add-In Servers

Test Installation

Tomcat
Lucene Index
SQL Database
File System
Vibe Desktop

This deployment is suitable for a single-person evaluation or minimal usage by a small group.

Vibe Components CPU Memory Java Heap

1 dedicated Vibe (Tomcat) server with: 3Ghz x86 or x64, single- 4-8 GB 2-6 GB

core or dual-core
¢ Lucene

+ SQL

*

File System
Vibe Desktop
Vibe Add-In

*

*

For more information about installing a basic, single-server Vibe site, see Part Il, “Basic Installation,”
on page 37.

You can perform a Basic installation to set up a single-server configuration, as described in
Chapter 4, “Planning a Basic Vibe Installation,” on page 39 and Chapter 5, “Installing and Setting Up
a Basic Vibe Site,” on page 59.

Small Installation

Tomcat Tomcat

Lucene Index (for Vibe Desktop
SQL Database if more than 100
File System active users)
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2.6.4

This deployment is suitable for a workgroup, department, or small company. All components are on a
single server but are running typical memory allocations. If Vibe Desktop is being used with more
than 100 active users, it must be running on one or more separate Vibe (Tomcat) servers.

Vibe Components CPU Memory Java Heap

Multiple Vibe servers: 3Ghz x86 or x64, dual- 4-8 GB 2-6 GB

core or quad-core
+ 1 dedicated Vibe (Tomcat) server

with SQL and file system

+ 1 dedicated Vibe (Tomcat) server
with Vibe Desktop for 100 or fewer
active users; 2 dedicated Vibe
(Tomcat) servers with Vibe Desktop
for more than 100 active users

For more information about installing a basic, single-server Vibe site, see Part II, “Basic Installation,”
on page 37.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how to
distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Configuring Vibe
Desktop and the Microsoft Office Add-In”" in “Site Setup” in the Novell Vibe 4.0 Administration Guide.

You can perform a Basic installation to set up a single-server configuration, as described in
Chapter 4, “Planning a Basic Vibe Installation,” on page 39 and Chapter 5, “Installing and Setting Up
a Basic Vibe Site,” on page 59.

Medium Installation

<F) ‘ ’

Tomcat Tomcat Tomcat
(for Vibe Desktop) Lucene Index (for Vibe Desktop
File System if more than 100

active users)

This deployment is suitable for a medium-to-large business. The database server is separate, to
increase the amount of parallel processing in the system. The database can be a single server or a
cluster of database servers. More memory is also allocated to the Vibe server. If Vibe Desktop is
being used with more than 100 active users, it must be running on multiple separate Vibe (Tomcat)
servers.
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2.6.5

Vibe Components CPU Memory Java Heap

Multiple Vibe servers: 3Ghz x86 or x64 quad- 4-8 GB 6 GB

core
+ 1 dedicated Vibe (Tomcat) server

with file system
+ 1 or more dedicated SQL servers
+ 2 dedicated Lucene servers

+ 2 or more dedicated Vibe (Tomcat)
servers with Vibe Desktop

For information on how to create a separate Vibe database, follow the instructions specific to your
database type, as described in Chapter 14, “Creating the Vibe Database on a Remote Server,” on
page 125.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how to
distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Configuring Vibe
Desktop and the Microsoft Office Add-In”" in “Site Setup” in the Novell Vibe 4.0 Administration Guide.

You can perform a Basic installation to set up a multiple-server configuration (as described in
Chapter 4, “Planning a Basic Vibe Installation,” on page 39 and Chapter 5, “Installing and Setting Up
a Basic Vibe Site,” on page 59); however, the remote database must be created manually and in
advance of performing the installation, as described in Chapter 14, “Creating the Vibe Database on a
Remote Server,” on page 125.

Large Installation

Ny ERR TR

Tomcat Tomcat SQL database

(for Vibe Desktop) / \

File System Lucene Index

This deployment is suitable for a large business. This deployment uses load balancing across all
servers. The database server is separate, to increase the amount of parallel processing in the
system. The index server is separate, to allow the application to better utilize the physical memory
that is allocated. The file system is separate, and a SAN file system is recommended. The memory
utilization of the index server is proportional to the index size, which is directly related to the number
and size of documents and entries that are stored. As the number and size of documents and entries
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that are stored increases, you should increase the amount of memory accordingly. If Vibe Desktop is
being used with more than 100 active users, it must be running on multiple separate Vibe (Tomcat)
servers.

Vibe Components CPU Memory Java Heap
Multiple Vibe servers: 3Ghz x64 quad-core or 8- 4-8 GB 6 GB
core

+ 3-5 dedicated Vibe (Tomcat)
servers

+ 2 dedicated Lucene servers
+ 2 dedicated SQL servers

+ 1 dedicated file system server (SAN
is recommended)

+ 2 or more dedicated Vibe (Tomcat)
servers with Vibe Desktop

For more information on load balancing, see Section 16.3, “Configuring a Web Application to Provide
High Availability Functionality for Your Vibe Site,” on page 139.

For information on how to create a separate Vibe database, follow the instructions specific to your
database type, as described in Chapter 14, “Creating the Vibe Database on a Remote Server,” on
page 125.

For information on how to create a separate index server, see Chapter 15, “Installing the Lucene
Index Server on a Remote Server,” on page 131.

For more information on how to create a separate file system server, see Section 16.1.2, “Vibe File
Repository Considerations,” on page 135.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how to
distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Configuring Vibe
Desktop and the Microsoft Office Add-In” in “Site Setup” in the Novell Vibe 4.0 Administration Guide.

You must perform an Advanced installation to achieve this type of deployment. For more information,
see Part Ill, “Advanced Installation and Reconfiguration,” on page 89.
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2.6.6 Very Large Installation

b

Tomcat Tomcat SQL database

(for Vibe Desktop) / \

File System Lucene Index

This deployment is suitable for a large business. This deployment uses load balancing across all
servers. The database server is separate, to increase the amount of parallel processing in the
system. The index server is separate, to allow the application to better utilize the physical memory
that is allocated. The file system is separate, and a SAN file system is recommended. The memory
utilization of the index server is proportional to the index size, which is directly related to the number
and size of documents and entries that are stored. As the number and size of documents and entries
that are stored increases, you should increase the amount of memory accordingly. If Vibe Desktop is
being used with more than 100 active users, it must be running on multiple separate Vibe (Tomcat)
servers.

Vibe Components CPU Memory Java Heap
Multiple Vibe servers: 3Ghz x64 quad-core or 8- 4-8 GB 6 GB
core

+ 4-8 dedicated Vibe (Tomcat)
servers

+ 2 dedicated Lucene servers
+ 2 dedicated SQL servers

+ 1 dedicated file system server (SAN
is recommended)

+ 2 or more dedicated Vibe (Tomcat)
servers with Vibe Desktop

For more information on load balancing, see Section 16.3, “Configuring a Web Application to Provide
High Availability Functionality for Your Vibe Site,” on page 139.

For information on how to create a separate Vibe database, follow the instructions specific to your
database type, as described in Chapter 14, “Creating the Vibe Database on a Remote Server,” on
page 125.

For information on how to create a separate index server, see Chapter 15, “Installing the Lucene
Index Server on a Remote Server,” on page 131.
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For more information on how to create a separate file system server, see Section 16.1.2, “Vibe File
Repository Considerations,” on page 135.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how to
distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Configuring Vibe

Desktop and the Microsoft Office Add-In”" in “Site Setup” in the Novell Vibe 4.0 Administration Guide.

You must perform an Advanced installation to achieve this type of deployment. For more information,
see Part Ill, “Advanced Installation and Reconfiguration,” on page 89.
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What's New in Vibe 4.0

This section describes new features and enhancements that have been added to Novell Vibe 4.0.

+ Section 3.1, “Vibe 4.0 User Enhancements,” on page 33
+ Section 3.2, “Vibe 4.0 Installation Enhancements,” on page 33
+ Section 3.3, “Vibe 4.0 Administration Enhancements,” on page 33

3.1 Vibe 4.0 User Enhancements

For a list of Novell Vibe user enhancements and instructions for use, see:

+ “What's New in Novell Vibe 4.0” in the Novell Vibe 4.0 User Guide
+ “What's New in Vibe 4.0” in the Novell Vibe 4.0 Advanced User Guide

3.2 Vibe 4.0 Installation Enhancements

+ Database Changes: Vibe now requires you to create the database.

For more information about creating the database on Linux, see Section 5.1.3, “Creating the
Vibe Database,” on page 63.

For more information about creating the database on Windows, see Section 5.2.3, “Creating the
Vibe Database,” on page 71.

+ Specify File Types for Document Conversions during Installation: Previous versions of
Vibe allowed you to configure the file formats that could be converted to HTML by editing
configuration files. Vibe 4.0 provides a graphical interface during installation for configuring the
file formats that can be converted to HTML and viewed from Vibe.

For more information, see Section 4.9, “Adding File Types for HTML Conversions,” on page 55.

For more generic information on document conversions in Vibe, see “Understanding and
Configuring Document Conversions with Oracle Outside-In Technology” in the Novell Vibe 4.0
Administration Guide.

+ Ability to specify a From email address for outbound email: You can specify an email
address to be used as the From address of emails sent from Vibe.

For more information, see Section 4.7.5, “Outbound Email From Address,” on page 53.

3.3 Vibe 4.0 Administration Enhancements

+ LDAP Synchronization Improvements: The following improvements were made to LDAP
synchronization:

+ Synchronization performance improvements
Performance improvements in Vibe 4.0 as compared with Vibe 3.4:
+ When synchronizing 1 to 10,000 users - 3x improvement
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+ When synchronizing 10,000 to 30,000 users - 5x improvement

+ When synchronizing 30,00 to 60,000 users - 10x improvement
+ Improved interface, with a tabbed view
+ LDAP browser for selecting users and containers in your directory for LDAP configuration
¢ Support for non-unique group names

+ Ability to preview an LDAP synchronization (display the users and groups that will be
added, deleted, or disabled in Vibe) before the LDAP synchronization runs

+ Filter users and groups on Sync Results pages

For more information, see “Synchronizing Users and Groups from an LDAP Directory” in the
Novell Vibe 4.0 Administration Guide.

+ Sharing: The following administration improvements were made for sharing:

+ Ability to determine whether LDAP groups can be used when sharing: New option to
allow you to control whether groups that were imported from the LDAP directory are
displayed in the Share with field when users are sharing an item.

+ Whitelist or blacklist for sharing: You can create a whitelist or blacklist for sharing with
certain email addresses and domains.

+ New sharing option for File Link: Grant users the ability to share files by distributing a link
to the file. Any person with access to the link then has access to the file.

For more information about sharing, see “Setting Up Sharing” in the Novell Vibe 4.0
Administration Guide.

Ability to Reset the Administrator User ID: You can reset the user ID for the Vibe
administrator.

For more information, see “Changing the Vibe Administrator User ID or Password” in the Novell
Vibe 4.0 Administration Guide.

Improved Method for Resetting Passwords: It is easier than ever for local and external users
to reset their passwords. This method also applies to the Vibe administrator.

For information about how to reset the password for the Vibe administrator, see “Changing the
Vibe Administrator User ID or Password” in the Novell Vibe 4.0 Administration Guide.

New user interface for granting administrator privileges: It is now easier to grant
administrator rights to users and groups.

For more information, see Creating Additional Vibe Administrators.

Team management administration: You can more easily view and manage team workspaces
across your Vibe site.

For more information, see “Managing Team Workspaces” in the Novell Vibe 4.0 Administration
Guide.

Enhanced user and group management interface: For information, see “Managing Users”
and “Managing Groups” in the Novell Vibe 4.0 Administration Guide.

Improved handling of external users: In Vibe 3.4, marking a user as external was a manual
process. External user accounts are now created automatically when a workspace, folder, or
entry is shared with someone outside of the organization.

External user accounts from Vibe 3.4 are maintained after upgrading to Vibe 4.
For more information, see “Setting Up Sharing” in the Novell Vibe 4.0 Administration Guide.

Ability to disable access to the web client: You can disable users’ ability to access Vibe via a
web browser. Users can then access Vibe only through Vibe Desktop or through the Vibe mobile

app.
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For more information, see “Disabling User Access to the Vibe Site on the Web” in the Novell
Vibe 4.0 Administration Guide.

Support for multiple groups with the same name: In the Type-to-Find drop-down list, Vibe
now includes the group name or group title, as well as secondary information about the group
(either the group description or the Fully Qualified DN). This secondary information helps
distinguish between multiple groups that have the same name.

Ability to specify a maximum number of REST requests: You can specify the maximum
number of concurrent upload and download requests made by Vibe Desktop and mobile
applications.

”

For more information, see Section 10.4, “Configuring Requests and Connections Configuration,
on page 94.

Centralized Trash Management: All items that have been sent to the trash are now visible in
one location and can be restored or permanently deleted.

For more information, see “Permanently Deleting Files from the Trash” in the Novell Vibe 4.0
Administration Guide.

Data Quota on Outgoing Mail Messages: You can set a data quota on outgoing mail
messages. The combined size of all attachments in a single outgoing email cannot exceed the
guota that you set.

For more information, see “Enabling/Disabling Outbound Emailing of Folder Digests” in the
Novell Vibe 4.0 Administration Guide.

Download Vibe Desktop and Add-In from the Web Client: You can make the Vibe Desktop
and Vibe Add-In available to users from the Vibe web client.

For more information, see “Configuring the Vibe Desktop Application for All Users” in the Novell
Vibe 4.0 Administration Guide.

Exporting and Importing Folders Includes Global Filters: When you export and import
folders out of and into Vibe, all global filters are included in the export and import. (Personal
filters are not included.)

Workspace Templates Can Be Created at a Non-Global Level: You can create workspace
templates and make them available to only specific workspaces, rather than making them
available at a global level.

Automatically Delete or Archive Audit Trail and Change Log Entries: You can configure
Vibe to automatically delete or archive Audit Trail and Change Log entries after a given number
of months. This is helpful if these logs are consuming a lot of disk space.

For more information, see “Managing Database Logs and File Archives” in the Novell Vibe 4.0
Administration Guide.

Single Sign-On Support with KeyShield: You can provide single sign-on to your Vibe site with
KeyShield (KeyShield license not included).

For information, see “Configuring Single Sign-On with KeyShield” in the Novell Vibe 4.0
Administration Guide.

Ability to Deter Brute-Force Attacks with CAPTCHA: By default, CAPTCHA (http://
en.wikipedia.org/wiki/CAPTCHA) is now enabled on the Vibe site, securing the Vibe web
application against brute-force attacks.

For information about how to customize when CAPTCHA is used on the Vibe site, see “Securing
against Brute-Force Attacks with CAPTCHA” in the Novell Vibe 4.0 Administration Guide.

For information about how to enable CAPTCHA and set various configuration options, see
Securing against Brute-Force Attacks with CAPTCHA.
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+ Ability to Secure User Passwords: You can require the passwords of local and external users
to meet certain password requirements.

For more information, see “Securing User Passwords” in the Novell Vibe 4.0 Administration
Guide.
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I Basic Installation

+ Chapter 4, “Planning a Basic Vibe Installation,” on page 39

+ Chapter 5, “Installing and Setting Up a Basic Vibe Site,” on page 59
+ Chapter 6, “Adding Users to Your Vibe Site,” on page 77

+ Chapter 7, “Updating Your Vibe License,” on page 79

+ Chapter 8, “Setting Up Vibe,” on page 81

+ Chapter 9, “Basic Vibe Installation Summary Sheet,” on page 83
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4 Planning a Basic Vibe Installation

4.1

The installation program for Novell Vibe helps you install the Vibe software and file repository to the
appropriate locations.

+ Section 4.1, “What Is a Basic Vibe Installation?,” on page 39

+ Section 4.2, “Selecting the Operating Environment for Your Vibe Server,” on page 40

+ Section 4.3, “Selecting a Java Development Kit,” on page 43

+ Section 4.4, “Gathering Network Information for Your Vibe Site,” on page 43

¢ Section 4.5, “Planning the WebDAV Authentication Method,” on page 46

¢ Section 4.6, “Planning the Vibe Database,” on page 48

+ Section 4.7, “Gathering Outbound Email Information,” on page 51

+ Section 4.8, “Enabling Inbound Email,” on page 53

+ Section 4.9, “Adding File Types for HTML Conversions,” on page 55

+ Section 4.10, “Planning Site Security,” on page 55

¢ Section 4.11, “Gathering Directory Services Information,” on page 56

+ Section 4.12, “Accommodating Multiple Languages,” on page 57

What Is a Basic Vibe Installation?

The Novell Vibe installation program provides two installation types: Basic and Advanced. When you
perform a Basic installation, the result is a fully functional Vibe site with all required options configured
and with typical defaults in use for optional settings.

If you are new to Vibe, the easiest way to get started is to perform a Basic installation first, with all
Vibe components installed on the same server. Then you can add advanced configuration options to
your Vibe site after the Basic installation has been successfully tested. However, experienced Vibe
administrators can choose to perform an Advanced installation immediately, which includes all
installation and configuration options, as described in Part Ill, “Advanced Installation and
Reconfiguration,” on page 89.

IMPORTANT: The following Vibe configurations require that you perform an Advanced installation as
your initial installation of the Vibe software:

+ Setting up the Vibe file repository so that some types of files are located outside the Vibe file
repository root directory. See Section 10.2, “Distributing Different Data Types to Different
Locations,” on page 92 for Advanced installation instructions. You cannot move subdirectories
within the Vibe file repository after they have been created.

+ Installing the Vibe software on multiple servers to create a clustered environment. See
Chapter 16, “Running Vibe on Multiple Servers,” on page 135 for Advanced installation
instructions. The option to enable a clustered environment is available only during an Advanced
installation.

If you want to implement an Advanced installation option, you should perform a Basic installation first,
in a test environment, before performing the Advanced installation to set up your permanent Vibe site.
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4.2

421

422

This section helps you make informed decisions about the required options for a Basic installation:

+ Server platform (Linux or Windows)

+ Server architecture (32-bit or 64-bit)

+ Physical server memory requirements

+ File locations (Vibe software and data)

+ Java Development Kit (JDK) version (Sun or IBM)

+ Database type (MySQL, Microsoft SQL Server, or Oracle)

+ Database creation (during installation or before installation)

+ Database authentication (user name and password)

+ Network information (Vibe server hostname or fully qualified domain name, and ports)

¢ Outbound email configuration (SMTP vs. SMTPS, hostname, SMTP port, time zone,
authentication)

+ Inbound email configuration (SMTP address, SMTP port, and TLS support)
+ User and group for running the Vibe software (Linux only)

Before performing a Basic installation, ensure that all system requirements are met, as listed in
Chapter 2, “Vibe System Requirements,” on page 17.

As you proceed with planning, you can use the Basic Vibe Installation Summary Sheet to record your
decisions about the options you want to use.

Selecting the Operating Environment for Your
Vibe Server

+ Section 4.2.1, “Vibe Server Platform,” on page 40

+ Section 4.2.2, “Vibe Server Architecture,” on page 40
¢ Section 4.2.3, “Vibe Server Memory,” on page 41

+ Section 4.2.4, “Vibe Installation Locations,” on page 42

¢ Section 4.2.5, “TrueType Font Location (Linux Only),” on page 43

Vibe Server Platform

Novell Vibe can run on the versions of Linux and Windows listed in Section 2.1, “Vibe Server
Requirements,” on page 17.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe Server Platform, mark your operating system of choice.

Vibe Server Architecture

Vibe can run on 32-bit or 64-bit processors. A 64-bit processor is recommended for a large Vibe site
where the processor load is heavy and data storage requires a large amount of disk space.
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BASIC VIBE INSTALLATION SUMMARY SHEET

Under Processor Architecture, mark the processor capacity required for the size of Vibe site that you want
to set up.

42.3 Vibe Server Memory

If a 32-bit processor is sufficient for your Vibe server, the server needs at least 3 GB of memory. If you
plan to use a 64-bit processor in your Vibe server, the server needs more.

Vibe server memory usage is significantly affected by some factors and less affected by others:

+ Number of users logged in: No significant effect.
+ Number of concurrent active sessions: No significant effect.
+ Database server caches: Significant memory usage.

When you follow the instructions for a Basic installation, the database is located on the same
server as the Vibe software. After you have successfully tested your Basic installation, you can
reconfigure Vibe to have its database on a remote server, so that the database uses separate
memory resources, as described in Chapter 14, “Creating the Vibe Database on a Remote
Server,” on page 125.

+ Vibe internal data caches: Significant memory usage.

When you follow the instructions for a Basic installation, the Vibe internal data caches are
subdirectories of the teamingdata directory, described in Section 4.2.4, “Vibe Installation
Locations,” on page 42. The Vibe internal data caches are separate from any caching or memory
usage by the database server itself.

+ Lucene index cache: Significant memory usage.

The Lucene Index Server is a high-performance Java search engine. Large file repositories
(particularly with large files or a large number of files) can create a very large data index. When
you perform a Basic installation, the Lucene index is created on the same server where the Vibe
software is installed. After you have successfully tested your Basic installation, you can
reconfigure Vibe to have its Lucene index on a remote server, so that it uses separate memory
resources, as described in “Installing the Lucene Index Server on a Remote Server” on

page 131.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Memory Requirements, specify the amount of physical memory you plan to have for your Vibe
server.

When you perform a Basic installation, the default amount of memory allocated to the Java Virtual
Machine (JVM) where the Vibe software runs is 1 GB, which is adequate for a medium-sized Vibe site
running on a 32-bit server. This memory allocation, called the Java “heap size,” does not include
memory used by your database server or by the Lucene Index Server when these programs are
running on the same server as the Vibe software.

A general rule is that no more than 75% of the available physical memory should be allocated to the
JVM. Memory not allocated to the JVM must be sufficient to support the operating system, the
database server, and the Lucene Index Server if they are also running on the Vibe server, and any
other processes running on the Vibe server.
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4.2.4

IMPORTANT: A JVM on a 32-bit server should not be configured to take more than 1.5 G of memory.
However, large numbers of users and documents often need memory settings higher than 2 GB to
provide adequate performance. This type of Vibe system should be set up on 64-bit hardware.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location, specify the amount of memory to allocate to the JVM where Vibe runs.

Although it is possible to run Vibe with less than 1 GB of memory for the JVM, this applies only to very
small test configurations, and is not suitable for production systems. In a test configuration, 512 MB is
the minimum amount of memory required to produce a functioning Vibe installation.

Vibe Installation Locations

The default file location for the Vibe software varies by platform:

Linux: /opt/novell/teaming

Windows: c:\Program Files\Novell\Teaming

Included under the main Vibe software directory are subdirectories for Tomcat and file viewer
software.

The default file location for the Vibe file repository also varies by platform:

Linux: /var/opt/novell/teaming

Windows: c:\Novell\Teaming

IMPORTANT: On Windows, the Vibe installation program displays the Windows pathname with
forward slashes (/) rather than the traditional backslashes (\). This syntax is necessary in the
installation program.

The Vibe file repository holds all files that are imported into Vibe, information related to the imported
files, such as thumbnails and HTML renderings, and the search engine index.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under File Locations, specify the directories where you want to install the Vibe software and data if you
prefer not to use the default locations.

A Basic installation allows you to change the root directory for the Vibe software and the Vibe file
repository.

IMPORTANT: If you want to organize the Vibe file repository so that some file types are not under the
Vibe file repository root directory, you must perform an Advanced installation as your initial Vibe
installation. You cannot move directories out of the Vibe file repository root directory after the initial
installation has been performed. To perform an Advanced installation in order to organize the Vibe file
repository to meet your needs, complete the planning steps for a Basic installation and complete the
Basic Vibe Installation Summary Sheet, then follow the additional instructions in Section 10.2,
“Distributing Different Data Types to Different Locations,” on page 92.
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4.2.5

4.3

4.4

TrueType Font Location (Linux Only)

The Oracle Outside In viewer technology used by Novell Vibe to render various file formats into
HTML for viewing requires access to TrueType fonts. Typical locations for these fonts include the
following:

/usr/X11R6/1ib/X11/fonts/truetype
/usr/share/fonts/truetype

If the TrueType font location is not correct, thumbnails are not displayed correctly on the Vibe site.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under TrueType Font, specify the directory that contains the TrueType font location.

Selecting a Java Development Kit

As listed in Section 2.1, “Vibe Server Requirements,” on page 17, you need to install a Java
Development Kit (JDK) before you install Novell Vibe. You can use either the Sun JDK or the IBM
JDK for the platform where you are installing Vibe (Linux or Windows).

If you want to use an SSL connection between your Novell Vibe site and a WebDAV server, and if the
WebDAV server has a self-signed certificate rather than a certificate provided by a certificate
authority, you must use the Sun JDK. The existing Vibe functionality for handling self-signed
certificates is not compatible with the way the IBM JDK handles self-signed certificates.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java Development Kit, mark the JDK that you want to use with Vibe.

You must install the JDK on the Vibe server before you install the Vibe software. If you are not familiar
with installing a JDK, see “Java Development Kit (JDK)” in Appendix A, “Vibe System Requirements
Assistance,” on page 203.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java Development Kit, specify the directory where you have installed the JDK.

The Vibe Installation program uses this path as if you had set the JAVA_HOME environment variable.
The path is stored for future reference in the installer.xml file so that you need to specify the path
to the JDK only once.

Gathering Network Information for Your Vibe Site

When you perform a Basic installation, the Novell Vibe installation program needs hostname and
HTTP port information about the server where you are installing Vibe.

+ Section 4.4.1, “Host Identification,” on page 44
¢ Section 4.4.2, “Port Numbers,” on page 44
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4.4.2

Host Identification

When you install Vibe, the Vibe installation program needs to know the name of the server where you
are installing the Vibe software. The default is 1ocalhost. Do not use the default.

For internal use, you can use the DNS hostname of the Vibe server. However, if you want your Vibe
site to be accessible from the Internet, you must specify the fully qualified domain name for the Vibe
server in order to allow external access.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the hostname or fully qualified domain name to use for the Vibe
server.

Port Numbers

When you install Vibe, Tomcat is installed along with the Vibe software. Vibe uses Tomcat as a
standalone web server for delivering data to Vibe users in their web browsers. For more information
about Tomcat, see the Apache Tomcat website (http://tomcat.apache.org).

IMPORTANT: If the server where you want to install Vibe already has a web server running on it, shut
it down while you install and test Vibe. The instructions for a Basic Vibe installation assume that no
other web server is running on the Vibe server. If you want to maintain another web server on the
Vibe server, you are responsible for resolving any port conflicts that might arise.

On the command line, use the netstat command to see what ports are currently in use on the server
where you plan to install Vibe:

Linux: netstat -tan

Windows: netstat -a -n -p tcp

Ensure that the port numbers that you specify during Vibe installation do not conflict with ports that
are already in use on the server.

¢ “HTTP/HTTPS Ports” on page 44
+ “HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe” on page 45

¢ “Shutdown Port” on page 46
+ “AJP Port” on page 46

HTTP/HTTPS Ports

By default, standard web servers such as Apache and Microsoft Internet Information Services (11S)
use port 80 for non-secure HTTP (Hypertext Transfer Protocol) connections and port 443 for secure
HTTPS connections. HTTPS connections use SSL (Secure Sockets Layer) for added security. As a
result, web browsers default to port 80 when no port is specified in a non-secure HTTP URL and to
port 443 when no port is specified in a secure HTTPS URL.

Tomcat defaults to port 8080 for non-secure HTTP connections and to port 8443 for secure HTTPS
connections, so that it does not conflict with the standard web server port numbers. If you configure
Vibe with the Tomcat default port numbers, users must include the appropriate port number when
providing the Vibe site URL. Typically, users prefer not to do this.
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Unfortunately, the situation is not as simple as just configuring Vibe to use the default port numbers of
80 and 443. On Linux, non-root processes are not allowed access to port numbers lower than 1024
and you are counseled against running Vibe as root in Section 4.10.2, “Linux User ID for Vibe,” on
page 56. Also on Linux and Windows, the default Tomcat installation expects ports 8080 and 8443.

For a Basic installation, you can use the default port numbers as presented by the Vibe Installation
program:

HTTP port: 80

Secure HTTP port: 443
Listen port: 8080
Secure listen port: 8443

IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server 2, port 80 is already in use
by iManager. In order for Vibe to listen on port 80 (which is the standard port), you need to change
iManager to listen on a non-standard port, such as 81.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, the default port numbers have been provided for you. You need to specify
different port numbers only if you anticipate port conflicts with other software on the Vibe server.
Resolving port conflicts is beyond the scope of this Vibe documentation.

After you install Vibe on Linux, you need to complete the steps in “Setting Up Port Forwarding” on
page 66 so that users are not required to include the port number in the Vibe URL.

If you want to use secure HTTPS connections for your Vibe site, you must obtain signed certificate
files as described in “Preparing for Secure HTTP Connections” in “Site Security” in the Novell Vibe
4.0 Administration Guide either before or after you install Vibe.

HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe

If you are fronting Vibe with Novell Access Manager, ensure that you have configured the HTTP/
HTTPS ports as described in the following sections, depending on the operating system where Vibe
is running.

Configuring Vibe in this way configures Novell Access Manager to access Vibe over port 80, which is
the standard port.

+ “Windows Port Configuration” on page 45

+ “Linux Port Configuration” on page 46

Windows Port Configuration

Use the following port configuration when Novell Access Manager is fronting your Vibe system on
Windows:

HTTP Port: 80
Secure HTTP Port: 443
Listen Port: 80

Secure Listen Port: 443
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4.5

Linux Port Configuration

Use the following port configuration when Novell Access Manager is fronting your Vibe system on
Linux:

HTTP Port: 80

Secure HTTP Port: 443
Listen Port: 8080
Secure Listen Port: 8443

With this suggested configuration on Linux, you also need to set up port forwarding, as described in
“Setting Up Port Forwarding” on page 66.

Shutdown Port

By default, Vibe uses 8005 as its shutdown port. For an explanation of the shutdown port, see Tomcat
- Shutdown Port (http://www.wellho.net/mouth/837_Tomcat-Shutdown-port.html).

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its shutdown port if the default of
8005 is already in use on the Vibe server.

AJP Port

By default, Vibe uses 8009 as its AJP port. For an explanation of the Apache JServ Protocol port, see
The AJP Connector (http://tomcat.apache.org/tomcat-6.0-doc/config/ajp.html).

IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server 2, port 8009 is already in
use, so you need to select a different port, such as 8010.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its AJP port if the default of 8009 is
already in use on the Vibe server.

Planning the WebDAV Authentication Method

+ Section 4.5.1, “Understanding WebDAV,” on page 47
+ Section 4.5.2, “Choosing the WebDAV Authentication Method,” on page 47
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45.1

45.2

Understanding WebDAV

WebDAV is a standard collaborative editing and file management protocol. Novell Vibe relies on the
WebDAV protocol for two key features:

+ Edit-in-Place for using tools such as OpenOffice and Microsoft Office, as described in “Editing
Files” in the Novell Vibe 4.0 User Guide.

+ Mapping Vibe folders as a web folder on the client computer, which allows access to Vibe files
from a WebDAV-compliant file navigation tool such as Windows Explorer or Nautilus, as
described in “Creating a Mapped Drive to the Vibe Folder” in the Novell Vibe 4.0 Advanced User
Guide.

IMPORTANT: When Vibe users are running Windows 7 as the client operating system, various
issues can be introduced because of WebDAV limitations in Windows 7. If your Vibe users are using
the Windows 7 operating system, see “Configuring Vibe to Support WebDAV on Windows 7" in the
Novell Vibe 4.0 Administration Guide.

Choosing the WebDAV Authentication Method

The WebDAV authentication method determines how user credentials are passed from Vibe to the
WebDAV server. Vibe 3 and later supports three types of WebDAYV authentication methods:

+ “Choosing Basic Authentication” on page 47
+ “Choosing Digest Authentication” on page 47
+ “Choosing Windows Authentication” on page 48

Choosing Basic Authentication

Basic authentication encodes the user name and password with the Base64 algorithm. The Base64-
encoded string is unsafe if transmitted over HTTP, and therefore should be combined with SSL/TLC
(HTTPS).

Select this type of authentication when you plan to use Novell Access Manager or Internet
Information Services (11S) to authenticate users.

For more information about encryption algorithms, see Section 4.6.5, “Database Encryption
Algorithm,” on page 50.

Choosing Digest Authentication

Digest authentication applies MD5 cryptographic, one-way hashing with usage of nonce values to a
password before sending it over the network. This option is more safe than Basic Authentication
when used over HTTP.

Select this type of authentication when client users are using Windows 7 as their operating system
and Microsoft Office as their text editor.

For more information about encryption algorithms, see Section 4.6.5, “Database Encryption
Algorithm,” on page 50.
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4.6

46.1

Choosing Windows Authentication

Windows Authentication provides Windows users with a single sign-on experience, enabling users to
automatically authenticate to Vibe after they are logged in to their individual workstations. Internet
Information Services (1IS) provides this capability.

To configure Vibe to use Windows Authentication as the WebDAV authentication method, select basic
in the WebDAV authentication method field during the Vibe installation program, then configure
Windows Authentication as described in Section 10.10, “Configuring Single Sign-On with Internet
Information Services for Windows,” on page 99.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under WebDAV authentication method, specify the authentication method you want Vibe to use when
authenticating to WebDAV.

Planning the Vibe Database

Novell Vibe database disk space requirements are relatively modest. Files that are imported into Vibe
are saved in the Vibe file repository, as described in Section 4.2.4, “Vibe Installation Locations,” on
page 42.

The Vibe database is primarily used for storing the following information:

+ Structural information about workspaces, folders, and entries (for example, their location in the
workspace tree)

+ |dentification information about workspaces, folders, and entries (for example, titles,
descriptions, dates of creation/modification, and users associated with creation/modification)

+ User profile information (for example, full name, phone number, and email address)
You or your database administrator must make the following decisions about the Vibe database:

+ Section 4.6.1, “Database Type,” on page 48

+ Section 4.6.2, “Database Setup Method,” on page 49

+ Section 4.6.3, “Database Location,” on page 49

+ Section 4.6.4, “Database Credentials,” on page 50

+ Section 4.6.5, “Database Encryption Algorithm,” on page 50

Database Type

Vibe supports the following database types:
On Linux: MySQL and Oracle
On Windows MySQL, Microsoft SQL, and Oracle

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Type, mark the type of database that you want to use with Vibe.

Ensure that a supported version of the database server, as listed in Section 2.1, “Vibe Server
Requirements,” on page 17, is installed and running before you install Vibe.

Novell Vibe 4.0 Installation Guide



4.6.2

4.6.3

Database Setup Method

You or your database administrator must manually create the Vibe database. This is a requirement,
regardless of which type of database you are using.

+ “Basic Setup” on page 49
+ “Remote Server Setup” on page 49

Basic Setup

If you plan to deploy the Vibe database as a basic installation, with the database running on the same
server as the Vibe software, you first install the Vibe software, and then create the database, as
described in Chapter 5, “Installing and Setting Up a Basic Vibe Site,” on page 59.

Remote Server Setup

If you plan to deploy the Vibe database on a remote server, follow the instructions in Chapter 14,
“Creating the Vibe Database on a Remote Server,” on page 125.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Setup Method, mark whether you are setting up the database as a basic installation (with
the database running on the same server as the Vibe software), or whether you are performing a remote
server setup, with the database server on a remote server.

Database Location

Creating the database on the same server where you install the Vibe software is the preferable
location for your Basic installation. The default database name is sitescape (a reference to the
company that previously developed the Vibe software).

Database Default Linux Location  Default Windows Location
Server

MySQL N/A N/A

Microsoft SQL N/A N/A

Oracle N/A N/A

You can have your database administrator create a database on a remote server later, after you have
successfully tested your Basic installation. See Chapter 14, “Creating the Vibe Database on a
Remote Server,” on page 125.

You must decide before installation whether you want the database on the Vibe server or on a remote
server. See Chapter 14, “Creating the Vibe Database on a Remote Server,” on page 125.

Vibe knows where to find its database from the JDBC (Java Database Connectivity) URL that you
provide during installation. For a database that is local to the Vibe software, the default JDBC URL
that provides localhost as the hostname of the Vibe server is appropriate. If the database is on a
remote server, the JDBC URL must provide the hostname of the remote database server.

The JDBC URL also includes the port number on which Vibe can communicate with the database
server. The default port number depends on the database server you are using:
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4.6.4

4.6.5

Database Server Default Port Number

MySQL 3306
Microsoft SQL 1433
Oracle 1521

Use this port number unless it is already in use by another process on the database server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under JDBC URL, specify the appropriate hostname for the database server (localhost or the
hostname of a remote server) and the port number it will use to communicate with Vibe.

Database Credentials

When you have the Vibe Installation program create the database for you, it defaults to the following
administrator user names for the database server:

Database Default Administrative User Name

MySQL root

IMPORTANT: The MySQL root user name is not the same as the Linux root user on a
Linux server.

Microsoft SQL  (no default) For a Microsoft SQL database, your database administrator establishes the
administrator user name and password for the database server.

Oracle (no default) For an Oracle database, your database administrator establishes the
administrator user name and password for the database server.

For an Oracle database and Microsoft SQL database, your database administrator establishes the
administrator user name and password for the database server.

Check with your database administrator to see if the default administrator user name is still in use for
your database server, and obtain the administrator password for the database server before you run
the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials, specify the administrator user name and password for the database server
so that Vibe can access its database.

Database Encryption Algorithm

Different encryption algorithms provide differing encryption strength. The supported algorithms for
encrypting the Vibe database password are listed below.

+ SHA-256

This is the only available option when you use Basic Authentication for WebDAV authentication,
as described in Section 4.5, “Planning the WebDAV Authentication Method,” on page 46.
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4.7

4.7.1

+ PBEWITHSHA256AND128BITAES-CBC-BC

This is the only available option when you select Digest Authentication for WebDAV
authentication, as described in Section 4.5, “Planning the WebDAV Authentication Method,” on
page 46.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Encryption Algorithm, mark the encryption algorithm you want to use for Vibe
passwords.

Gathering Outbound Email Information

Your Novell Vibe site can be configured to send outbound email through an existing email system.
Email from the Vibe site is useful for the following activities:

+ Vibe users can subscribe to email notifications, so that they automatically receive a message
whenever content of interest changes. For more information, see “Subscribing to a Folder or
Entry” in “Getting Informed” in the Novell Vibe 4.0 User Guide.

+ From the Vibe site, users can send email messages to individual users or to teams. For more
information, see “Sending Email from within Vibe” in “Connecting With Your Co-Workers” in the
Novell Vibe 4.0 User Guide.

+ If your emalil client is iCal-enabled, appointments created in a Vibe Calendar folder can be sent
to your email client for posting in your email client Calendar. For example, if you are using
GroupWise, see “Accepting or Declining Internet Iltems” in “Calendar” in the GroupWise 8
Windows Client User Guide.

In order for your Vibe site to communicate with your email system, you need to gather the following
information about your email system:

¢ Section 4.7.1, “Outbound Email Protocol,” on page 51

+ Section 4.7.2, “Outbound Email Host,” on page 52

¢ Section 4.7.3, “Outbound Email Authentication,” on page 52

+ Section 4.7.4, “Outbound Email Send Restriction,” on page 53

¢ Section 4.7.5, “Outbound Email From Address,” on page 53

After installation, outbound email can be disabled and enabled again on the Vibe site, as described in
“Configuring Email Integration” in “Site Setup” in the Novell Vibe 4.0 Administration Guide. However,
you must configure outbound email in the Vibe installation program.

Outbound Email Protocol

Email systems communicate by using SMTP (Simple Mail Transfer Protocol). You need to determine
whether the email system that you want your Vibe site to communicate with is using SMTP or SMTPS
(secure SMTP).

For GroupWise, you can check how the Internet Agent is configured:

1 In ConsoleOne, browse to and right-click the Internet Agent object, then click Properties.
2 Click GroupWise > Network Address.
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4.7.2

4.7.3

In the SMTP field, if the SSL column displays Disabled, GroupWise is using SMTP. If the SSL
column displays Enabled, GroupWise is using SMTPS.

3 Click Cancel to close the Network Address page.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Protocol, mark SMTP or SMTPS to match the email system that you want Vibe to
communicate with.

If the email system requires SMTPS, see “Securing Email Transfer” in “Site Security” in the Novell
Vibe 4.0 Administration Guide.

Outbound Email Host

In order to send messages to your email system, Vibe needs to know the hostname of your SMTP
mail server.

The default SMTP port of 25 is typically appropriate, unless the SMTP mail server requires port 465
or 587 for SMTPS connections.

For GroupWise, this is the hostname of a server where the Internet Agent is running. GroupWise
always uses port 25, even when SSL is enabled.

When the Vibe site sends email notifications for scheduled events, the messages are time-stamped

according to the time zone you specify here during installation. This setting allows you to use a time

zone for email notifications that is different from the time zone where the server is located. The time

zone list is grouped first by continent or region, optionally by country or state, and lastly by city. Some
common selections for United States time zones include the following:

Time Zone Continent/City
Pacific Time America/Los Angeles
Mountain Time America/Denver
Central Time America/Chicago
Eastern Time America/New York

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Host, specify the name of the mail host, the SMTP port number it uses, and the
time zone for the time stamp you want on scheduled event notifications.

Outbound Email Authentication

Many SMTP mail hosts require a valid email address before they establish the SMTP connection.
Some email systems can construct a valid email address if you specify only a valid user name; other
email systems require that you specify the full email address for successful authentication. You
should provide a user name (email address) to ensure a successful connection. Email notifications
from the Vibe system are sent using this email address in the From field.

Some email systems also require a password. Some do not. If authentication is required, you should
also provide a password.
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4.7.4

4.7.5

4.8

By default, the GroupWise Internet Agent does not require authentication in order to receive inbound
messages. However, the /forceinboundauth startup switch is available for use in the Internet Agent
startup file (gwia.cfg), in order to configure the Internet Agent to refuse SMTP connections where a
valid email user name and password are not provided. The Internet Agent can accept just the user
name or the full email address.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Authentication, indicate whether or not authentication is required for the Vibe site
to communicate with your email system. If it is, specify the user name or email address, and if necessary,
the password for the email account.

Outbound Email Send Restriction

By default, the Vibe site allows Vibe users to send messages to all Vibe users by using the All Users
group on the Vibe site. On a very large Vibe site, this generates a very large number of email
messages. If desired, you can prevent messages from being sent to the All Users group.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Allow Sending Email to All Users, mark whether you want users to be able to send messages to the All
Users group.

Outbound Email From Address

You can specify an email address to be used as the From address of emails sent from Vibe.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under From email address override, specify the email address to be used as the From address for emails sent
from Vibe.

Under Use this from email address for all outbound email, mark whether you want this address to be used for
all outbound email.

Enabling Inbound Email

You can configure your Novell Vibe site so that users can post comments by emailing them to the
folder where they want to post the comment. In order to receive email postings, folders must be
properly configured, as described in “Enabling Folders to Receive Entries through Email” in
“Managing Folders” in the Novell Vibe 4.0 Advanced User Guide. Also, users must know the email
address of the folder where they want to post their comment.

*

Section 4.8.1, “Internal Mail Host for Inbound Email,” on page 54

*

Section 4.8.2, “Inbound Email Port Number,” on page 54
+ Section 4.8.3, “Inbound Email IP Address,” on page 54
+ Section 4.8.4, “Inbound Email Security,” on page 54

After installation, inbound email can be disabled and enabled again on the Vibe site, as described in
“Disabling/Enabling Inbound Email Postings” in “Site Setup” in the Novell Vibe 4.0 Administration
Guide. However, you must configure inbound email in the Vibe installation program.
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48.1

4.8.2

4.8.3

4.8.4

Internal Mail Host for Inbound Email

Inbound email is disabled by default. When you enabile it, the Vibe site starts an internal SMTP mail
host to receive incoming messages and post them to the folders associated with the email addresses
to which the messages are addressed. By default, the internal SMTP mail host uses port 2525, so
that it does not conflict with another mail host that might be running on the Vibe server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, mark whether you want users to be able to post to the Vibe site from their
email clients.

Inbound Email Port Number

Selecting the port number for the Vibe internal SMTP mail host presents the same issue that needs to
be dealt with for the HTTP port numbers, as described in “HTTP/HTTPS Ports” on page 44. You
might want to configure the Vibe internal SMTP mail host to use the standard SMTP port of 25. How
you handle the issue depends on whether you are installing on Linux or on Windows.

Linux: Keep the default port number (2525) in the Vibe Installation program, then complete the steps in
“Setting Up Port Forwarding” on page 66 so that requests incoming on port 25 are forwarded to
port 2525.

Windows: Specify port 25 for incoming email in the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, specify the port number for the Vibe internal SMTP host to listen on.

Inbound Email IP Address

If you want to install Vibe on a server where an SMTP mail host is already running, you can do so if
the server has multiple IP addresses. The existing SMTP mail host can use port 25 on one IP address
and Vibe can use port 25 on another IP address. During installation, you need to specify an IP
address only if the server has multiple IP addresses and you want Vibe to bind to a specific IP
address rather than all of them.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, specify the IP address for the Vibe internal SMTP host to listen on, if you
are installing Vibe on a server with multiple IP addresses and you want Vibe to bind to just one of them.

Inbound Email Security

You can choose whether the Vibe internal mail host uses TLS (Transport Layer Security) when it
communicates with other SMTP mail hosts. In order for TLS to function properly, you must have a
certificate on the Vibe server, as described in “Securing Email Transfer” in “Site Security” in the
Novell Vibe 4.0 Administration Guide. When an SMTP mail host queries the Vibe mail host, the Vibe
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4.9

4.10

4.10.1

mail host communicates its ability or inability to handle TLS. The other SMTP mail host then
communicates appropriately, taking into account how the Vibe internal mail host is configured. The
default is to use TLS, because this provides more secure communication between mail hosts.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, mark whether you want the Vibe server to announce that it can use TLS.

You can install Vibe with Announce TLS selected, and then set up the certificate afterwards. However,
if you select Announce TLS, inbound email does not work until the certificate is available on the Vibe
server.

Adding File Types for HTML Conversions

Many file formats in Novell Vibe can be viewed as HTML by default, as described in “Viewing the File
in HTML Format” in the Novell Vibe 4.0 User Guide. File formats that can be viewed as HTML by
default are: .123, .bmp, .db, .doc, .docx, .dotm, .drw, .dxf, .htm, .html, .1lwp, .odf, .odf, .odp,
.ods, .odt, .pct, .ppt, .pptx, .prz, .qpw, .rtf, .sdw, .shw, .sxw, .tif, .txt, .vsd, .wpd, .xls,
.x1lsx, .sxi

Some file formats, such as .pdf files, cannot be viewed as HTML by default. This is because the
quality of these files is lessened when viewed as HTML. However, if you choose, you can enable non-
default file formats, such as .pdf files, to be viewed as HTML.

Not all file formats can be enabled to be viewed as HTML in Vibe, but many can be. If you are unsure
whether Vibe supports a particular file format to be viewed as HTML, try it and see.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe File Types for HTML Conversions, specify the file types (in addition to the default file types)
that you want users to be able to view as HTML.

Planning Site Security

+ Section 4.10.1, “Vibe Site Administrator Password,” on page 55
+ Section 4.10.2, “Linux User ID for Vibe,” on page 56
¢ Section 4.10.3, “Administrator Name for Novell Vibe,” on page 56

Vibe Site Administrator Password

When you first log in to the Novell Vibe site, you use admin as the Vibe administrator user name and
admin as the password. You should immediately change the password to one of your own choosing
when you are prompted to do so. If you do not immediately change the password, you can change
the Vibe adminsitrator user name and password at any time, as described in “Changing the Vibe
Administrator User ID or Password” in the Novell Vibe 4.0 Administration Guide.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe Administrator Credentials, specify the password that you want to use whenever you log in as
the Vibe site administrator.

Planning a Basic Vibe Installation 55


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bqkq1cv
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bqkq1cv
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#b1dl09ko
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#b1dl09ko
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo

4.10.2

4.10.3

4.11

Linux User ID for Vibe

For optimum security, Vibe should not run as the Linux root user. For example, if an intruder
manages to assume the identity of the Vibe program, the intruder gains all the privileges of the
commandeered process. If the process is running with root user privileges, the intruder has root
access to your system. If the process is running as a user with minimal privileges, the intruder has
only restricted access to your system. Therefore, your system is more secure if the Vibe program
does not run as root. For example, you might want to create a user named vibeadmin for the Vibe
program to run as. Linux users require a full name and a password.

In addition to creating a Linux user for the Vibe program to run as, you can also create a Linux group
for that user to belong to. This enables the Vibe program to create directories and files with consistent
ownership and permissions. For example, you might want to create a group named vibeadmin for the
vibeadmin user to belong to. Groups do not require passwords.

As an alternative to creating a custom Linux user name and group for Vibe, you can use the existing
wwwrun user name and the www group. This account is typically used to start web server processes.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Linux User Name and Group, specify the non-root Linux user name and group name to use for
running the Vibe program. If you are creating a new Linux user, specify its full name and password.

IMPORTANT: The non-root Linux user name and group must exist before you start the Vibe
Installation program. Instructions for creating the user name and group are provided in Section 5.1.1,
“Performing Pre-Installation Tasks on Linux,” on page 59.

Administrator Name for Novell Vibe

This is the administrator user ID that is used when logging in to the Vibe system. For enhanced
security, you might want to change the user ID.

In the Default Administrator Name field, specify a new user ID for the vibe administrator.

Gathering Directory Services Information

Unless you are planning a very small Novell Vibe site, the most efficient way to create Vibe users is to
synchronize initial user information from your network directory service (Novell eDirectory, Microsoft
Active Directory, or other LDAP directory service) after you have installed the Vibe software. Over
time, you can continue to synchronize user information from the LDAP directory to your Vibe site.

“Synchronizing Users and Groups from an LDAP Directory” in the Novell Vibe 4.0 Administration
Guide provides instructions for synchronizing user information via LDAP. Use this section when
planning your LDAP configuration.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under the LDAP sections, mark the information specific for your environment.
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412 Accommodating Multiple Languages

The Novell Vibe installation program runs in English only. When you install the Vibe software, you can
choose to have the primary language of the Vibe site be any of the following languages:

¢ Chinese-Simplified

¢ Chinese Traditional

+ Danish

¢ Dutch

+ English

+ French

+ German

¢ Hungarian

+ ltalian

+ Japanese

¢ Polish

+ Portuguese

+ Russian

¢ Spanish

+ Swedish

Some languages have an additional distinction by locale (the country where the language is spoken).

The language you select during installation establishes the language of the global text that displays in
locations where all Vibe users see it, such as in the Workspace tree when you click the Workspace
treeicon & :

o

Horne Workspace Personal Workspace Guest (guest)

The language you select also establishes the default interface language and locale for creating new
workspaces.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Default Locale, mark the default language and specify the default country for your Vibe site.

Additional language customization can be done after installation, as described in “Managing a
Multiple-Language Vibe Site” in “Site Setup” in the Novell Vibe 4.0 Administration Guide.
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Installing and Setting Up a Basic Vibe
Site

Follow the setup instructions for the platform where you are installing Novell Vibe:

+ Section 5.1, “Linux: Installing and Setting Up a Basic Vibe Site,” on page 59
+ Section 5.2, “Windows: Installing and Setting Up a Basic Vibe Site,” on page 69

5.1 Linux: Installing and Setting Up a Basic Vibe Site

You should already have reviewed Chapter 4, “Planning a Basic Vibe Installation,” on page 39 and
filled out the Basic Vibe Installation Summary Sheet. The following sections step you through the
process of installing and starting Novell Vibe on Linux:

¢ Section 5.1.1, “Performing Pre-Installation Tasks on Linux,” on page 59

¢ Section 5.1.2, “Running the Linux Vibe Installation Program,” on page 60

¢ Section 5.1.3, “Creating the Vibe Database,” on page 63

+ Section 5.1.4, “Performing Post-Installation Tasks on Linux,” on page 65

5.1.1 Performing Pre-Installation Tasks on Linux

1 Ensure that the Linux server where you plan to install Vibe meets the system requirements listed

in Section 2.1, “Vibe Server Requirements,” on page 17.
2 In a terminal window, become root by entering su - and the root password.
3 Set the Linux open file limit to meet the needs of the Vibe software:
3a Openthe /etc/security/limits.conf file in an ASCII text editor.
3b Add the following lines to the bottom of the list, following the format of the example lines:

* hard nofile 65535
* soft nofile 4096

3c Save the file, then exit the text editor.
4 Perform the following conditional tasks if necessary:
+ “Stopping and Disabling an Existing Web Server” on page 59
+ “Creating a Vibe User and Group” on page 60

Stopping and Disabling an Existing Web Server
If a web server is currently running on the Vibe server, stop it, and preferably disable it.
For example, to stop the Apache web server and its associated instance of Tomcat:

1 Enter the following commands to stop Apache and Tomcat:

/etc/init.d/tomcat5 stop
/etc/init.d/apache2 stop
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2 Enter the following commands to ensure that Apache and Tomcat do not start again when you
reboot the server:

chkconfig --del apache2
chkconfig --del tomcat5b

Creating a Vibe User and Group

If the user and group that you want to use for Vibe (as described in Section 4.10.2, “Linux User ID for
Vibe,” on page 56) do not exist yet, create them. It is easier if you create the group first.
1 Create the Linux group that you want to own the Vibe software and data store directories:

la In YaST, click Security and Users > User and Group Management to display the User and
Group Administration page.

1b Click Groups, then click Add.
1c Specify the group name, then click Accept or OK.
The group does not need a password.
2 Create the Linux user that you want Vibe to run as:
2a Click Users, then click Add.

2b On the User Data tab, specify the user’s full name, user name, and password, then select
Disable User Login.

Like any Linux system user, the Vibe Linux user does not need to manually log in. The Vibe
Linux user does not need a password, either, but YaST requires you to provide one.

2c¢ Click the Details tab.

2d In the Login Shell drop-down list, select /bin/false, because this user does not need to
manually log in.

2e In the Default Group drop-down list, select the Linux group that you created in Step 1.
2f In the Groups list, select the Linux group that you created in Step 1.
2g Click Accept or OK.

3 Exit YaST.

5.1.2 Running the Linux Vibe Installation Program

When you run the Vibe installation program for the first time, you typically want to use the GUI
interface. However, if you are installing Vibe on a server where the X Window System is not available,
a text-based installation program is also available. After you are familiar with the Vibe installation
process, you can use a silent installation to automate the process.

¢ “Using the GUI Installation Program” on page 60

¢ “Using the Text-Based Installation Program” on page 62

+ “Performing a Silent Installation” on page 63

Using the GUI Installation Program

1 In aterminal window, enter su - to become the root user, then enter the root password.

You need root permissions in order to install the Vibe software, but you should not run the Vibe
software as root.

2 Change to the directory where you downloaded and extracted the Vibe software.
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3 Ensure that you have a 1icense-key.xml file in the same directory with the Vibe installation
program.

more license-key.xml

The Vibe installation program does not start without a license file in the same directory. If you
have not already, rename the license file to be called 1icense-key.xml.

For more information about licensing, see Chapter 7, “Updating Your Vibe License,” on page 79.
4 Enter the following command to start the Vibe installation program:

./installer-teaming.linux
5 Accept the License Agreement, then click Next.
Novell Vibe 4 Installation Program 5 x

Installation Options

Select the action you want to perform. N

' New Installation
™ Update software and settings
" Reconfigure settings

6 Click Next to accept the default of New installation.

Novell Vibe 4 Installation Program - x
Choose Inslallation Type

Select the type of installation you want to perform N

Select the Basic installation if you do not want to configure

|
Advanced any of the optional features.

7 Click Next to accept the default of Basic.

8 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet to
provide the information that the Vibe installation program prompts you for:

Installation Locations
Location of TrueType Fonts for Stellent Converters
Additional Extensions for View as HTML
Default Locale for Novell Vibe
User ID for Novell Vibe
Built-In Administrator Name for Novell Vibe
Network Information
WebDAV Authentication Method
Database Selection

Database Type

JDBC URL

Credentials
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Setup
Encryption Algorithm
Java JDK Location
Outbound Email Configuration
Protocol
Host, Port, and Time Zone
User Name, Password, and Authentication
Allow Sending Email to All Users
Inbound Email Configuration

The installation program stores the information that it gathers in the installer.xml file in the
same directory where you started the installation program.

9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the installer.log file in the same
directory where you ran the Installation program. If a problem arises during the installation, the
installer.log file provides information that can help you resolve the problem.

11 Continue with Section 5.1.3, “Creating the Vibe Database,” on page 63.

Using the Text-Based Installation Program

If you try to start the GUI Vibe installation program in an environment where the X Windows System is
not running, the text-based Vibe Installation program starts.

Checking license key...

License Summary

Product: Novell Vibe

Version: 3.0

UID: 1
Effective: 10/27/2012
Expires: never
Users: unlimited

Installing this software requires agreement to the
terms and conditions set forth in the:
Novell EULA and Export Compliance Notice

You can review this agreement again at the download site or
type "REVIEW" below.

Note: You must answer "YES" to install the software.

Have you read and agree with the license? :

If you want to use the text-based installation program in an environment where the GUI starts by
default, use the following command in the directory where the installation program is located:

./installer-teaming.linux --text

IMPORTANT: The text-based Vibe installation program must be run in the same directory where the
Vibe license file is located. If the license file is not in the same directory, the text-based installation
program cannot find it.

The text-based installation program gathers the same configuration information as the GUI
installation program does. This information is stored in the installer.xml file in the directory where
you run the installation program.
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The installation program does not write the information it gathers into the installer.xml file until you
exit the installation program, and you cannot go back when you use the text-based installation
program. Therefore, when you use the text-based installation program, you should plan your
installation carefully in advance, using the Basic Vibe Installation Summary Sheet or the Advanced
Vibe Installation Summary Sheet. If you make a mistake during the installation, continue to the end of
the installation process and exit the installation program normally, so that all information is saved.
Then run the text-based installation program again. Your previous information is supplied as defaults,
and you can change the information as needed.

Performing a Silent Installation

If your Vibe system expands beyond one server, you might need to repeatedly install the same Vibe
components. A silent installation makes this an easy process.

1 Edit an existing installer.xml file so that it has the hostname of the server where you want to
perform the silent installation and copy it to that server.

2 In the directory where the installation program is located, use the appropriate command to run
the Vibe installation program, depending on the action that you want the silent installation to
perform:

./installer-teaming.linux --silent --install
./installer-teaming.linux --silent --upgrade
./installer-teaming.linux --silent --reconfigure

The Installation program obtains all the information it needs from the installer.xml file and
completes the installation without user interaction. If you have manually modified index server
scripts, such as the indexserver-startup. sh file as described in Section 15.1, “Installing the
Lucene Software,” on page 131, all modifications will be lost when you perform a silent upgrade.
To retain your modifications, you should upgrade with the GUI installation program, as described
in “Using the GUI Installation Program” on page 60.

5.1.3 Creating the Vibe Database

Before you can start Vibe, you need to create the Vibe database.

1 If you haven't done so already, install the database on the Vibe server.

For single-server installations running on Linux, it is easiest to install the MySQL database. For
information about how to install the MySQL database on the Vibe server (on Linux), see
Section A.3.1, “MySQL on Linux,” on page 206.

For more information about installing the database for a multi-server Vibe system, see
Chapter 14, “Creating the Vibe Database on a Remote Server,” on page 125.

2 Ensure that the database already exists on the server that is running the Vibe software or on the
remote server, depending on where you want to install the database.

3 Change to the following directory in your Vibe installation:
cd /vibe installation/temp-installer/db/scripts/sql

This directory contains the following scripts for each database type (MySQL, Microsoft SQL, and
Oracle):

¢ mysqgl-create-empty-database.sql
¢ Oracle-create-empty-database.sqgl
¢ sglserver-create-empty-database.sql

4 (Optional) If you need to change the default database name from sitescape to something else,
edit the . sql file for your database type to replace sitescape with the new name.
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5

10

11

Use the database utility for your database type to run the corresponding script for your database
from the vibe installation/temp-installer/db/scripts/sqgl directory:

MySQL: mysqgl -uusername -ppassword < "mysgl-create-empty-database.sqgl"

Microsoft osqgl -Uusername -Ppassword -1 sglserver-create-empty-database.sql
SQL:
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to create the database.

Oracle: sglplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@oracle-create-empty-database
SQL>quit;

Change to the db directory in the Vibe installation:
cd /vibe installation/temp-installer/db
This directory contains the following properties files:

¢ mysqgl-liquibase.properties

¢ Oracle-liquibase.properties

* sglserver-liquibase.properties

In a text editor, open the properties file that corresponds with your database type to make any of
the following changes. Save and close the text editor when you are finished making changes.

+ Change the database user name and password for accessing the database.
+ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace localhost with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database is
sitescape, the name of the company that previously developed the Vibe software).

In the same directory, execute the following command to create the database schema:
manage-database.sh database type updateDatabase
For example, if you are using a MySQL database:

manage-database.sh mysqgl updateDatabase

NOTE: You can safely ignore the following Liquibase log messages:

¢ Warning: modifyDataType will lose primary key/autoincrement/not null
settings for mysqgl

+ Any messages that contain the words info: failure Or info: failed, as long as they
are associated with a type INFO message

Start the Vibe server as described in “Starting Vibe on Linux” on page 67.
For security reasons, delete the password that you specified in Step 7:
10a Change to the following directory in your Vibe installation:

cd /vibe installation/temp-installer/db

10b In atext editor, open the database script that corresponds with your database type to delete
the password.

10c Save and close the properties file.

Continue with Section 5.1.4, “Performing Post-Installation Tasks on Linux,” on page 65.
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5.14 Performing Post-Installation Tasks on Linux

+ “Installing Missing Libraries” on page 65

+ “Checking for Available Hot Patches” on page 65

+ “Configuring Vibe to Start Automatically on Reboot” on page 65
+ “Setting Up Port Forwarding” on page 66

+ “Starting Vibe on Linux” on page 67

+ “Checking the Status of the Vibe Server” on page 68

+ “Restarting Vibe” on page 68

+ “Stopping Vibe” on page 68

+ “Uninstalling Vibe” on page 68

Installing Missing Libraries

After you install Vibe on SLES, you should check for and install any missing libraries.
1 Change to the following directory:

/opt/novell/teaming/stellent-converter/linux/x86
2 Run the exporter program.

The errors about missing input and output files are expected; you can safely ignore them.
3 Look for errors about missing libraries.
4 If there are library errors, install any libraries that are missing.

On 64-bit Linux systems, a common missing library is 1ibstdc++.

You can use the following command to install the missing libraries:

zypper in library file

Checking for Available Hot Patches

After you install Vibe, ensure that you check the Vibe download site where you downloaded the Vibe

software for any hot patches that might be available.

Configuring Vibe to Start Automatically on Reboot
You can configure Vibe to start automatically each time you reboot the Linux server.
1 As the Linux root user, enter the following command:

chkconfig --add teaming

2 To verify that automatic startup is turned on, enter the following command:

chkconfig teaming
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Setting Up Port Forwarding

In order to make Vibe available on the default HTTP/HTTPS ports of 80 and 443, you must set up port
forwarding in order to forward the browser default ports (80 and 443) to the Vibe server ports (8080
and 8443). In addition, you must set up port forwarding if you want to forward the default SMTP mail
host port (25) to the default Vibe internal mail host port (2525).

You can set up port forwarding in one of two ways, depending on whether you are using the Vibe
server as a firewall.

+ “Using the SuSEfirewall2 File” on page 66

+ “Using iptables Commands” on page 66

Using the SuSEfirewall2 File
To enable port forwarding on a SUSE Linux server that uses SuSEfirewall2:

1 Asthe Linux root user, open the following file:
/etc/sysconfig/SuSEfirewall2

2 Find the following line:
FW_REDIRECT=""

3 Between the quotation marks, copy and insert the following string:

0/0,1ip address,tcp, 80,8080 0/0,ip address,tcp,443,8443
0/0,1ip address,tcp,25,2525

4 Replace ip address with the IP address of the Vibe server.

5 Save the susEfirewall2 file, then exit the text editor.

6 Use the following command to restart the firewall:
/sbin/SuSEfirewall2 start

7 Use the following command to verify that the default browser ports (80 and 443) have been
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port (25)
has been forwarded to the Vibe internal mail host:

iptables-save | grep REDIRECT

Now, users do not need to include a port number in the Vibe site URL.

Using iptables Commands
To use iptables commands to enable port forwarding on any type of Linux server:

1 As the Linux root user, change to the /etc/init.d directory.

2 In atext editor, create a new file for a set of iptables commands, for example:
gedit vibe-iptables

3 Copy and paste the following lines into the vibe-iptables file:
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iptables

iptables

iptables

iptables

iptables

iptables

iptables

iptables

iptables

-t

nat

nat

nat

nat

nat

nat

nat

nat

nat

-A

OUTPUT -d localhost -p tcp --dport 80
-j REDIRECT --to-ports 8080

OUTPUT -d hostname -p tcp --dport 80
-j REDIRECT --to-ports 8080

PREROUTING -d hostname -p tcp --dport 80
-j REDIRECT --to-ports 8080

OUTPUT -d localhost -p tcp --dport 443
-j REDIRECT --to-ports 8443

OUTPUT -d hostname -p tcp --dport 443
-j REDIRECT --to-ports 8443

PREROUTING -d hostname -p tcp --dport 443
-j REDIRECT --to-ports 8443

OUTPUT -d localhost -p tcp --dport 25
-j REDIRECT --to-ports 2525

OUTPUT -d hostname -p tcp --dport 25
-j REDIRECT --to-ports 2525

PREROUTING -d hostname -p tcp --dport 25
-j REDIRECT --to-ports 2525

In this example, the lines are wrapped for readability. When you paste them into the text editor, if

the lines are still wrapped, remove the hard returns so that you have six iptables commands,

each on its own line.

4 Replace hostname with the hostname or IP address of the Vibe server.

5 Save the vibe-iptables file, then exit the text editor.

6 Use the following command to make the file executable:

chmod +x vibe-iptables

7 Use the following command to immediately execute the commands in the vibe-iptables file:

chkconfig vibe-iptables on

8 Use the following command to add vibe-iptables to future server boot initialization:

chkconfig --add vibe-iptables

9 Use the following command to verify that the default browser ports (80 and 443) have been

forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port (25)
has been forwarded to the Vibe internal mail host:

iptables-save | grep REDIRECT

Now, users do not need to include a port number in the Vibe site URL.

Starting Vibe on Linux

The Vibe Installation program created a teaming startup script in the /etc/init.d directory.

1 In aterminal window, become root by entering su - and the root password.

2 Enter the following command to start Vibe:

/etc/init.d/teaming start

You must execute the teaming Script as root, but the script runs Vibe as the user you selected
in Section 4.10.2, “Linux User ID for Vibe,” on page 56 and specified during installation.

You should see output similar to the following example:
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Using CATALINA BASE: /opt/teaming/apache-tomcat

Using CATALINA HOME: /opt/teaming/apache-tomcat
Using CATALINA TEMPDIR: /opt/teaming/apache-tomcat/temp
Using JRE_HOME: /use/java/jdkl.6.0 02/jre

3 Ensure that Vibe is ready for work:
3a Change to the following directory:
/opt/novell/teaming/apache-tomcat/logs
3b Enter the following command to display the end of the Tomcat log:
tail --f catalina.out

At the end of the log file listing, you should see:

INFO: Server startup in nnnn ms

4 Press Ctrl+C when you finish viewing the catalina.out file.

Checking the Status of the Vibe Server

You can see if Vibe is running by checking for its process ID (PID).

1 In aterminal window, enter the following command:
ps -eaf | grep teaming

You should see the Vibe PID number, along with a listing of configuration settings.

Restarting Vibe

You need to restart Vibe whenever you use the Vibe installation program to make configuration
changes, as described in Chapter 11, “Performing an Advanced Vibe Installation,” on page 115.

1 As root in a terminal window, enter the following command:
/etc/init.d/teaming restart

You should see the same output as when you originally started Vibe.

Stopping Vibe

1 As root in a terminal window, enter the following command:
/etc/init.d/teaming stop
You should see the same output as when you started Vibe.
2 To verify that Vibe has stopped, check for its PID number:
ps -eaf | grep teaming

The Vibe PID number, along with a listing of configuration settings, should no longer be
displayed.

Uninstalling Vibe

If you move the Vibe site to a different server, you can delete the Vibe files from the original server to
reclaim disk space. The default Vibe file locations are:

Vibe Software /opt/novell/teaming
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5.2

5.2.1

Vibe File Repository and /var/opt/novell/teaming
Lucene Index

MySQL Database /var/lib/mysqgl

For a complete list of your Vibe files, check the installer.xml file in the directory where you
originally ran the Vibe installation program.

Windows: Installing and Setting Up a Basic Vibe
Site

You should already have reviewed Chapter 4, “Planning a Basic Vibe Installation,” on page 39 and
filled out the Basic Vibe Installation Summary Sheet. The following sections step you through the
process of installing and starting Novell Vibe on Windows:

+ Section 5.2.1, “Performing Pre-Installation Tasks on Windows,” on page 69
+ Section 5.2.2, “Running the Windows Vibe Installation Program,” on page 70
+ Section 5.2.3, “Creating the Vibe Database,” on page 71

+ Section 5.2.4, “Performing Post-Installation Tasks on Windows,” on page 73

Performing Pre-Installation Tasks on Windows

+ “Verifying System Requirements” on page 69
+ “Stopping an Existing Web Server” on page 69
+ “Setting Environment Variables” on page 69

Verifying System Requirements

Ensure that the Windows server where you plan to install Vibe meets the system requirements listed
in Section 2.1, “Vibe Server Requirements,” on page 17.

Stopping an Existing Web Server

If a web server is currently running on the Vibe server, stop it, and preferably disable it.
For example, to stop and disable the Internet Information Services (1IS) web server:

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click World Wide Web Publishing Service, then click Properties.
3 In the Startup type drop-down list, select Disabled.

4 Click Stop, then click OK.

Setting Environment Variables

Ensure that the JAVA_ HOME environment variable is set to the path where you installed the JDK and
that the Windows PATH environment variable includes the path to your database server.

1 Right-click My Computer, then click Properties.
2 On the Advanced tab, click Environment Variables.
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3 Set the JAVA_HOME environment variable:
3a In the System variables box, click New.
3b In the Variable name field, specify JAVA_HOME.
3c In the Variable value field, specify the path where you installed the JDK.

3d Click OK to add the JAVA_HOME environment variable to the list of system variables, then
click OK again to save the setting and return to the Advanced tab.

4 Check the PATH environment variable:
4a On the Advanced tab, click Environment Variables.
4b In the System variables list, locate the PATH environment variable.
4c If the path includes your database server software directory, click Cancel.

or

If the path does not include your database server software directory, add the directory, then
click OK.

5.2.2 Running the Windows Vibe Installation Program

70

1 Log in to the Windows server as a user with Administrator rights.

2 In Windows Explorer, browse to the directory where you downloaded and extracted the Vibe
software.

3 Ensure that there is a 1icense-key.xml file in the directory.

The Vibe installation program does not start without a license file, and it has a different name
when you download it.

For more information about licensing, see Chapter 7, “Updating Your Vibe License,” on page 79.
4 Double-click the installer-teaming.exe file to start the Vibe installation program.

5 Accept the License Agreement, then click Next.

i & Novell Vibe 4 Installation P_ @‘
Installation Options
Select the action you want to perform. N
& New installation
¢ Update software and settings
" Reconfigure settings

6 Click Next to accept the default of New installation.

, ‘

Choose Installation Type N

Select the type of installation you want to perform

Basic Select the Basic installation if you do not want te configure any of
| Advanced the optional festures. |

7 Click Next to accept the default of Basic.

8 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet to
provide the information that the Vibe installation program prompts you for:
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Installation Locations
Default Locale for Novell Vibe
Network Information
WebDAV Authentication Method
Database Selection
Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm
Java JDK Location
Outbound Email Configuration
Protocol
Host, Port, and Time Zone
User Name, Password, and Authentication
Allow Sending Email to All Users
Inbound Email Configuration
Adding File Types for HTML Conversions

The installation program stores the information that it gathers in the installer.xml file in the
same directory where you started the installation program.

9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the installer.log file in the same
directory where you ran the Installation program. If a problem arises during the installation, the
installer.log file provides information that can help you resolve the problem.

11 Continue with Section 5.2.3, “Creating the Vibe Database,” on page 71.

5.2.3 Creating the Vibe Database

Before you can start Vibe, you need to create the Vibe database.

1 If you haven't done so already, install the database on the Vibe server.

For single-server installations running on Windows, install either the MySQL or Microsoft SQL
database. (For information about how to install the MySQL database on the Vibe server (on
Windows), see Section A.3.2, “MySQL on Windows,” on page 208).

For more information about installing the database for a multi-server Vibe system, see
Chapter 14, “Creating the Vibe Database on a Remote Server,” on page 125.

2 Change to the following directory in your Vibe installation:
vibe installation\temp-installer\db\scripts\sqgl

This directory contains the following scripts for each database type (MySQL, Microsoft SQL, and
Oracle):

¢ mysqgl-create-empty-database.sql
¢ Oracle-create-empty-database.sqgl
¢ sglserver-create-empty-database.sql

3 (Optional) If you need to change the default database name from sitescape to something else,
edit the . sql file for your database type to replace sitescape with the new name.
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4 Use the database utility for your database type to run the corresponding script for your database

from the vibe installation/temp-installer/db/scripts/sqgl directory:

MySQL: mysqgl -uusername -ppassword < "mysgl-create-empty-database.sqgl"

Microsoft osqgl -Uusername -Ppassword -1 sglserver-create-empty-database.sql
SQL:
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to create the database.

Oracle: sglplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@oracle-create-empty-database
SQL>quit;

Change to the db directory in the Vibe installation:
vibe installation\temp-installer\db
This directory contains the following properties files:
¢ mysqgl-liquibase.properties
¢ Oracle-liquibase.properties
* sqglserver-liquibase.properties

In a text editor, open the properties file that corresponds with your database type to make any of
the following changes. Save and close the text editor when you are finished making changes.

+ Change the database user name and password for accessing the database.
+ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace localhost with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database is
sitescape, the name of the company that previously developed the Vibe software).

In the same directory, execute the following command to create the database schema:
manage-database.bat database type updateDatabase
For example, if you are using a Microsoft SQL database:

manage-database.bat sglserver updateDatabase

NOTE: You can safely ignore the following Liquibase log messages:

¢ Warning: modifyDataType will lose primary key/autoincrement/not null
settings for mysqgl

+ Any messages that contain the words info: failure Or info: failed, as long as they
are associated with a type INFO message

8 Start the Vibe server as described in “Starting Vibe on Linux” on page 67.

9 For security reasons, delete the password that you specified in Step 7:

9a Change to the following directory in your Vibe installation:
cd /vibe installation/temp-installer/db

9b In a text editor, open the database script that corresponds with your database type to delete
the password.

10 Continue with Section 5.2.4, “Performing Post-Installation Tasks on Windows,” on page 73.
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5.2.4

Performing Post-Installation Tasks on Windows

“Checking for Available Hot Patches” on page 73
“Running Vibe as a Windows Service” on page 73
“Running Vibe as a Windows Application” on page 74
“Uninstalling Vibe” on page 74

Checking for Available Hot Patches

After you install Vibe, ensure that you check on the Vibe download site where you downloaded the
Vibe software for any hot patches that might be available.

Running Vibe as a Windows Service

*

“Configuring Vibe as a Windows Service” on page 73

“Starting Vibe as a Windows Service” on page 73

“Configuring the Vibe Service to Start Automatically on Reboot” on page 74
“Restarting the Vibe Service” on page 74

“Stopping the Vibe Service” on page 74

Configuring Vibe as a Windows Service

The Vibe installation program created a service.bat file for configuring Vibe to run as a Windows
service.

1 In a Command Prompt window, change to the following directory:

c:\Program Files\Novell\Teaming\apache-tomcat\bin\windows
In the windows directory, copy the files from the appropriate subdirectory.
The following subdirectories exist: x86, x64, ia64.

If you are unsure which subdirectory is appropriate for your server, use the readme. txt file
located in the c:\Program Files\Novell\Teaming\apache-tomcat\bin\windows directory as
a reference.

3 Paste the files into the c¢:\Program Files\Novell\Teaming\apache-tomcat\bin directory.

Use the following command to configure Vibe as a Windows service:
service.bat install Teaming

This creates a service named Apache Tomcat Teaming.

Starting Vibe as a Windows Service

1 On the Windows desktop, click Start > Administrative Tools > Services.

2 Right-click Apache Tomcat Teaming, then click Start.
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Configuring the Vibe Service to Start Automatically on Reboot

When you run Vibe as a Windows service, you can configure Vibe to start automatically each time
you reboot the Windows server.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Properties.
3 In the Startup type drop-down list, select Automatic, then click OK.

Restarting the Vibe Service

You need to restart Vibe whenever you use the Vibe installation program to make configuration
changes, as described in Chapter 11, “Performing an Advanced Vibe Installation,” on page 115.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Restart.
3 Close the Services window.

Stopping the Vibe Service

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Stop.
3 Close the Services window.

Running Vibe as a Windows Application

+ “Starting Vibe as an Application” on page 74
+ “Stopping Vibe as an Application” on page 74
Starting Vibe as an Application
The Vibe installation program created a startup.bat file for starting Vibe.
1 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat\bin
2 Run the startup.bat file to start Vibe as an application.
Stopping Vibe as an Application

1 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat\bin

2 Run the shutdown.bat file to stop the Vibe application.

Uninstalling Vibe

If you move the Vibe site to a different server, you can delete the Vibe files from the original server to
reclaim disk space. The default Vibe file locations are:
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Vibe Software c¢:\Program Files\Novell\Teaming

Vibe File Repository and c:\Novell\Teaming
Lucene Index

MS SQL Database c:\Program Files\Microsoft SQL Server\MSSQL\Data

For a complete list of your Vibe files, check the installer.xml file in the directory where you
originally ran the Vibe Installation program.
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Adding Users to Your Vibe Site

After you have installed Novell Vibe and ensured that Vibe starts successfully, you are ready to
access your Vibe site from your web browser and add users.

+ Section 6.1, “Accessing Your Basic Vibe Site as the Site Administrator,” on page 77
¢ Section 6.2, “Creating a User,” on page 77
+ Section 6.3, “Adding Vibe Users from Your LDAP Directory,” on page 78

6.1 Accessing Your Basic Vibe Site as the Site
Administrator

1 In your web browser, specify one of the following URLs, depending on whether you are using a
secure SSL connection:

http://vibe hostname
https://vibe hostname

Replace vibe hostname with the hostname or fully qualified domain name of the Vibe server
that you have set up in DNS. If you configured the HTTP ports correctly during installation, you
do not need to include the port number in the Vibe URL.

Fang ol your paEssword

2 If this is the first time you have logged in to the Vibe site, log in using admin as the login name
and admin as the password.

The Change Password dialog box is automatically displayed when you first log in to the Vibe
site.

If this is not your first time logging in, log in using admin as the login name and your password.

6.2 Creating a User

For information about how to create a local user in the Vibe system, see “Creating a New Local User”
in the Novell Vibe 4.0 Administration Guide.
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6.3 Adding Vibe Users from Your LDAP Directory

Unless you have a very small Novell Vibe site, you create Vibe users by synchronizing their user
information from an LDAP directory service such as Novell eDirectory or Microsoft Active Directory.

For information about how to add users to your Vibe system via LDAP, see “Synchronizing Users and
Groups from an LDAP Directory” in the Novell Vibe 4.0 Administration Guide.

IMPORTANT: Consider the following before you add users to your Vibe system:

+ For a large Vibe site with thousands of users, the synchronization process can consume
substantial server resources and can take some time to complete. Perform the initial import from
the LDAP directory at a time when this processing does not conflict with other activities on the
server.

+ After they are added to the Vibe system, users could log into the Vibe site by using their
eDirectory or Active Directory user names and passwords. However, you should not invite users
to access the Vibe site until after you have finished setting up the Vibe site, as described in “Site
Setup” in the Novell Vibe 4.0 Administration Guide.
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Updating Your Vibe License

Several Vibe license types are available:
+ Evaluation License: Available from Novell Downloads (http://download.novell.com).

You receive your 60-day evaluation license when you download the evaluation version of Vibe.

+ Starter Pack License: Available from Novell Downloads (http://download.novell.com) and from
the Novell Vibe Starter Pack web page (http://www.novell.com/products/teaming/
starterpack.html).

You receive your 10-user starter pack license when you download the 10-user starter pack.
+ Standard Vibe License: Purchased through a Novell sales representative or Novell partner.

The Standard Vibe License gives full Vibe functionality on a per-user basis.

After you purchase the Standard Vibe License, you can access your license key or view your

purchase history in the Novell Customer Center (http://www.novell.com/customercenter).

If you are upgrading to a new version of Vibe, or if you originally installed Vibe with an Evaluation
License or a Starter Pack License, it is easy to update your Vibe site with a new license file.

1 Copy the new license file that you downloaded from one of the sources listed above into the
directory where you originally ran the Vibe installation program.

Rename the existing 1icense-key.xmnl file to a different name.

Rename the new license file to 1icense-key.xml.

Stop Vibe.

Run the Vibe Installation program, select the Reconfigure Settings option, then select the Basic
Installation option.

a A W N

6 Click Next through all the installation program pages, then click Install to update your Vibe
license.

7 Start Vibe.
8 Log in to the Vibe site as the Vibe administrator.
9 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon '+,
10 Under Management, click License.
11 If the contents of the new license file are not displayed, click Reload Vibe License.
12 Click Close.

At any time, you can generate a report of license usage, as described in “License Report” in “Site
Maintenance” in the Novell Vibe 4.0 Administration Guide.
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Setting Up Vibe

After you have installed and started Novell Vibe, there are still administrative tasks to perform before
your Vibe site is ready for users to log in and use Vibe efficiently. Refer to the following sections of the
Novell Vibe 4.0 Administration Guide as you finish setting up your Vibe site.

*

*

“Setting Up Initial Workspaces”

“Planning and Controlling User Access to Workspaces and Folders”
“Setting Up User Access to the Vibe Site”

“Setting Up Site-Wide Customizations”

“Configuring Vibe to Support WebDAV on Windows 7”
“Configuring Email Integration”

“Configuring Weekends and Holidays”

“Configuring Real-Time Communication Tools”

“Enabling Custom JSPs to Be Used on Your Vibe Site”
“Enabling Custom JAR Files to Be Used on Your Vibe Site”
“Setting Up Mirrored Folders”

“Setting Up Zones (Virtual Vibe Sites)”

“Adding Software Extensions to Your Vibe Site”

“Using Remote Applications on Your Vibe Site”

“Managing a Multiple-Language Vibe Site”
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9 Basic Vibe Installation Summary Sheet

Installation Program Field

Value for Your Vibe Site

Explanation

Vibe Server Platform:

+ Windows

¢ Linux

See Section 4.2.1, “Vibe Server
Platform,” on page 40.

Vibe Server Architecture:

¢ 32-bit
* 64-bit

See Section 4.2.2, “Vibe Server
Architecture,” on page 40.

Vibe Server Memory:

¢ 4GB
¢+ 8GB

¢ More

See Section 4.2.3, “Vibe Server
Memory,” on page 41.

Java Development Kit (JDK):

¢ Sun JDK
¢ |BM JDK

See Section 4.3, “Selecting a
Java Development Kit,” on
page 43.

Vibe Installation Locations:
+ Software

Linux default:

/opt/novell/teaming

Windows default:

c:\Program

Files\Novell\Teaming

* File repository

Linux default:

/var/opt/novell/teaming

Windows default:

c:\Novell\Teaming

See Section 4.2.4, “Vibe
Installation Locations,” on
page 42.

TrueType Font Location:

Default:

/usr/X11R6/1ib/X11/fonts/

truetype

See Section 4.2.5, “TrueType
Font Location (Linux Only),” on
page 43.
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Installation Program Field Value for Your Vibe Site Explanation

Vibe Site Locale: See Section 4.12,
“Accommodating Multiple
Language: Languages,” on page 57.

¢ Chinese-Simplified
¢ Chinese Traditional
¢ Danish

¢ Dutch

+ English

+ French

*+ German

¢ Hungarian

* Japanese

+ Polish

* Portuguese

¢ Russian

¢ Spanish

+ Swedish

Country:

User ID for Novell Vibe (Linux only): See Section 4.10.2, “Linux User
ID for Vibe,” on page 56.

¢ User ID:
Full name:

Password:

* Group ID:

Network Information: See Section 4.4, “Gathering
Network Information for Your Vibe
¢ Host: Site,” on page 43.

¢ HTTP port: 80

¢ Secure HTTP port: 443
+ Listen port: 8080

* Secure listen port: 8443
¢ Shutdown port:

* AJP port:

WebDAYV Authenticaiton Method: See Section 4.5, “Planning the
_ WebDAV Authentication Method,”
¢ basic on page 46.

+ digest
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Installation Program Field

Value for Your Vibe Site

Explanation

Database Type:

* MySQL
* Microsoft SQL

+ Oracle

See Section 4.6.1, “Database
Type,” on page 48.

JDBC URL:

¢ Hostname:

¢ Port number:

See Section 4.6.3, “Database
Location,” on page 49.

Database Credentials:

¢ User name:

+ Password:

See Section 4.6.4, “Database
Credentials,” on page 50.

Database Setup Method:

+ Basic installation (same server as
Vibe software)

+ Remote installation

See Section 4.6.2, “Database
Setup Method,” on page 49.

Database Encryption Algorithm:

¢ SHA-256

¢ PBEWITHSHA256AND128BITAES-
CBC-BC

See Section 4.6.5, “Database
Encryption Algorithm,” on
page 50.

Java JDK Location:

+ Java home:

* JVM heap size:

See Section 4.3, “Selecting a
Java Development Kit,” on
page 43.

Outbound Email Protocol:

¢ SMTP
¢ SMTPS

See Section 4.7.1, “Outbound
Email Protocol,” on page 51.

Outbound Email Host:

+ Hostname:
¢ SMTP port:
Default: 25
¢ Time zone
+ Continent/region:
+ Country/state:

+ City:

See Section 4.7.2, “Outbound
Email Host,” on page 52.

Outbound Email Authentication:

¢ User name:
+ Password:

+ Authentication required? No / Yes

See Section 4.7.3, “Outbound
Email Authentication,” on
page 52.
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Installation Program Field

Value for Your Vibe Site

Explanation

Allow Sending Email to All Users

Yes / No

See Section 4.7.4, “Outbound
Email Send Restriction,” on
page 53.

From email address override
+ Email address for outbound email

Use this email address for all
outbound email

Yes / No

See Section 4.7.5, “Outbound
Email From Address,” on page 53.

Inbound Email Configuration

+ Enable: No/ Yes
¢ SMTP bind address:
¢ SMTP port:

¢ Announce TLS: Yes / No

See Section 4.8, “Enabling
Inbound Email,” on page 53.

File Types for HTML Conversions

+ Added HTML Extensions:

See Section 4.9, “Adding File
Types for HTML Conversions,” on
page 55

Vibe Site Password:

+ Administrator user name: admin
+ Default password: admin

* Your password:

See Section 4.10.1, “Vibe Site
Administrator Password,” on
page 55.

LDAP Directory Service:

+ Novell eDirectory
* Microsoft Active Directory

¢ Other LDAP directory

See “Synchronizing Users and
Groups from an LDAP Directory
in the Novell Vibe 4.0
Administration Guide.

LDAP Server:

+ LDAP server URL:
¢ User DN:

+ Password:

See “Server Information” in the
Novell Vibe 4.0 Administration
Guide.

GUID Attribute (to identify the user):
¢ GUID

screenName=GUID
¢ object GUID

screenName=objectGUID

See “Server Information” in the
Novell Vibe 4.0 Administration
Guide.
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Installation Program Field Value for Your Vibe Site

Explanation

LDAP Attribute for Vibe Name:

¢ cn

screenName=cn
¢ uid

screenName=uid

See “Server Information” in the
Novell Vibe 4.0 Administration
Guide.

LDAP User Search Context:

¢ Base DNs:
+ Additional filter attributes:

* Search subtree: Yes / No

See “Configuring User
Synchronization Options” in the
Novell Vibe 4.0 Administration
Guide.

LDAP Group Search Context:

+ Base DNs:
+ Additional filter attributes:

* Search Subtree: Yes / No

See “Configuring Group
Synchronization Options” in the
Novell Vibe 4.0 Administration
Guide.

LDAP Synchronization Schedule:

¢ Days
+ Every day
* Weekly
Sun Mon Tue Wed Thu Fri Sat

¢ Hours:
* Attime:

+ Repeat every nn hours

See “Configuring the
Synchronization Schedule” in the
Novell Vibe 4.0 Administration
Guide.

LDAP User Options:

+ Synchronize user profiles

* Register LDAP user profiles
automatically

+ Delete users that are not in LDAP

+ When deleting a user, delete
associated user workspaces and
content

+ Time zone for new users

See “Configuring User
Synchronization Options” in the
Novell Vibe 4.0 Administration
Guide.

LDAP Group Options:

+ Synchronize group profiles

* Register LDAP group profiles
automatically

+ Synchronize group membership

+ Delete local groups that are not in
LDAP

See “Configuring User
Synchronization Options” in the
Novell Vibe 4.0 Administration
Guide.
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I I Advanced Installation and
Reconfiguration

*

Chapter 10, “Planning an Advanced Vibe Installation,” on page 91

*

Chapter 11, “Performing an Advanced Vibe Installation,” on page 115

*

Chapter 12, “Setting Configuration Options after Installation,” on page 117

*

Chapter 13, “Advanced Vibe Installation Summary Sheet,” on page 119

Advanced Installation and Reconfiguration 89



90 Novell Vibe 4.0 Installation Guide



O Planning an Advanced Vibe Installation

10.1

The Advanced installation provides additional options for you to customize Novell Vibe.

+ Section 10.1, “What Is an Advanced Installation?,” on page 91

+ Section 10.2, “Distributing Different Data Types to Different Locations,” on page 92
¢ Section 10.3, “Using Advanced Network Information Settings,” on page 93

+ Section 10.4, “Configuring Requests and Connections Configuration,” on page 94

+ Section 10.5, “Configuring Web Services,” on page 95

+ Section 10.6, “Changing Your Lucene Index Server Configuration,” on page 95

¢ Section 10.7, “Managing RSS Feeds,” on page 97

+ Section 10.8, “Configuring Presence,” on page 98

+ Section 10.9, “Configuring Single Sign-On with Novell Access Manager,” on page 99

¢ Section 10.10, “Configuring Single Sign-On with Internet Information Services for Windows,” on
page 99

¢ Section 10.11, “Configuring Mirrored Folder Resource Drivers,” on page 112

+ Section 10.12, “Installing the Vibe Software in a Clustered Environment,” on page 114

As you proceed with planning, you can use the Advanced Vibe Installation Summary Sheet to record
your decisions about the options you want to use.

What Is an Advanced Installation?

In addition to the Basic installation options described in Section 4.1, “What |s a Basic Vibe
Installation?,” on page 39, the installation program for Vibe provides several advanced installation
and configuration alternatives. You can implement the advanced options after performing a Basic
installation, or you can have the installation program present all the options together.

Compared to a Basic installation, an Advanced installation offers the following additional options:

+ Changing the session timeout

+ Specifying a keystore file

+ Specifying different directories for different types of data

+ Configuring requests and connections configuration

+ Disabling and enabling four different web services

+ Changing the configuration of the Lucene Index Server

+ Configuring a remote Lucene Index Server or a group of high-availability Lucene nodes
+ Reconfiguring how RSS feeds are retained or disabling them entirely
+ Enabling presence in conjunction with Novell Messenger

+ Configuring a reverse proxy to accommodate single sign-on

+ Configuring Windows Authentication
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10.2

+ Configuring mirrored folders
+ Installing Vibe in a clustered environment

IMPORTANT: The following Vibe configurations require that you perform an Advanced installation as
your initial installation of the Vibe software:

+ Setting up the Vibe file repository so that some types of files are located outside the Vibe file
repository root directory. See Section 10.2, “Distributing Different Data Types to Different
Locations,” on page 92 for Advanced installation instructions. You cannot move subdirectories
within the Vibe file repository after they have been created.

+ Installing the Vibe software on multiple servers to create a clustered environment. See
Chapter 16, “Running Vibe on Multiple Servers,” on page 135 for Advanced installation
instructions. The option to enable a clustered environment is available only during an Advanced
installation.

If you want to implement an Advanced installation option, you should perform a Basic installation first,
in a test environment, before performing the Advanced installation to set up your permanent Vibe site.

Distributing Different Data Types to Different
Locations

The default location for the Novell Vibe file repository varies by platform:

Linux: /var/opt/novell/teaming

Windows: c:\Novell\Teaming

Under the main Vibe file repository root directory are subdirectories for various kinds of data files that
are not stored in the Vibe database (MySQL, Microsoft SQL Server, or Oracle). You can use an
Advanced installation to store Vibe data files in various locations.

The data files not stored in the Vibe database are divided into several functional areas:
+ Simple file repository: A large consumer of disk space.

All attachment files are stored in the file repository. All versions of files are also stored here.

+ Jackrabbit repository: (Optional) Takes only a fraction of the space consumed by the file
repository.
By default, Vibe stores all data files individually on disk, in the file repository. If you prefer to store

data files in the database itself, you can use Apache Jackrabbit with Vibe. See the Apache
Jackrabbit website (http://jackrabbit.apache.org) for setup instructions.

+ Extensions repository: Disk space consumption depends on the number of extensions you
add to your Vibe site.

An extension is a software program that you can incorporate into your Vibe site in order to
enhance (extend) Vibe capabilities. Adblock Plus is an example of a Firefox browser extension
that filters out advertisements. You or a Java developer can create custom extensions for your
Vibe site. For more information about creating and using Vibe extensions, see the Novell Vibe
4.0 Developer Guide.

+ Archive store: A large consumer of disk space.
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10.3

10.3.1

When entries are deleted, files that were attached to the deleted entries are retained in the
archive store in order to meet compliance and archival goals. Previous versions of documents
are also retained in the archive store. After files have been archived, they are inaccessible from
the Vibe site. Files that accumulate in the archive store must be manually deleted as needed to
manage the disk space occupied by the archive store.

+ Cache store: Consumes less disk space than the file repository.

Information derived from the attachments (such as thumbnails, HTML renderings, scaled
images), and word lists for indexing are stored in the cache store.

+ Lucene index: Takes only a fraction of the space consumed by the file repository.

The Lucene index contains only pointers to the actual data stored in the file repository. The index
enables the Lucene search engine to perform very fast searches through large quantities of
data.

The directories for the various types of data can be on the Vibe server or on a remote server. Data
access is fastest if the data is local; however, depending on the size of your Vibe site and the types of
data you store, the Vibe server might not be the best place to store all the Vibe data. If you want to
store any of the data types on a remote server, you must ensure that the remote location of the data
appears local to the Vibe server and that it is always available with read/write access.

Linux: Mount the file repository to the Vibe server.

Windows: Map a drive from the Vibe server to the file repository.

Linux and Place the file repository on a SAN (storage area network) with read/write access. This alternative

Windows provides the most reliable remote location for the Vibe file repository. This is required for a
clustered environment, as described in Chapter 16, “Running Vibe on Multiple Servers,” on
page 135.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Data Locations, specify the directories where you want to store the various types of Vibe data.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 11, “Performing an Advanced Vibe Installation,” on
page 115.

Using Advanced Network Information Settings

+ Section 10.3.1, “Changing the Vibe Session Timeout,” on page 93
+ Section 10.3.2, “Providing a Secure Keystore File,” on page 94

Changing the Vibe Session Timeout

By default, if a user's Novell Vibe session is idle for four hours (240 minutes), Vibe logs the idle user
out. For increased convenience to Vibe users, you can make the session timeout interval longer. For
increased security for your Vibe site, you can make the session timeout shorter.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the session timeout interval (in minutes) for your Vibe site.
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10.3.2

10.4

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 11, “Performing an Advanced Vibe Installation,” on
page 115.

Providing a Secure Keystore File

For your convenience, the Vibe software includes a self-signed public certificate that enables you to
specify secure HTTP and listen ports during installation. This certificate is stored in the .keystore file
in the following directory:

Linux: /opt/novell/teaming/apache-tomcat/conf

Windows: c:\Program Files\Novell\Teaming\apache-tomcat\conf

To ensure secure SSL connections for your Vibe site, you should replace the self-signed public
certificate with a public certificate issued by a valid certificate authority.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the name and location of the public certificate.

If you do not already have a permanent public certificate for your Vibe server, see “Securing HTTP
Browser Connections” in “Site Security” in the Novell Vibe 4.0 Administration Guide.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 11, “Performing an Advanced Vibe Installation,” on
page 115.

Configuring Requests and Connections
Configuration

You can configure the number of client requests and database connections that Vibe is able to
support.

If you have an extremely large Vibe site and you need to make numerous client requests and
database connections, you might see improved performance by increasing these settings.

+ Max Threads: The maximum number of simultaneous client request threads that Vibe is able to
support. The default is 200 threads.

+ Max Active: The maximum number of database connections that can be allocated from this pool
at the same time.

If your database server license (for Oracle or MS SQL) restricts you from having more
connections than the Vibe default of 50, you must specify a number that does not exceed your
database server license.

+ Max Idle: The maximum number of database connections that can be idle in this pool at the
same time. The default is 20 connections.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Requests and Connections Configuration, mark the maximum client request threads, maximum
active database connections, and maximum idle database connections.
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10.5

10.6

10.6.1

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 11, “Performing an Advanced Vibe Installation,” on
page 115.

Configuring Web Services

When you install and set up your Novell Vibe site, three web services are enabled by default; a fourth
is available for selection. These web services enable programs to access information on your Vibe
site just as users would. Allowing programmatic access to your Vibe site can be useful or can be
viewed as a security risk.

+ WSS authentication: Uses OASIS Web Services Security (WSS) (http://www.oasis-open.org).

¢+ HTTP Basic authentication: Uses HTTP Basic Access authentication (http://tools.ietf.org/html/
rfc2617).

+ Token-based authentication: Uses custom Vibe tokens to communicate with Vibe remote
applications. For more information, see “Using Remote Applications on Your Vibe Site” in “Site
Setup” in the Novell Vibe 4.0 Administration Guide.

+ Anonymous access: Allows access to your Vibe site without authentication. It is similar to the
Guest access provided for users, as described in “Allowing Guest Access to Your Vibe Site” in
“Site Setup” in the Novell Vibe 4.0 Administration Guide.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Web Services, mark which web services you want enabled for your Vibe site. The first three are
enabled by default. The fourth is disabled by default.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 11, “Performing an Advanced Vibe Installation,” on
page 115.

Changing Your Lucene Index Server Configuration

The default Lucene Index Server configuration is appropriate for a medium-sized Novell Vibe site. If
you have a larger Vibe site, you can change its Lucene Index Server configuration.

*

Section 10.6.1, “Understanding Indexing,” on page 95

*

Section 10.6.2, “Changing Lucene Configuration Settings,” on page 96

*

Section 10.6.3, “Running the Lucene Index Server in Its Own JVM,” on page 96

*

Section 10.6.4, “Running the Lucene Index Server on a Remote Server,” on page 97

*

Section 10.6.5, “Running Multiple Lucene Index Servers,” on page 97

After planning your Lucene configuration, complete the planning process for additional Advanced
installation features as needed, then perform the Advanced installation as described in Chapter 11,
“Performing an Advanced Vibe Installation,” on page 115.

Understanding Indexing

The Lucene Index Server is responsible for indexing all data on the Vibe site so that Vibe users can
easily use the Find and Search features to retrieve the information that they need. Text posted in
folder entries is easy to index, because the formatting is simple. However, text in attached files arrives
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10.6.2

10.6.3

in many different file formats, many of which require conversion before the text in the files can be
indexed. Therefore, the Lucene Index Server is dependent on the available file conversion
technology in order to perform its indexing function. For information about the file viewers that Vibe
uses, see Section 2.5.1, “File Viewer Support,” on page 23.

The Lucene Index Server provides additional services on your Vibe site in addition to indexing. In
fact, you cannot access your Vibe site if the Lucene Index Server is not running. For this reason,
Novell Vibe provides multi-server Lucene configuration options that are not available in Kablink Vibe.

Changing Lucene Configuration Settings

If you have an extremely large Vibe site and you need to reindex the Vibe data, you might see
improved performance by increasing these settings.

+ Max booleans: The default is 10000. This means that 10,000 Boolean clauses are allowed in a
guery. You need to increase this only if your Vibe site includes more than 10,000 users, groups,
or teams.

+ RAM in MB that may be used for buffering: The default is 256 MB for remote and high
availability Lucene configurations and 32 MB for local Lucene configurations. This is the amount
of RAM that is allocated for buffering documents and deletions before they are flushed to the
directory. (This setting can be changed only in the Lucene installer; it is not available in the Vibe
installer.)

+ Merge factor: The default is 10. This sets the number of index segments that are created on
disk. When additional index segments are needed, existing segments are merged to keep the
merge factor constant.

+ Network interface for RMI service: (Optional) Specify the IP address or hostname for the
network interface for the RMI (Remote Method Invocation (http://java.sun.com/javase/
technologies/core/basic/rmi/index.jsp)) service.

This is the hostname of the server where the Lucene Index is installed.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify any Lucene configuration settings that you want to change.

Running the Lucene Index Server in Its Own JVM

By default, the Lucene Index Server runs in the same Java Virtual Machine (JVM) as the Vibe
software. To leave more memory available for the Novell Vibe software, you can configure the Lucene
Index Server to run in a separate JVM. In this configuration, it communicates with the Vibe software
using the RMI (Remote Method Invocation (http://java.sun.com/javase/technologies/core/basic/rmi/
index.jsp)) port, which by default is 1199.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify a hostname of Localhost. Use the default RMI port number unless
it is already in use on the server.

To change from running the Lucene Index Server in the same JVM with Vibe to running it in its own
JVM, you must complete the same steps that you use for setting up the Lucene Index Server on a
remote server. This includes manually installing the Lucene Index Server software on the Vibe server,
as described in Chapter 15, “Installing the Lucene Index Server on a Remote Server,” on page 131.
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10.6.4

10.6.5

10.7

10.7.1

10.7.2

Running the Lucene Index Server on a Remote Server

If the Lucene Index Server requires more memory, disk space, or CPU resources than are available
on the Novell Vibe server, you can move it to a remote server. This requires installing the Lucene
Index Server software on that server. For instructions, see Chapter 15, “Installing the Lucene Index
Server on a Remote Server,” on page 131.

Running Multiple Lucene Index Servers

Because the availability of the index is critical to the functioning of the Novell Vibe site, you can install
multiple Lucene Index Servers on multiple remote servers to provide high availability. For instructions,
see Chapter 17, “Running Multiple Lucene Index Servers,” on page 143.

Managing RSS Feeds

By default, Novell Vibe users can set up RSS feeds in folders on the Vibe site, as described in
“Viewing Folders as RSS or Atom Feeds” in “Getting Informed” in the Novell Vibe 4.0 User Guide.
+ Section 10.7.1, “Configuring RSS Feeds,” on page 97
¢ Section 10.7.2, “Disabling RSS Feeds,” on page 97
After planning the RSS settings, complete the planning process for additional Advanced installation

features as needed, then perform the Advanced installation as described in Chapter 11, “Performing
an Advanced Vibe Installation,” on page 115.

Configuring RSS Feeds

The following aspects of RSS functionality on your Vibe site are configurable:

+ Max elapsed days: By default, items from RSS feeds are retained on the Vibe site for 31 days.
You can decrease the number of days to reduce the amount of disk space occupied by the RSS
files.

+ Max inactive days: By default, if no one on the Vibe site accesses an RSS feed for 7 days, the
feed is no longer updated. Increase or decrease the retention time for inactive feeds to meet the
needs of Vibe users and disk space considerations.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, specify the number of days that meet the needs of your Vibe site.

Disabling RSS Feeds

Some administrators consider RSS feeds to be a security risk because the RSS feed URL includes
user name and password information. If you do not want Vibe site users to be able to subscribe to
RSS feeds from the Vibe site, you can disable this feature.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, mark No.
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10.8 Configuring Presence

98

If you are using Novell Messenger as your instant messaging solution, you can configure Novell Vibe
to display a user's Messenger presence information. For information about where presence
information is displayed in Vibe, see “Sending an Instant Message from within Vibe” in the Novell Vibe
4.0 User Guide.

When you click a user’s presence icon, the Profile Quick View is displayed. This enables you to send
an instant message to the user, view the user’s personal workspace, follow the user, and more.

In order to configure Messenger presence to be displayed in Vibe, you need the following information
about the Messenger system during the Vibe installation:

+ Server address: Specify the IP address or DNS hostname of the messaging agent for your
Messenger system.
+ Port: Specify the port number.

+ Server user: Specify the fully typed, comma-delimited context user name of the Allowed Service
User that you want to log in to the Messenger system and retrieve presence information.

For example, cn=vibesvc, o=acme

For more information about the Allowed Service User, see “Integrating Novell Vibe with Novell
Messenger” in the Novell Messenger 2.2 Administration Guide.

+ Password: Specify the password for the Allowed Service User that you want to log in to the
Messenger system and retrieve presence information.

For more information about the Allowed Service User, see “Integrating Novell Vibe with Novell
Messenger” in the Novell Messenger 2.2 Administration Guide.

+ Server Certificate: Browse to and select the Messaging Agent’s SSL certificate. Vibe uses this
certificate to identify the Messenger server.

If Messenger is installed on a separate server, copy the certificate from the Messenger server
and place it in a location on the Vibe server that can be reached from the Vibe installation
program.

The certificate is located in the following directory on the Messenger server:

Linux: /opt/novell /messenger/certs

Windows: c:\Novell\Messenger\certs

To remove the certificate after you have already selected it, click Browse > Cancel.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Presence Configuration, select Enable Novell Messenger Presence, then list the information that
the Vibe site needs to know in order to communicate with the Messenger system.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 11, “Performing an Advanced Vibe Installation,” on
page 115.

IMPORTANT: In order for Messenger presence to display in Vibe when using LDAP, you need to map
presencelID to your authentication attribute in the Vibe LDAP configuration page. For example,
presenceID=cn. For more information, see “Configuring Presence” in the Novell Vibe 4.0
Administration Guide
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10.9

10.10

Configuring Single Sign-On with Novell Access
Manager

Novell Access Manager provides secure single sign-on access to your Novell Vibe site by functioning
as a reverse proxy server. Access Manager 3.1 SP1 IR1 is required for use with Novell Vibe. You can
download the required version of Access Manager from Novell Downloads (http://
download.novell.com).

For background information about setting up Novell Access Manager 3.1, see the Access Manager
3.1 Documentation website (http://www.novell.com/documentation/novellaccessmanager31). For
instructions specific to Vibe, see “Configuring a Protected Resource for a Novell Vibe Server” in the
Novell Vibe 4.0 Administration Guide.

After you have configured Novell Access Manager, you must configure your Vibe site with the IP
address of one or more Access Gateway servers and with the logout URL. When you configure the
Vibe site to use the Access Gateway, the IP addresses that you specify are the only locations from
which the Vibe site accepts logins. The logout URL is the location where users find themselves when
they log out of the Vibe site.

When you enable the Access Gateway for use with your Vibe site, all Vibe users must log in through
the Access Gateway. It is not possible to set up the Vibe site so that some users log in through the
Access Gateway and some do not.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Reverse Proxy Configuration, list one or more IP addresses of Access Gateway servers that have
been configured for use by Vibe. List the logout URL, and if necessary, the Access Gateway hostname for
WebDAV connections.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 11, “Performing an Advanced Vibe Installation,” on
page 115.

Configuring Single Sign-On with Internet
Information Services for Windows

Like Novell Access Manager, Windows Authentication provides Windows users with a single sign-on
experience, enabling users to automatically authenticate to Novell Vibe after they log in to their
individual workstations. Internet Information Services (IIS) provides this capability.

Before you implement Windows Authentication, consider the following limitations:

+ |IS is best suited for an intranet environment. Because NTLM is a connection-based protocol, it
does not work well with HTTP proxy servers.

+ IS does not support Guest Access.

After you configure the Vibe server to support Windows Authentication, complete the planning
process for additional Advanced installation features as needed, then perform the Advanced
installation as described in Chapter 11, “Performing an Advanced Vibe Installation,” on page 115.

¢ Section 10.10.1, “System Requirements,” on page 100

¢ Section 10.10.2, “Planning Your IIS Installation and Configuration,” on page 101

+ Section 10.10.3, “Configuring the Vibe Server to Support Windows Authentication,” on page 102
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10.10.1

¢ Section 10.10.4, “Running the Vibe Installation Program,” on page 108
+ Section 10.10.5, “Configuring Your Browser to Allow Access to the Vibe Site,” on page 108

+ Section 10.10.6, “Bypassing Windows Authentication to Configure LDAP and Perform Other
Tasks,” on page 109

¢ Section 10.10.7, “Logging In to the Vibe Site through Windows Authentication,” on page 110

¢ Section 10.10.8, “Editing Files through WebDAV with Windows Authentication,” on page 110

+ Section 10.10.9, “Configuring 1IS to Allow Uploading of Large Files to the Vibe Site,” on page 111
¢ Section 10.10.10, “Configuring IIS to Load Balance in a Clustered Environment,” on page 111

System Requirements

Windows Authentication with 11S can be enabled for Vibe only in the following environments:

Server

+ Windows 2008 Server
+ Windows 2008 R2 Server

1S

+ [IS 7 with IIS Manager with CGI and ISAPI components
+ IS 7.5 with 1IS Manager with CGI and ISAPI components

Authentication Protocol

One of the following authentication protocols:

* NTLM
+ Kerberos v5
+ Negotiate/SPNEGO (wrapper for NTLM and Kerberos v5)

Domain Controller

+ Active Directory Service

Vibe needs to be configured and synchronized with your Active Directory directory service. For
more information about configuring LDAP synchronization within Vibe, see Section 4.11,
“Gathering Directory Services Information,” on page 56 and “Synchronizing Users and Groups
from an LDAP Directory” in the Novell Vibe 4.0 Administration Guide.

If you are using Kerberos as your authentication protocol, then Key Distribution Services is also
required.

For more information about installing and configuring the domain controller and other domain
services to support Windows Authentication, refer to the appropriate Microsoft documentation.
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10.10.2

Client

One of the following clients:

+ Windows 7
+ Windows XP

Browser

One of the following browsers, configured to support Windows Authentication:

+ Internet Explorer
+ Firefox

For information on how to configure your browser to support Windows Authentication, see
Section 10.10.5, “Configuring Your Browser to Allow Access to the Vibe Site,” on page 108.

Planning Your IIS Installation and Configuration

Use the information in the following table as you consider your IS installation.

Directory: The default installation directory for the IS plug-in is C:\Program Files\Novell.
This is the recommended directory. If for some reason you choose to install the 1IS plug-inin a
directory other than the C:\Program Files\Novell directory, you need to modify the
isapi redirect.properties files, as described in “Installing the Vibe 1IS Plug-In” on

page 102.

External or Local Server: You can install the IIS plug-in on the same server where you are running
Vibe, or you can install it on an external server. Installing 1IS on an external server can have the
following benefits:

+ Performance improvement
+ Ability to integrate with several Vibe servers in a clustered environment

+ Ability to run Vibe from a non-Windows server

If you are running IS from an external server, you need to edit the C: \Program
Files\Novell\Vibe IIS Plugin\conf\workers.properties file, as described in
“Installing the Vibe 1IS Plug-In” on page 102.

64-bit/32-bit: You can install the 1IS plug-in on a 64-bit or 32-bit operating system. However, Vibe
should run on a 64-bit operating system; therefore, if you install IIS on a 32-bit operating system,
you should use an external server.

HTTP Ports: Regardless of whether 1IS and Vibe are located on the same server or separate
servers, the HTTP port and secure HTTP port for Vibe should always be 80 and 443. This ensures
that when links are generated, they contain the correct hostname and port number.

These are the ports that Vibe uses to refer to the browser. In a very basic Vibe system (single server
without Windows Authentication), the HTTP ports can be the same as the listen ports. However, in a
Vibe system with Windows Authentication enabled, the HTTP ports correspond with the ports that
the IS server is configured to use.
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Listen Ports: If you plan to run IIS on the same server as the Vibe server, you need to set the listen
port and secure listen port for Vibe to something other than 80 and 443.

By default, Vibe listens on ports 80 and 443. Because IIS also uses these ports to listen on, you
must reconfigure the Vibe listen ports to ports that are not currently in use, such as 8080 for the
listen port and 8443 for the secure listen port.

You configure Vibe ports during the Vibe installation, as described in Chapter 11, “Performing an
Advanced Vibe Installation,” on page 115.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the HTTP ports and listen ports.

Under Integration with 1IS for Windows Authentication, select Enable Integration with IIS for Windows
Authentication, then list the logout URL.

Configuring the Vibe Server to Support Windows
Authentication

To configure the Vibe server to support Windows Authentication, you must first configure IIS. You can
set up IIS on the same server where Vibe is running, or on a separate server. See Section 10.10.2,
“Planning Your IIS Installation and Configuration,” on page 101 for more information.

Complete the instructions in the following sections to ensure that 1IS is configured correctly to work
with Vibe.

+ “Installing the Vibe 1S Plug-In” on page 102

+ ‘“Installing 1IS Manager” on page 103

+ ‘“Installing Windows Authentication Role Service” on page 104

+ “Creating and Managing Vibe Resources with 1IS Manager” on page 104

Installing the Vibe 1IS Plug-In

1 Locate the teaming-version-iis-plugin.zip file from the Vibe distribution, then unzip it into
the C:\Program Files\Novell directory.

This creates a directory called vibe IIS Plugin.

2 Ifin Step 1 you chose to unzip the teaming-version-iis-plugin.zip file into the C:\Program
Files\Novell directory, continue with Step 3.

or

If in Step 1 you chose to unzip the teaming-version-iis-plugin.zip file into a location other
than C:\Program Files\Novell, you must complete the following steps:

2a Locate the isapi_redirect.properties file in each of the following directories:
¢ Vibe IIS Plugin\resourcesl\bin
¢ Vibe IIS Plugin\resources2\bin
2b In each of the directories, open the isapi redirect.properties file in a text editor.

2c Adjust the values of the 1og file, worker file and worker mount file properties to
reflect the directory where you chose to unzip the teaming-version-iis-plugin.zip file.

2d Save your changes and close both of the isapi redirect.properties files.
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3 If lIS and the Vibe server are located on the same server, continue with Step 4.
or
If IIS and the Vibe server are located on separate servers, complete the following steps:

3a Locate the ¢:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties
file.

3b Open the workers.properties file in a text editor.

3c Adjust the value of the worker.workerl.host property from localhost to the hostname or
IP address of the Vibe server.

3d Save your changes and close the editor.
4 (Conditional) If you are running IIS on a 64-bit server, complete the following steps:
4a Locate the C:\Program Files\Novell\Vibe IIS Plugin\library\winé4 directory.

4b Copy the appropriate version of the .d11 library and paste it into each of the following
directories:

¢ C:\Program Files\Novell\Vibe IIS Plugin\resourcesl\bin
¢ C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin

Ensure that you copy the correct version of the .d11 library. If you copy the incorrect
version, you receive a 500 error when you try to access the Vibe site.

4c Delete the existing isapi_redirect.dll files from the C:\Program Files\Novell\Vibe
IIS Plugin\resourcesl\bin directory, as well as from the C:\Program
Files\Novell\Vibe IIS Plugin\resources2\bin directory.

4d Rename the .d11 library files that you copied in Step 4b to isapi redirect.dll.

For example, if Vibe is running on an AMD64/EM64T platform, copy C:\Program
Files\Novell\Vibe IIS Plugin\library\winé4\amdé4\isapi redirect-
version.dll into the C:\Program Files\Novell\Vibe IIS Plugin\resourcesl\bin
and C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin directories, then
delete the original isapi redirect.dll file and rename isapi redirect-version.dllto
isapi_redirect.dll.

Installing 1IS Manager

If Internet Information Services (IIS) Manager is not already installed on your server, you need to
download and install it. You also need to install the CGI and ISAPI components.
1 Install the IIS 7 Administration Pack:
la Navigate to Microsoft IS Download Site (http://www.iis.net/download/Manage).
1b Click the Manage tab.
1c Under Administration Pack, click Install.

1d (Conditional) If you have not yet installed the Microsoft Web Platform, click Get the Microsoft
Web Platform to download the . exe file, install the Microsoft Web Platform, then click Finish
your installation.

The Launch Application dialog box is displayed.
le Select Web Platform Installer, then click OK.
The Web Platform Installer 2.0 dialog box is displayed.

1f Click Install to install the Administration Pack, then accept the terms of the license
agreement.
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2 Install the ISAPI and CGI components:
2a Launch the Web Platform Installer.
2b From the Web Platform Installer, select Web Platform.
2c Under Web Server, click Customize.
2d In the Application Development section, select CGI, ISAPI Extensions, and ISAPI Filters.
2e Click Install, then accept the terms of the license agreement.
2f Click Finish after the components have been installed successfully.

Installing Windows Authentication Role Service

If the Windows Authentication Role Service is not already installed, you need to install it.

1 On the Windows 2008 server, click Start > Administrative Tools > Server Manager.
2 Expand Roles, then right-click Web Server (11S).
3 Click Add Role Services.
The Add Role Services window is displayed.
4 Scroll to the Security section, then select Windows Authentication.
5 Click Next, then complete the installation.

Creating and Managing Vibe Resources with 1IS Manager

1 Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
2 In the Connections pane on the left side of the window, expand your server, then expand Sites.
3 Right-click Default Web Site, then click Add Virtual Directory.

The Add Virtual Directory dialog box is displayed.

Site name;  Default 'Web Site
Path: !

Alias:

Example: images

Physical path:

| e

Paszs-through authentication

Connect as. .. Test Settings... |

Ok I Cancel

4 In the dialog box, specify the following information:
Alias: VibeResourcesl

Physical path: ¢:\Program Files\Novell\Vibe IIS Plugin\resourcesl\bin

Novell Vibe 4.0 Installation Guide



5
6

10
11
12

Click OK.

Repeat Step 3 through Step 5 to add another virtual directory.

This time, specify the following information in the Add Virtual Directory dialog box:
Alias: VibeResources?2

Physical path: ¢:\Program Files\Novell\Vibe IIS Plugin\resources2\bin

In the Connections panel, select VibeResourcesl, then double-click Handler Mappings.

"E Internet Information Services (II5) Manager - ol x|
@ (5] [ Gl PEN » Sites » DefaultWebSite b VbeResourcesl » |5& @ -
Fle View Help
i _ | Handler Mappings [
€ |58 al PRing Add Managed Handier...
- Start Page Add Script Map. ..
e Use this feature to specify the resources, such as DLLs and managed core, i
;j = ); lication Pook ‘ that handle responses for specific request types. Add Wildcard Script Map. ..
[ TpplatonToos Add Module Mapping...
E-[8] Sites Group by: State |
B Default Web Site [ Patn [ state Edit Feature Permissions. ..
e g, | VibeResources1 Revert To Inherited
7 VibeResources2
. — - View Ordered List...
“.d DI @ rHep
Online Help
Enabled
OPTIONSVYerbHandler * Enabled
TRACEVerbHandler * Enabled
StaticFile * Enabled
o i
Canfiguration: ‘Default Web Site fvibeResources1' web.config ei:;

In the Actions pane, click Edit Feature Permissions.
The Edit Feature Permissions dialog box is displayed.

Edit Feature Permissions 2=l

Permissions:
v Read
¥ script

v Execute

Ok I Cancel

Select Execute, then click OK.

Repeat Step 7 through Step 9 for the VibeResources2 virtual directory.

In the Connections pane, select Default Web Site, then double-click ISAPI Filters.
In the Actions panel, click Add.

The Add ISAPI Filter dialog box is displayed.
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13

14
15

16

Add ISAPI Filter e |
Filter name:

Executable:

| ]

Ok I Cancel

In the dialog box, specify the following information:
Filter name: vibeResourcesl
You must name the filter vibeResources1 for Windows Authentication to work successfully.

Executable: ¢:\Program Files\Novell\Vibe IIS
Plugin\resourcesl\bin\isapi redirect.dll

Click OK.

Repeat Step 12 through Step 14 to add another ISAPI filter.

This time, specify the following information in the Add ISAPI Filter dialog box:
Filter name: VibeResources?2

You must name the filter vibeResources2 in order for Windows Authentication to work
successfully.

Executable: C:\Program Files\Novell\Vibe IIS
Plugin\resources2\bin\isapi redirect.dll

In the Connections pane, select the server, then double-click ISAPI and CGI Restrictions.
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1!E Internet Information Services (IIS) Manager

—loj x|

€3] EEEEE

[ - B e~

File  view Help

€-iH|7 8

& Start Page
Eiij PEN (LPTEAMING \administrator)
[ 2} Application Pools
- Sites
B4 Default Web Site
] VibeResources1
[ VibeResources2

4

| »

G‘;l_ ISAPI and CGI Restrictions

Use this feature to specify the ISAPI and CGI extensions that can run on the
Web server,

Group by: Mo Grouping <

Description =+ I Restriction I Path

TeamingResourc... Allowed C:'\Program Files\Mavell\Teamir
TeamingResourc... Allowed C:'\Program Files\Movell\Teamir
l | 2

Configuration: localhost’ applicationHost. config

17 In the Actions pane, click Add.

The Add ISAPI or CGI Restriction dialog box is displayed.

Add ISAPI or CGI Restriction

ISAPI or CGI path:

2 x

Description:

L

|_ Allow extension path to execute

Cancel

o ]

18 In the dialog box, specify the following information:

ISAPI or CGI path: Specify C:\Program Files\Novell\Vibe IIS
Plugin\resourcesl\bin\isapi redirect.dll

Description: vibeResourcesl

Add...

Edit Feature Settings...

@ Help

Online Help

ia51.:5

Allow extension path to execute: Select this option to allow the path to execute.

19 In the Actions pane, click Add.

The Add ISAPI or CGI Restriction dialog box is displayed.
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10.10.5

ISAPI or CGI path:

|| ]

Description:

[T allow extension path to execute

oK I Cancel

20 In the dialog box, specify the following information:

ISAPI or CGI path: Specify C:\Program Files\Novell\Vibe IIS
Plugin\resources2\bin\isapi redirect.dll

Description: vibeResources?2

Allow extension path to execute: Select this option to allow the path to execute.
21 In the Connections pane, select VibeResourcesl, then double-click Authentication.
22 Select Anonymous Authentication, then click Disable in the Actions panel.
23 Select Windows Authentication, then click Enable in the Actions panel.
24 Exit the Internet Information Services Manager.

25 Perform the Advanced installation as described in Chapter 11, “Performing an Advanced Vibe
Installation,” on page 115.

Running the Vibe Installation Program

See “Choosing Windows Authentication” on page 48 for information about how to configure the Vibe
installation program to support Windows Authentication, then follow the instructions for the advanced
installation as described in Chapter 11, “Performing an Advanced Vibe Installation,” on page 115.

Return here and continue with Section 10.10.5, “Configuring Your Browser to Allow Access to the
Vibe Site,” on page 108.

Configuring Your Browser to Allow Access to the Vibe Site

After Windows Authentication has been enabled on the server, you need to configure the client
browser to allow access to the Vibe site.
+ “Internet Explorer” on page 108

+ “Firefox” on page 109

Internet Explorer

1 In an Internet Explorer window, click Tools > Internet Options.
The Internet Options dialog box is displayed.

2 Click the Security tab, select Local intranet, then click Sites.
The Local Intranet dialog box is displayed.

3 Click Advanced.
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4 In the Add this website to the zone field, specify the Vibe website.
5 Click Add > Close.

Firefox

1 In Firefox, specify about :config in the URL field.

2 Specify nt1m in the Filter window, then locate and select the network.automatic-ntlm-
auth.trusted-uris entry.

The Enter String Value dialog box is displayed.
3 Specify the DNS name of your Vibe site, then click OK.

For example, vibe.mycompany. com.

4 Repeat Step 2 through Step 3 for network.negotiate-auth.trusted-uris and network.negotiate-
auth.delegation-uris.

10.10.6 Bypassing Windows Authentication to Configure LDAP and
Perform Other Tasks

After Windows Authentication is working on your Vibe server, you can bypass the Windows
Authentication functionality by including the Vibe listening port in the Vibe URL.

You need to do this in order to configure your LDAP directory.

1 In a web browser, specify your Vibe URL with the Vibe listening port.
For example, http://vibe:8080.
The Vibe login page is displayed.

Novell. Vibe

User 1D

Password

Forgat your password?

2 Login to the Vibe site as the Vibe administrator.

3 Configure LDAP, as described in Section 6.3, “Adding Vibe Users from Your LDAP Directory,” on
page 78.

You might also need to bypass Windows Authentication to access Vibe for the following reasons:

+ To access a specific Vibe node in a clustered environment
+ To troubleshoot the Vibe system
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Logging In to the Vibe Site through Windows Authentication

After you have performed the configuration steps described in Section 10.10.3, “Configuring the Vibe
Server to Support Windows Authentication,” on page 102 through Section 10.10.5, “Configuring Your
Browser to Allow Access to the Vibe Site,” on page 108, users can access the Vibe site through
Windows Authentication. Users who have been configured through LDAP and are already logged in
to their individual workstations do not need to log in again to access the Vibe site. Users who are not
already logged in before they access Vibe see the following dialog box:

Authentication Required x|
0 Enter username and password for http://13.6.7.31
User Mame: I
Password: I sesnsssns
OK I Cancel |

Editing Files through WebDAV with Windows
Authentication

+ “Achieving Single Sign-On When Editing Files through WebDAV” on page 110
+ “Enabling Basic Authentication for WebDAV” on page 110

Achieving Single Sign-On When Editing Files through WebDAV

By default, when you edit a file in Vibe through WebDAV, you are prompted for your system login
credentials before you can edit the file. However, when Windows Authentication is enabled on your
Vibe server, you are no longer prompted for your system login credentials before you edit a file
through WebDAV.

This functionality is supported only when you use Microsoft Office as your default document editor.
When you use OpenOffice 3.1 or later as your default document editor, Vibe allows you to edit files
through WebDAV, but it still requires you to enter your system login credentials. The single sign-on
experience is only available when you use Microsoft Office.

Enabling Basic Authentication for WebDAV

If you are using OpenOffice 3.0 or earlier, or any other document editor that requires basic
authentication (it does not support Windows Authentication), you need to configure your IIS server to
support basic authentication. Supporting basic authentication enables Vibe users to edit files through
WebDAV when using a document editor other than Microsoft Office or OpenOffice 3.1 or later.

NOTE: If you enable basic authentication on your IS server, all users who access the Vibe site
through Firefox are prompted for their login credentials. Single sign-on to the Vibe server no longer
functions. However, users who access the Vibe site using Internet Explorer retain the single sign-on
experience.

To enable basic authentication on your IIS server, you need to install the Basic Authentication Role
Service.

1 On the Windows 2008 server, click Start > Administrative Tools > Server Manager.
2 Expand Roles, then right-click Web Server (11S).
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Click Add Role Services.

The Add Role Services window is displayed.

Scroll to the Security section, then select Basic Authentication.

Click Next, then complete the installation.

Click Start > Administrative Tools > Internet Information Services (IIS) Manager.

In the Connections pane on the left side of the window, expand your server, expand Sites, then
expand Default Web Site.

Select VibeResources1, then double-click Authentication.

9 Select Basic Authentication, then click Enable in the Actions panel.

10

Close the Internet Information Services (IIS) Manager.

Configuring lIS to Allow Uploading of Large Files to the Vibe
Site

By default, 1IS might not allow you to upload large files to the Vibe site. This is caused by timeout
restrictions as well as maximum upload size restrictions.

For information about how to configure IIS to allow you to upload large files, see article 925083 in the
Microsoft Support Knowledgebase (http://support.microsoft.com/kb/925083).

Configuring IIS to Load Balance in a Clustered Environment

If you have Vibe installed in a clustered environment where there are multiple Vibe nodes, you can
configure 1IS to balance the load of user requests from the multiple Vibe nodes, while still supporting
Windows Authentication.

1

On the IIS server, locate the C:\Program Files\Novell\Vibe IIS
Plugin\conf\workers.properties.clustered.template file, then open the file in a text
editor.

Copy the contents of the file.

Locate the C:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties file,
then open the file in a text editor.

Paste the contents of the C:\Program Files\Novell\Vibe IIS
Plugin\conf\workers.properties.clustered.template file that you copied in Step 2 and
into the C:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties file,
overwriting the content that was previously there.

Replace the value of worker.workerl.host from first_hostname_or_ip with the hostname or IP
address of your first Vibe node.

Repeat Step 5 for each additional Vibe node that is running in your environment. If you have
more than two Vibe nodes, you should add an additional section to the workers.properties file
for each additional node.

The values that you specify in the workers.properties file (for example, worker1, worker2,

etc.) must exactly match the values that you specify as the JVM Route setting during the Vibe

installation, as described in Section 16.2, “Installing the Vibe Software on Multiple Servers,” on
page 136.

Locate the C:\Program Files\Novell\Vibe IIS
Plugin\resourcesl\conf\uriworkermap.properties file, then open the file in a text editor.

Replace all instances of worker1 with balancer.
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9 Repeat Step 7 and Step 8 for each Vibe node.

10 Locate the ¢:\Program Files\Novell\Vibe IIS
Plugin\resources2\conf\uriworkermap.properties file, then open the file in a text editor.

11 Replace all instances of worker1 with balancer.

12 Repeat Step 10 and Step 11 for each Vibe node.

13 Restart each Vibe node.

14 Restart the IIS server:
1l4a Click Start > Administrative Tools > Internet Information Services (11S) Manager.
14b Select your server in the Connections panel, then click Restart in the Actions panel.

Configuring Mirrored Folder Resource Drivers

A mirrored folder is a directory, either local or shared on a SAN (storage area network), that is directly
accessible from the Novell Vibe site. The files on the file system are accessed by the Novell Vibe
program through a resource driver, not directly by individual Vibe users. A resource driver defines
how the Vibe program accesses the file system.

During installation, you define the users and groups that can access the mirrored folder resource
drivers. After installation, from the Vibe site, you associate resource drivers with specific Vibe folders
and use folder access controls to govern which users and groups can access the data in the mirrored
folder. As a result, you can set up a small number of users who can create mirrored folders, and allow
a larger number of users to access the mirrored folders.

Vibe attempts to keep the metadata about each mirrored folder synchronized with the contents of the
actual file system. Therefore, mirrored folders are most appropriate for large sets of relatively static
data. Mirrored folders are also useful for making extremely large files available from your Vibe site
without including them in the Vibe file repository.

Although the installation program allows you to set up three mirrored folder resource drivers during
installation, you can set up and test just one to start with, and then set up additional resource drivers
later.

¢ Section 10.11.1, “File System Type,” on page 112

¢ Section 10.11.2, “File System Directory,” on page 113

+ Section 10.11.3, “File System Access,” on page 113

¢ Section 10.11.4, “Mirrored Folder Setup,” on page 114
After planning mirrored folders, complete the planning process for additional Advanced installation

features as needed, then perform the Advanced installation as described in Chapter 11, “Performing
an Advanced Vibe Installation,” on page 115.

File System Type

Vibe provides resource drivers for two different types of file systems:

+ file: A directory in a regular file system on a Linux or Windows server.

+ webdav: A directory on a web server that supports WebDAV (Web-based Distributed Authoring
and Versioning). The WebDAV server must support HTTP Basic Authentication (http://
en.wikipedia.org/wiki/Basic_access_authentication) so that Vibe can provide a user name and a
password when making a request from the WebDAV server.
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ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, mark the type of directory that you want to mirror in
your Vibe site.

File System Directory

The file system that a Vibe mirrored folder uses can be on Linux, NetWare, or Windows, as long as
the following conditions are met:

+ The file system is accessible from the Vibe server by using a directory path specification that the
Vibe server operating system understands.

+ The file system is accessible through the standard java. io package interface.

IMPORTANT: On Windows, you must use forward slashes (/) in the path nhame, not the typical
Windows backslashes (\). For example, use c: /Documents rather than c:\Documents.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, specify the full path for the directory that you want
to mirror in your Vibe site. Also, provide a title for the mirrored folder resource driver that indicates what
directory or data is being mirrored. For WebDAV mirrored folders, you must also specify the URL of the
WebDAV host where the data is located.

If you need to eventually set up more than three directories as mirrored folders in your Vibe site, you
can edit the installer.xml file in the directory where you run the Installation program.

File System Access

Vibe offers several security options for controlling access to the data that resides on the file system.

+ You can restrict the Vibe program to read-only access to the mirrored data, or you can allow full
read/write access.

+ You can list specific Vibe users who are allowed to access the mirrored folder resource drivers
and thereby create mirrored folders.

+ You can list specific Vibe groups whose members are allowed to access the mirrored folder
resource drivers and thereby create mirrored folders.

+ For WebDAV mirrored folder resource drivers, you must also specify a user name and password
that the Vibe program can use to access the WebDAV server.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, list the file access (read/write or read-only) for the
mirrored data, along with users and groups that you want to have access to the resource driver. For a
WebDAV mirrored folder, list a user name and password that provides access to the WebDAV server.
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10.11.4 Mirrored Folder Setup

After you run the Vibe Installation program to configure the Vibe site for mirrored folder resource
drivers, additional folder setup is required. Follow the instructions in “Setting Up Mirrored Folders” in
“Site Setup” in the Novell Vibe 4.0 Administration Guide.

10.12 Installing the Vibe Software in a Clustered
Environment

You must use an Advanced installation in order to install the Novell Vibe software on multiple servers
and set up a clustered environment. Setting up multiple Vibe servers, along with other clustering
options, are described in Chapter 16, “Running Vibe on Multiple Servers,” on page 135.
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Performing an Advanced Vibe
Installation

You should already have reviewed Chapter 4, “Planning a Basic Vibe Installation,” on page 39 and
filled out the Basic Vibe Installation Summary Sheet. You should also have reviewed Chapter 10,
“Planning an Advanced Vibe Installation,” on page 91 and filled out the Advanced Vibe Installation
Summary Sheet for those aspects of an Advanced installation that you want to implement for your
Novell Vibe site.

1 Follow the Basic installation instructions provided in Chapter 5, “Installing and Setting Up a Basic
Vibe Site,” on page 59 for the platform where you are installing Vibe.
2 When you run the installation program, select Advanced on the Choose Installation Type page.

Neovell Vibe 4 Installation Program = x

Choose Installation Type

Select the type of installation you want to perform

Hasit Select the Advanced installation if you want to configure any
of the optional features.

3 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet and
the Advanced Vibe Installation Summary Sheet to provide the information that the Vibe
Installation program prompts you for:

Basic Installation Pages:

Installation Locations

Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Vibe

User ID for Novell Vibe (Linux only)

Network Information

WebDAV Authentication Method

Database Selection

Java JDK Location

Outbound Email Configuration

Inbound Email Configuration

Some Basic installation pages have additional options available when you perform an Advanced
installation.

Advanced Installation Pages:

Web Services

Lucene Configuration

RSS Configuration

Presence Configuration
Reverse Proxy Configuration
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Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration

The Installation program stores the information it gathers in the installer.xml file in the same
directory where you started the Installation program.

4 After you have provided all the requested information, click Install to begin the Advanced
installation.

5 When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the installer.log file in the same
directory where you ran the Installation program. If a problem occurs during the installation, the
installer.log file provides information that can help you resolve the problem.

6 After you complete the Advanced installation, continue setting up your Vibe site, as described in
Chapter 6, “Adding Users to Your Vibe Site,” on page 77.
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Setting Configuration Options after
Installation

After you install Novell Vibe, following the instructions in Part II, “Basic Installation,” on page 37 or
Part I, “Advanced Installation and Reconfiguration,” on page 89, you can rerun the Vibe installation
program to change configuration options or add new functionality to your Vibe site.

1 Stop Vibe.

2 Start the Vibe installation program as described in Section 5.1.2, “Running the Linux Vibe
Installation Program,” on page 60 and Section 5.2.2, “Running the Windows Vibe Installation
Program,” on page 70.

Novell Vibe 4 Installation Program = x

Installation Options

Select the action you want to perform.

" New installation
" Update software and settings
" Reconfigure settings

Because the Installation program finds an existing installer.xml file, it defaults to Reconfigure
settings.

3 Click Next.
The Vibe Installation program asks you to verify that you have stopped Vibe.
4 Click Yes.

Novell Vibe 4 Installation Program = x
Choose Installation Type

Select the type of installation you want to perform

| Basic Select the Advanced installation if you want to configure any
of the optional features.

5 Select Basic or Advanced, depending on the configuration settings that you want to change, then
click Next.

6 Click Next until you reach an installation page where you want to reconfigure settings.
Basic Installation Pages:
Installation Locations
Location of TrueType Fonts for Stellent Converters

Default Locale for Novell Vibe
User ID for Novell Vibe (Linux only)
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Network Information

WebDAV Authentication Method
Database Selection

Java JDK Location

Outbound Email Configuration
Inbound Email Configuration

Advanced Installation Pages:

Web Services

Lucene Configuration

RSS Configuration

Presence Configuration

Reverse Proxy Configuration

Integration with 1S for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration

7 When you reach the Ready to Install page, click Install to implement the reconfigured settings.
8 Start Vibe.
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Advanced Vibe Installation Summary

Sheet

Installation Program Field

Value for Your Vibe Site

Explanation

Data Locations:
Linux default:
/var/opt/novell/teaming
Windows default:
c:\Novell\Teaming

+ Simple file repository

+ Jackrabbit repository

+ Extensions repository

+ Cache store

* Lucene index

See Section 10.2, “Distributing
Different Data Types to Different
Locations,” on page 92.

Network Information:
+ Enable web services:

No / Yes

¢ Session timeout
Default: 240 minutes

+ Enable Tomcat access log:
No / Yes

+ Keystore file:

See Section 10.3, “Using Advanced

Network Information Settings,” on
page 93.

Network Information:
¢ Max Threads

Default: 200
+ Max Active

Default: 50
+ Max Idle

Default: 20

See Section 10.4, “Configuring
Requests and Connections
Configuration,” on page 94.

WebDAV Authentication Method

+ basic

+ digest

See Section 4.5, “Planning the
WebDAV Authentication Method,”
on page 46.
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Installation Program Field

Value for Your Vibe Site

Explanation

Web Services:

+ Enable WSS authentication
+ Enable Basic authentication

+ Enable token-based
authentication

+ Enable anonymous access

See Section 10.5, “Configuring
Web Services,” on page 95.

Lucene Configuration:
Configuration type: all
¢ Max booleans:

Default: 10000
+ Merge factor:
10

See Section 10.6.2, “Changing
Lucene Configuration Settings,” on
page 96.

Server Lucene Configuration:
Configuration type: server only

* Host:
* RMI port:
Default: 1199

See Section 10.6.3, “Running the
Lucene Index Server in Its Own
JVM,” on page 96.

High Availability Lucene
Configuration:

Configuration type: high availability
only

Number of high availability search
nodes:

* Service name:
* Service title:
¢ Host:

* RMI port:

* Service name:
* Service title:
* Host:

* RMI port:

See Chapter 17, “Running Multiple
Lucene Index Servers,” on
page 143.

RSS Configuration:

Enable RSS: No / Yes

* Max elapsed days:

¢ Max inactive days:

See Section 10.7, “Managing RSS
Feeds,” on page 97.
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Installation Program Field Value for Your Vibe Site

Explanation

Presence Configuration:
Enable presence: No / Yes

+ Server address:
¢ Port:

* Server user:

* Password:

* Server Certificate:

See Section 10.8, “Configuring
Presence,” on page 98.

Reverse Proxy Configuration:
Enable Access Gateway: No / Yes

* Access Gateway address(es):
¢ Logout URL:

+ Use Access Gateway for
WebDav connections: No / Yes

* WebDAV Access Gateway
address:

See Section 10.9, “Configuring
Single Sign-On with Novell Access
Manager,” on page 99.

Integration with IIS for Windows
Authentication:

Enable Integration with 1IS for
Windows Authentication: No / Yes

+ |IS address(es):

* Logout URL:

See Section 10.10, “Configuring
Single Sign-On with Internet
Information Services for Windows,”
on page 99.

Mirrored Folder Resource Driver
Configuration:

Enable file share: No / Yes

¢ Share type

+ File

+ WebDav
+ Read only: No / Yes
+ Title
+ Root path
+ Allowed users
+ Allowed groups
¢ User
¢ Password
¢+ Host URL

See Section 10.11, “Configuring
Mirrored Folder Resource Drivers,”
on page 112.
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I Multi-Server Configurations and
Clustering

+ Chapter 14, “Creating the Vibe Database on a Remote Server,” on page 125

+ Chapter 15, “Installing the Lucene Index Server on a Remote Server,” on page 131
+ Chapter 16, “Running Vibe on Multiple Servers,” on page 135

+ Chapter 17, “Running Multiple Lucene Index Servers,” on page 143

+ Chapter 18, “Running Multiple Database Servers,” on page 161
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Creating the Vibe Database on a Remote
Server

The default database location for Novell Vibe is on the same server with the Vibe software, as
described in Section 4.6.3, “Database Location,” on page 49. However, for better performance and
scalability, you can install the database server (MySQL, Microsoft SQL, or Oracle) on a remote
server, and then use the scripts that are included with the Vibe software to manually create the Vibe
database in any location that you prefer.

+ Section 14.1, “Creating a MySQL Database,” on page 125
+ Section 14.2, “Creating a Microsoft SQL Database,” on page 127
+ Section 14.3, “Creating an Oracle Database,” on page 128

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part I, “Basic Installation,” on
page 37 before attempting a more complex Vibe configuration.

14.1 Creating a MySQL Database

Before you begin, you should be familiar with standard database maintenance procedures.
For more information about MySQL, see the following references:

+ MySQL 5.0 Reference Manual (http://dev.mysqgl.com/doc/refman/5.0/en)
+ MySQL 5.1 Reference Manual (http://dev.mysgl.com/doc/refman/5.1/en)

The following database tools can be helpful:

+ MySQL GUI Tools (http://dev.mysgl.com/downloads/gui-tools)
+ SQLyog (http://www.webyog.com)
+ Squirrel SQL Client (http://squirrel-sqgl.sourceforge.net)

To create the MySQL database:

1 Review the MySQL requirements listed in Section 2.1, “Vibe Server Requirements,” on page 17.

2 Ensure that the MySQL database server and client have been installed and configured, as
described in Section A.3, “MySQL Database Server,” on page 206.

3 Ensure that the MySQL database client is also installed on the Vibe server.

The Vibe installation program needs the MySQL client in order to communicate with the remote
MySQL database server.

4 Ensure that you know the password for the MySQL root administrator user.
5 Ensure that innodb support is enabled.

It is enabled by default. To verify that innodb support is enabled:

5a Enter the following command to access the MySQL monitor:
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12
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mysgl -u root -p

For information on how to set a password for your MySQL database if you have not already
done so, see “Configuring MySQL” on page 207.

5b Specify your password.
5¢ From the MySQL prompt, enter the following command to display status information about
the server’s storage engines:
SHOW ENGINES\G
5d Locate the InnoDB engine, and ensure that innodb support is enabled.
Update the MySQL configuration file:
6a Locate the MySQL configuration file and open it in a text editor.

Linux: /etc/my.cnf

Windows: c:\Program Files\MySQL\MySQL Server version\my.ini

6b Under the [client] section, add the following line:

default character set = utfs8

6¢c Under the [mysgld] section, add the following line:

character set server = utf8

Setting the character set to UTF-8 ensures that extended characters are handled correctly
in the database.

6d (Conditional) For a system with multiple network interfaces, in the [mysqld] section, add
the following line:

bind-address = mysqgl server address

Replace mysqgl server address with the IP address that you want MySQL to bind to and
to listen on.

6e Save the updated configuration file, then exit the text editor.

Copy the teaming-4.0.n-db.zip file from the Vibe server where the Vibe installation program
is located and copy it to the database server.

or
Download and unzip the Vibe software onto the database server.

In the directory where the Vibe Installation program is located on the database server, or in the
location where you copied the teaming-4.0.n-db. zip file, unzip the teaming-4.0.n-db.zip
file.

Change to the db subdirectory.
Change to the db/scripts/sql subdirectory.

Copy the mysql-create-empty-database.sgl script to a convenient temporary location on the
server where you want to create the database, and ensure that your database management
utility is on your path so that you can run it from that directory.

Specify the following command to run the MySQL database creation script:

mysql -uuser -ppassword < mysdgl-create-empty-database.sqgl

Configure MySQL to allow access from a remote server:
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14

15

16

17

18

19

mysql -uuser -ppassword

mysgl> grant all privileges on *.*
-> to 'username'@'%'
-> identified by 'password'
-> with grant option
->

Edit the mysgl-liquibase.properties file to use your specific credentials.

For example:

vi mysgl-liquibase.properties

Populate the database that you just created:
./manage-database.sh mysgl updateDatabase

Verify that the database tables were created:

mysql -uuser -p

Specify the password for the MySQL user.

Specify the following command to use the default Vibe database:
mysql> use sitescape;

A message indicating that the database has been changed is displayed.
Specify the following command to show that the tables were created:

mysqgl> show tables;

Creating a Microsoft SQL Database

Before you begin, you should be familiar with standard database maintenance procedures.

For more information about Microsoft SQL, see the following references:

+ Microsoft SQL Server 2008 Learning Resources (http://www.microsoft.com/sqlserver/2008/en/

us/learning.aspx)

+ Microsoft SQL Server 2005 Learning Resources (http://www.microsoft.com/sqlserver/2005/en/

us/learning-resources.aspx)

The following database tool can be helpful:

*

Squirrel SQL Client (http://squirrel-sgl.sourceforge.net)

To create a Microsoft SQL database:

1 Review the Microsoft SQL requirements listed in Section 2.1, “Vibe Server Requirements,” on

page 17.

Ensure that the Microsoft SQL Server and Client have been installed and configured properly.

IMPORTANT: Ensure that TCP/IP is enabled for the Microsoft SQL Server.

For more information, see “Microsoft SQL Server” (http://msdn.microsoft.com/en-us/library/

bb545450.aspx).

Ensure that the Microsoft SQL database client is also installed on the Vibe server.

The Vibe installation program needs the Microsoft SQL client in order to communicate with the

remote Microsoft SQL database server.

When you install Microsoft SQL Server, select SQL Server and Windows for authentication.

The default is Windows Only, which is not appropriate for Vibe.
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5 Copy the teaming-4.0.n-db.zip file from the Vibe server where the Vibe installation program
is located and copy it to the database server.

or
Download and unzip the Vibe software onto the database server.

6 In the directory where the Vibe Installation program is located on the database server, or in the
location where you copied the teaming-4.0.n-db.zip file, unzip the teaming-4.0.n-db.zip
file.

7 Change to the db subdirectory.
8 Change to the db/scripts/sql subdirectory.
9 Use Microsoft SQL Server Management Studio to create the empty database:

9a Copy the sqlserver-create-empty-database.sql file from the db/scripts/sql
subdirectory .

9b Execute the query to create the empty database.

When the database is created, you should see Command (s) completed successfully in
the messages window.

10 Edit the sqlserver-liquibase.properties file to use your administrator user name and
password for the SQL database server.

11 Populate the database that you just created:
run manage-database.bat sqglserver updateDatabase

12 Verify that the database tables were created by using Microsoft SQL Server Management Studio.

14.3 Creating an Oracle Database

Before you begin, you should be familiar with standard database maintenance procedures.
For more information about your Oracle database, see the following references:

¢ Oracle Product Documentation (http://www.oracle.com/technetwork/indexes/documentation/)

¢ Oracle SQL Plus Documentation (http://download.oracle.com/docs/cd/B19306_01/server.102/
b14357/toc.htm)

The following database tool can be helpful:

+ Squirrel SQL Client (http://squirrel-sgl.sourceforge.net)

1 Review the Oracle database requirements listed in Section 2.1, “Vibe Server Requirements,” on
page 17.

2 Ensure that the Oracle database server software has been installed and configured properly.
For more information, see Oracle Database (http://www.oracle.com/database).

3 Set up the Oracle database character set to support Unicode character encodings.

Vibe requires either the UTF-8 or AL32UTF8 character set for proper operation. Oracle
recommends AL32UTF8, because it has increased support for certain Asian languages. For
more information, see “Choosing a Character Set” (http://download.oracle.com/docs/cd/
B19306_01/server.102/b14225/ch2charset.htm) in the Oracle Database Globalization Support
Guide.

4 Copy the teaming-4.0.n-db. zip file from the Vibe server where the Vibe installation program
is located and copy it to the database server.

or
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Download and unzip the Vibe software onto the database server.

5 In the directory where the Vibe Installation program is located on the database server, or in the
location where you copied the teaming-4.0.n-db. zip file, unzip the teaming-4.0.n-db.zip
file.

6 Change to the db subdirectory.

7 Change to the db/scripts/sql subdirectory.

8 Edit the oracle-create-empty-database.sqgl Script with your Oracle database password.
Original:

drop user sitescape cascade;

create user sitescape identified by sitescape;
grant connect, resource to sitescape;

connect sitescape/sitescape;

(SiteScape is the name of the company that previously developed the Vibe software.)
Updated:

drop user sitescape cascade;

create user sitescape identified by your oracle password;
grant connect, resource to sitescape;

connect sitescape/your oracle password;

IMPORTANT: Unless you are very familiar with editing scripts, change only the password. Do
not attempt to change the name of the database from the legacy default of sitescape.

9 Enter the following commands to run the database creation script:

sqgqlplus "/ as sysdba"

SQL> spool oracle-create-empty-database.out;
SQL> @oracle-create-empty-database;

SQL> quit

10 Check the resulting oracle-create-empty-database.out file for errors and resolve them.

11 Edit the oracle-liquibase.properties file to use your administrator user name and
password.

For example:
vi oracle-liquibase.properties
12 Populate the database that you just created:
run ./manage-database.sh oracle updateDatabase

13 Verify that the database tables were created.
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15.1

Installing the Lucene Index Server on a
Remote Server

You can install the Lucene Index Server on a different server from where Novell Vibe is running. If the
Lucene Index Server is already running on the same server as Vibe, you can move the Lucene Index
Server to a different server.

Running the Lucene Index Server on a remote server allows both the Lucene Index Server and the
Vibe server to have access to more server memory, disk space, and CPU resources.

Complete the following sections whether you are installing the Lucene Index Server on a remote
server, or moving the Lucene Index Server to a remote server.

IMPORTANT: The Vibe server and the Lucene Index Server must not have a firewall between them.
The RMI protocol used for the Lucene Index Server port works only within a trusted local area
network (LAN).

+ Section 15.1, “Installing the Lucene Software,” on page 131
+ Section 15.2, “Updating Your Vibe Site,” on page 133

+ Section 15.3, “Managing a Remote Lucene Index Server,” on page 133

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part I, “Basic Installation,” on
page 37 before attempting a more complex Vibe configuration.

Installing the Lucene Software

1 Ensure that the Java Developer Kit (JDK) is installed on the remote server where you want to
install the Lucene Index Server.

You must use the same JDK that is being used on the server where Vibe is running. For
example, if you are using the IBM JDK on the server where Vibe is running, you must use the
IBM JDK on the remote Lucene Index Server.

For instructions, see Appendix A, “Vibe System Requirements Assistance,” on page 203.
2 Ensure that there is no firewall between the Vibe server and the Lucene Index Server.

3 Copy the Lucene installation program from its original location in the same directory with the
Vibe installation program to a convenient temporary directory on the remote server.

The file name for the Lucene Installation program varies by platform:

Linux: lucene-installer.linux

Windows: lucene-installer.exe

4 Change to the directory where you copied the Lucene installation program, then start it.
5 Accept the License Agreement, then click Next.
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10
11

12

13
14

Select New installation, then click Next.

Browse to and select the directory where you want to install the Lucene Index Server, then click
Next.

The default location varies by platform:

Linux: /opt/novell/teaming/luceneserver

Windows: c:\Program Files\Novell\Teaming\luceneserver

Browse to and select the directory where you installed the JDK, then click Next.

Adjust the configuration of the Lucene Index Server, as described in Section 10.6, “Changing
Your Lucene Index Server Configuration,” on page 95, then click Next.

Click Install to install the Lucene software.
(Conditional) On Linux, deselect Start Lucene server.

You must edit the Lucene Index Server startup script before you start the Lucene Index Server.
Instructions are provided later in this procedure.

(Conditional) On Windows, if you do not want to start the Lucene Index Server immediately,
deselect Start Lucene server.

For instructions on starting and stopping the Lucene Index Server manually, see Section 15.3,
“Managing a Remote Lucene Index Server,” on page 133.

Click Finish.
(Conditional) On Linux:
14a Change to the following directory:

/opt/novell/teaming/luceneserver/indexserver/bin

14b Open the indexserver-startup.sh file in a text editor.
14c Add the following switch to the java launch command at the end of the script:

-Djava.rmi.server.hostname=ip address

Rename ip address with the IP address of the server where you installed the Lucene
Index Server.

14d Save the indexserver-startup.sh file, then exit the text editor.
14e Start the Lucene Index Server.

For instructions on starting and stopping the Lucene Index Server manually, see
Section 15.3, “Managing a Remote Lucene Index Server,” on page 133.

Moving the Lucene Index Server from the Vibe server to a remote server increases the scalability of
your Vibe system, because the workload is distributed between two different physical servers.
However, in this configuration, the Lucene Index Server still runs on a single server. Your Vibe site
depends on the Lucene Index Server for full functionality. If that server goes down for some reason,
the Vibe site becomes inaccessible until access to the Lucene Index Server is restored. You can
further expand your Vibe system by setting up multiple Lucene Index Servers to provide high
availability, as described in Chapter 17, “Running Multiple Lucene Index Servers,” on page 143.
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15.2 Updating Your Vibe Site

Complete this section only if you are moving the Lucene Index Server. If you are performing a fresh
Lucene Index Server installation, disregard this section.

1 Stop Novell Vibe.

2 Start the Vibe installation program to reconfigure the Lucene Index Server settings.

For information on how to start the installation program, see Section 5.1.2, “Running the Linux
Vibe Installation Program,” on page 60 or Section 5.2.2, “Running the Windows Vibe Installation
Program,” on page 70.

3 On the Choose Installation Type page, select Advanced, then click Next.
4 Click Next until you reach the Lucene Configuration page.

Novell Vibe 4 Installation Program o x

Lucene Configuration

N

Use the following fields to configure the Lucene index.

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software Is installed or on a
remote machine.

Enter the host name and edit the RMI port If the default port cannot be used.

Max boaleans 100000
Merge factor .ID

Lucene configuration type: local j

5 In the Lucene configuration type field, select server to activate additional fields.
Host: Specify the hostname of the server where you installed the Lucene Index Server software.

RMI Port: Use the same port number that you used when you installed the Lucene Index Server
software. The default RMI port is 1199.

6 Click Next until you reach the Ready to Install page, then click Install.
7 When the installation is complete, click Finish.
8 Start Vibe.

15.3 Managing a Remote Lucene Index Server

¢ Section 15.3.1, “Linux: Managing a Remote Lucene Index Server,” on page 133

+ Section 15.3.2, “Windows: Managing a Remote Lucene Index Server,” on page 134

15.3.1 Linux: Managing a Remote Lucene Index Server

Use the following commands to start and stop the Lucene index server manually:

/etc/init.d/indexserver start
/etc/init.d/indexserver stop
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15.3.2

To configure the Lucene Index Server to start automatically when the Linux server reboots, use:

chkconfig --add indexserver

Windows: Managing a Remote Lucene Index Server

Use the following commands at a DOS command prompt to start and stop the Lucene index server
manually:

c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin)\
indexserver-startup.bat

c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin)\
indexserver-shutdown.bat

To configure the Lucene Index Server to start automatically when the Windows server reboots, you
can set it up as a scheduled task that runs at system startup.

1 On the Windows server where the Lucene Index Server is installed, click Start > All Programs >
Accessories > System Tools > Scheduled Tasks.

2 Double-click Add Scheduled Task to open the Scheduled Task Wizard, then click Next to
continue.

3 Click Browse, then browse to and double-click the indexserver-startup.bat file in the
following directory:

c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin
4 In the Task name field, specify an informative name for the task, such as Lucene Index Server.
The default task name is the name of the batch file.
In the Perform this task field, select When my computer starts, then click Next.
Specify and confirm the Administrator password for the Windows server, then click Next.
Select Open advanced properties for this task when | click Finish, then click Finish.

o N o o

Verify that Run only if logged on is deselected, then click OK.

A new task with the name you specified in Step 4 is added to the list in the Scheduled Tasks
window.

9 Click File > Exit to close the Scheduled Task Wizard.
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6 Running Vibe on Multiple Servers

By running Novell Vibe on multiple servers, you can achieve high availability, including failover and
load balancing, depending on how you configure your servers. You must perform an Advanced
installation on each server in order to configure the Vibe software for such a clustered environment.
+ Section 16.1, “Planning a Multi-Server Vibe Configuration,” on page 135
+ Section 16.2, “Installing the Vibe Software on Multiple Servers,” on page 136

¢ Section 16.3, “Configuring a Web Application to Provide High Availability Functionality for Your
Vibe Site,” on page 139

+ Section 16.4, “Configuring Internet Information Services to Support Multiple Vibe Servers,” on
page 141

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommended that you follow the instructions in Part I, “Basic Installation,”
on page 37 before attempting a more complex Vibe configuration.

16.1 Planning a Multi-Server Vibe Configuration

¢ Section 16.1.1, “Lucene Index Server Considerations,” on page 135
+ Section 16.1.2, “Vibe File Repository Considerations,” on page 135
+ Section 16.1.3, “Configuring Routing for Multicast IP on the Vibe Server,” on page 136

16.1.1 Lucene Index Server Considerations

Before you can implement a multi-server Novell Vibe configuration, you must move your Lucene
Index Server away from the initial Vibe server, as described in Chapter 15, “Installing the Lucene
Index Server on a Remote Server,” on page 131.

16.1.2 Vibe File Repository Considerations

Before you implement a multi-server Novell Vibe configuration, you must plan the Vibe file repository
for the clustered Vibe servers. Your configuration must comply with the following restrictions:

+ The Vibe file repository must be placed in a shared location that is accessible to each Tomcat
instance.

+ All Tomcat instances must be configured with the same path leading to the shared storage.

For background information on the contents of the Vibe file repository, see Section 10.2, “Distributing
Different Data Types to Different Locations,” on page 92.
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16.1.3

16.2

136

Configuring Routing for Multicast IP on the Vibe Server

If you are planning to use ehcache as your hibernate caching provider, you might need to set up the
routing for multicast IP on each server where Vibe is installed. If this is not done, then depending on
your Vibe system, you might see a communication error when you start the Vibe server. For example,
in the log file you might see the following:

Error starting heartbeat. Error was: No such device.

To prevent this error, or to fix the Vibe system after the error occurs:

1 Run the following command:

route add -net 232.0.0.0/8 dev ethO

Installing the Vibe Software on Multiple Servers

1 Update your existing Novell Vibe server to participate in a multi-server configuration:

la
1b

1c
1d
le

1f

19

1h

1i

Stop Vibe.
Start the Vibe Installation program.

For information on how to start the installation program, see Section 5.1.2, “Running the
Linux Vibe Installation Program,” on page 60 or Section 5.2.2, “Running the Windows Vibe
Installation Program,” on page 70.

On the Installation Settings page, select Reconfigure Settings, then click Next.
On the Choose Installation Type page, select Advanced, then click Next.
Click Next to proceed through the installation pages where no changes are needed.

(Conditional) If you do not have the Basic Vibe Installation Summary Sheet and Advanced
Vibe Installation Summary Sheet from the initial Vibe server installation, record the
configuration of the initial Vibe server as you proceed through the installation pages.

Subsequent Vibe servers in the multi-server configuration must be installed with the same
configuration settings as the initial Vibe server.

On the Vibe Cluster Configuration page, select Enable clustered environment to enable
clustering.

On the first Vibe node, in the JVM Route field, specify workeri. On the second Vibe node,
in the JVM Route field, specify worker2, and so forth for each Vibe node, incrementing the
JVM Route setting. Each Tomcat instance should have a unique JVM Route setting.

workerl, worker2, and so forth are the default names for the matching values used for the
reverse proxy configuration. For example, if you have set up Apache or IIS as a reverse
proxy, these are the default values. The JVM Route setting in the Vibe installer must match
these values.

Select one of the following options for your hibernate caching provider:

ehcache: Ehcache is recommended for small clustered Vibe sites, and is included in the
Vibe software. If you select this option, no further configuration is necessary. For more
information, see Ehcache (http://ehcache.sourceforge.net).

memcached: Memcached is recommended for medium to large clustered Vibe sites.
Memcached is not included in the Vibe software. If you select this option, you must
download and install memcached on each server that you plan to use for caching in your
Vibe cluster. For information about downloading and installing memcached, see
Appendix B, “Memcached Caching with Novell Vibe,” on page 209.
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Depending on the cache provider you select, different options are displayed.

Novell Vibe 4 Installation Program i E

Vibe Cluster Configuration

Select the checkbox to configure this Vibe installation to participate in a cluster.

v Enable clustered environment

JVM Route:

Hibernate caching provider: [encache |~

Metwork interface for distributed cache service (Optional: IP address or hostname expected)

HostName:
Multicast Group Address (Ip Address): [232.0.0.1

Multicast Group Port: |4446

Novell Vibe 4 Installation Program i X

Vibe Cluster Configuration

Select the checkbox to configure this Vibe installation to participate in a cluster.

v Enable clustered environment

JVM Route: |

Hibemnate caching provider: Ir'm-mmachad |'|

Enter a space delimited list of memcached instances in the format host:port
For example, 192.168.1.5:11211 192.168.1.7:11212

Server Addresses: ..

1j (Conditional) If you selected ehcache as the hibernate caching provider in Step 1g, specify
the following information on the Vibe Cluster Configuration page to configure ehcache:

Network interface for distributed cache service: Specify the IP address or hostname of
the distributed cache service.

Multicast Group Address: (Optional) Specify the common multicast group IP address.
Each clustered node recognizes other nodes in the cluster by means of this IP address.

IMPORTANT: Ensure you specify the same IP address on all Vibe nodes in the cluster.
After you have set this IP address for each Vibe node, restart each node in succession,
allowing each node to initialize before restarting the next.

The default multicast group IP address is 232.0.0.1. If you have more than one clustered
Vibe system (for example, one in the lab and one in production), or if you have another
software product that is already using the default multicast group IP address, you must
update this field for one system so that it uses an IP address other than the default.

Use an IP address in the range of 224.0.0.1 to 239.255.255.255.
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1k
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*
*

*

Multicast Group Port: (Optional) Specify the port number through which the Vibe nodes
will communicate.

(Conditional) If you selected memcached as the hibernate caching provider in Step 1g,
specify the following information on the Vibe Cluster Configuration page to configure
memcached:

Server Addresses: Specify a list of memcached servers, with each server separated by a
space. For example, hostnamel: port hostname2:port hostname3: port

The server addresses listed here are all nodes within the Vibe cluster. Changes made to
one Vibe node are immediately visible in other Vibe nodes. Ensure that the clock settings
for each Vibe node are synchronized. Failure to do so can significantly degrade overall
system performance.

Memcached is not included in the Vibe software. If you select memcached as your
hibernate caching provider, you must download and install memcached on each server in
your Vibe cluster. For information about downloading and installing memcached, see
Appendix B, “Memcached Caching with Novell Vibe,” on page 209.

On the Ready to Install page, click Install.

1m On the Installation Complete page, click Finish.

2 Install the Vibe software on each additional server, using the same installation settings that you
used for the initial Vibe server.

3 (Conditional) If you set up ehcache as the caching provider, on each Linux server where you
installed the Vibe software, set the multicast route to enable the servers to function as a cluster:

3a Use the following command on the command line to immediately set the multicast route for

the server:

route add -net 232.0.0.0/8 dev etho

3b To run this command each time the server reboots, add the command to the following file on

each server:

/etc/init.d/boot.local

4 Start Vibe on each server, as described for the platform where you are installing Vibe:

“Starting Vibe on Linux” on page 67
“Running Vibe as a Windows Service” on page 73

“Running Vibe as a Windows Application” on page 74

5 (Conditional) If you set up ehcache as the caching provider and the Vibe servers fail to start
because of a communication error, ensure that you have followed the steps in Section 16.1.3,
“Configuring Routing for Multicast IP on the Vibe Server,” on page 136.

6 Continue with Configuring a Web Application to Provide High Availability Functionality for Your
Vibe Site.
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16.3 Configuring a Web Application to Provide High
Availability Functionality for Your Vibe Site

After Novell Vibe is installed and running on multiple servers, you must provide additional software to
provide high availability functionality. Because Vibe is based on Tomcat, you can use software that
provides high availability for Tomcat.

1 Install and configure one of the following web applications to provide high availability for your
Vibe site:
+ Apache web server (http://www.apache.org)
+ Linux Virtual Server (http://www.linuxvirtualserver.org)
+ Novell Access Manager (https://www.netig.com/products/access-manager/)
+ Microsoft Internet Information Services (http://www.iis.net)

2 Configure the web application to establish the Vibe site URL, which then stays constant for Vibe
users regardless of which Vibe server they access at any given time.

3 Start the web application with its new configuration settings.
4 Test your Vibe site for high availability.

+ If you are using Apache web server, Linux Virtual Services, or Microsoft Internet Information
Services, users can immediately log in to the Vibe site again after a failover has occurred.
The connection between the user’s browser and the Vibe site is maintained as the failover
occurs.

+ If you are using Novell Access Manager, users must start a new browser session, and then
log in to the Vibe site after a failover has occurred. They cannot log in again from the same
browser session, because the connection between the user’s browser and the Vibe site
must be reestablished after the failover.

The following sections provide examples of how to configure the web applications:

+ Section 16.3.1, “Configuring Apache as a Load Balancer,” on page 139
+ Section 16.3.2, “Configuring Linux Virtual Server as a Load Balancer,” on page 141

16.3.1 Configuring Apache as a Load Balancer

The following example configuration uses the balancer module built into the newer Apache (version
2.2.4 and later) web server. It is based on a widely used sticky session technique. Novell Vibe does
not support session sharing/replication among Tomcat instances.

If you are using Novell Access Manager as described in Section 10.9, “Configuring Single Sign-On
with Novell Access Manager,” on page 99, you do not need to configure Apache to load balance as
described in this section, because Access Manager provides this service.

NOTE: When you update your Vibe system, these settings are not preserved. You must redefine
these settings each time you update your Vibe system.

To configure Apache to load balance:

1 Install the Apache web server (http://httpd.apache.org) on one server.
2 Editthe /etc/sysconfig/apache? file:
2a Locate the following line:
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2b

2c

2d

APACHE MODULES=

Then add the following lines:

proxy
proxy_ajp
proxy balancer

The end result should look similar to the following:

APACHE MODULES="actions alias auth basic authn file authz host
authz_groupfile authz_ default authz user authn dbm autoindex cgi dir env
expires include log config mime negotiation setenvif ssl suexec userdir
php5 regtimeout proxy proxy ajp proxy balancer"

Create the following new configuration file:

/etc/apache2/httpd.conf.vibe

Add the following section to the /etc/apache2/httpd.conf.vibe file, providing a
BalancerMember line for each jvmRoute value in a Tomcat server.xml file.

<Location /balancer-managers>
SetHandler balancer-manager
Order deny,allow
Deny from all
Allow from 127.0.0.1
</Location>
<Proxy balancer://cluster names
BalancerMember ajp://vibe server 1:8009 route=workerl
BalancerMember ajp://vibe server 2:8009 route=worker2
</Proxy>
<Location />
ProxyPass balancer://cluster name/ stickysession=JSESSIONID
</Location>

The values that you specify for the route setting (for example, worker1, worker2, etc.)
must exactly match the values that you specify as the JVM Route setting during the Vibe
installation, as described in Section 16.2, “Installing the Vibe Software on Multiple Servers,”
on page 136.

Save the httpd.conf.vibe file.

3 Reconfigure each Vibe server in the cluster so that each server has the same network
information (hostname and ports) as the Apache web server.

For each Vibe server in the cluster:

3a Run the Vibe installation program by reconfiguring the Vibe server.

3b

3c

For information about how to reconfigure your Vibe server, see Chapter 12, “Setting
Configuration Options after Installation,” on page 117.

On the Network Information page in the Vibe installation program, change the hostname in
the Host field for each Vibe server. The hostname must match the DNS name that users
use to access the Vibe service.

For example, if the URL for you Vibe site is vibe.acme.com, you would specify
vibe.acme.com in this field.

Continue through the Vibe installation program for each Vibe server in the cluster, as
described in Chapter 12, “Setting Configuration Options after Installation,” on page 117.

4 Restart Apache.
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TIP: For enhanced performance when using the Internet Explorer browser to access a Vibe system
that is using Apache as an SSL reverse-proxy server, change the Apache SSL exclusion regular
expression configuration from the following:

SetEnvIf User-Agent ".*MSIE.*" \
nokeepalive ssl-unclean-shutdown \
downgrade-1.0 force-response-1.0

to the following:

SetEnvIf User-Agent ".*MSIE [1-5].*"
nokeepalive ssl-unclean-shutdown
downgrade-1.0 force-response-1.0

SetEnvIf User-Agent ".*MSIE [6-9].*"
ssl-unclean-shutdown

16.3.2 Configuring Linux Virtual Server as a Load Balancer

Consult the following online sources for instructions on setting up Linux Virtual Server as a load
balancer for your Novell Vibe site:

+ The Linux Virtual Server Project (http://www.linuxvirtualserver.org)
¢ Linux Virtual Server (LVS) Project (http://www.austintek.com/LVS)
+ Linux Virtual Server Tutorial (http://www.ultramonkey.org/papers/Ivs_tutorial/html)

16.4 Configuring Internet Information Services to
Support Multiple Vibe Servers

You can configure Internet Information Services (IIS) to support multiple Novell Vibe servers. For
more information, see Section 10.10.10, “Configuring IIS to Load Balance in a Clustered
Environment,” on page 111.
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17.1

Running Multiple Lucene Index Servers

Your Novell Vibe site depends on the Lucene Index Server for full functionality. Different Lucene
configurations provide different levels of scalability and reliability.

You can install the Lucene Index Server on a different server from where Vibe is running so that both
programs have access to more server memory, disk space, and CPU resources. However, the Vibe

server and the Lucene Index Server must not have a firewall between them. The RMI protocol used

for the Lucene Index Server port works only within a trusted local area network (LAN).

+ A Basic installation of Vibe places the Lucene Index Server on the same server where the Vibe
software is installed.

+ To provide additional memory for the Lucene Index Server, you might already have configured it
to run in its own memory space, as described in Section 10.6.3, “Running the Lucene Index
Server in Its Own JVM,” on page 96.

+ To provide additional disk space and memory for the Lucene Index Server, you might already
have moved it to a different server, as described in Chapter 15, “Installing the Lucene Index
Server on a Remote Server,” on page 131.

These configurations provide additional resources for the Lucene Index Server, but it is still a single
point of failure for your Vibe site. If the Lucene Index Server goes down, the Vibe site becomes
inaccessible until access to the Lucene Index Server is restored.

Running multiple Lucene Index Servers provides high availability functionality, so that if one Lucene
Index Server goes down, Vibe users can still access the Vibe site because other Lucene Index
Servers are still available.

+ Section 17.1, “Planning a High Availability Lucene Configuration,” on page 143

¢ Section 17.2, “Setting Up a High Availability Lucene Configuration,” on page 144

¢ Section 17.3, “Testing Your Lucene High Availability Configuration,” on page 156

+ Section 17.4, “Synchronizing a High Availability Lucene Configuration,” on page 158

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part I, “Basic Installation,” on
page 37 before attempting a more complex Vibe and Lucene configuration.

Planning a High Availability Lucene Configuration

A high availability Lucene Index Server configuration must include at least two different servers
(either physical or virtual), referred to as “nodes” in the Vibe installation program. Lucene nodes in a
high availability configuration can be set up on Linux servers, Windows servers, or both.

Each Lucene node must have its own independent directory structure for index files. The default
location for the index files for the Lucene Index Server varies by platform:

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene
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17.2

17.2.1

As you plan your high availability Lucene configuration, you can use the Advanced Vibe Installation
Summary Sheet to record the options you want to use.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the number of Lucene nodes that you want in your
high availability Lucene configuration.

Each Lucene node needs a unique name, a descriptive title, and a static IP address. The name and
title identify the node in the Vibe administrative interface. Typically, the Lucene Index Server listens
on RMI port 1199 on its server, but you can configure it to use a different port number if the default
port number is already in use.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the name, description, IP address, and RMI port
number for each Lucene node.

If you have already accumulated index data on your initial Vibe server, you can choose to copy the
index files to the Lucene nodes, or you can reindex the Vibe site after the new Lucene nodes are
running. Depending on the amount of accumulated index data, reindexing can be a time-consuming
process.

The Vibe server and the Lucene nodes must not have a firewall between them. The RMI protocol
used for the Lucene Index Server port works only within a trusted local area network (LAN).

Setting Up a High Availability Lucene
Configuration

¢ Section 17.2.1, “Changing from a Local Lucene Index Server,” on page 144
¢ Section 17.2.2, “Changing from a Single Remote Lucene Index Server,” on page 147
¢ Section 17.2.3, “Expanding an Existing High Availability Lucene Configuration,” on page 149

+ Section 17.2.4, “Changing Your Lucene Configuration without Vibe Site Down Time,” on
page 152

Changing from a Local Lucene Index Server

To change from a local Lucene Index Server running on the Novell Vibe server, you must install the
Lucene Index Server on two or more remote servers, and then reconfigure Vibe for a high availability
Lucene configuration.

NOTE: Although it is possible to use the Lucene Index Server on the Vibe server as one of the
“remote” Lucene nodes, this is not a recommended configuration. Consider it only if you are restricted
to two servers for your Vibe site.

1 Set up two or more Lucene nodes:

la Install the Lucene Index Server on each node, as described in Section 15.1, “Installing the
Lucene Software,” on page 131.

1b (Optional) Copy accumulated index data from the initial Lucene Index Server to each
additional Lucene node.
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1c

The default location for the index files varies by platform:

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene

Start the Lucene Index Server on each Lucene node, as described in Section 15.3,
“Managing a Remote Lucene Index Server,” on page 133.

2 Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 16, “Running
Vibe on Multiple Servers,” on page 135, stop Vibe on all servers, or follow the instructions in
Section 17.2.4, “Changing Your Lucene Configuration without Vibe Site Down Time,” on

page 152.

3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:

3a
3b
3c
3d

3e
3f

On the Installation Settings page, select Reconfigure Settings, then click Next.

On the Choose Installation Type page, select Advanced, then click Next.

Click Next to proceed through the installation pages where no changes are needed.
On the Lucene Configuration page, fill in the following fields:

Lucene configuration type: Select high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed and started the Lucene Index Server.

Novell Vibe 4 Installation Program - x

Lucene Configuration

i

Use the following fields to configure the Lucene index.

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannot be used.

Max booleans | 100000

Merge factor 10

Lucene configuration type: high avallability j

Connection credentials to the lucene server(s):
Login name: iucene service

Password:

o —
-—

MNumber of high availability search nodes: l2

Click Next.

On the Configure High Availability Search Nodes page, specify the configuration information
for each Lucene node from the Advanced Vibe Installation Summary Sheet that you filled
out in Section 17.1, “Planning a High Availability Lucene Configuration,” on page 143, then
click Next.
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Novell Vibe 4 Installation Program o x

Configure High Availablity Search Nodes

Gonfigure the high availability search nodes specified in the previous panel.

Use the following fields to configure each high availability search node.
To remove one of the high avallable search nodes, unselect Its "Keep" check box.

Enter the high availability service name, host name and edit the RMI Port if the default port cannot
be used.

High Availability Search Node 1
¥ Keep Service name |LuceneLinux

Service title ELucene on Linux

Host [172.16.5.2

AMI port [1199

~High Avallability Search Node 2
Iv Keep Service nameELucene Windows

Service title iLucene on Windows

Host [172.16.5.9

RMI port [1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.
4b Click your linked name in the upper right corner of the page, then click the Administration
Console icon ',
4c Under Search Index, click Nodes.

Lucene on Linux {lucenelinux)

Host 1721652
RMI port: 1199

User Mode Access
@ Read and Write
© write Only
© No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host: 172.16.5.19
RMI port: 1198

User Mode Access
© Read and Write
@ Write Only
© No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

@D
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By default, the first Lucene node in the list has Read and Write access, meaning that Vibe

updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a hew Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes, click Apply, then
click Close.

The new setting is put into effect immediately, so that users immediately have access to the
additional Lucene nodes.

5 Skip to Section 17.3, “Testing Your Lucene High Availability Configuration,” on page 156.

Changing from a Single Remote Lucene Index Server

To change from a single remote Lucene Index Server to a high availability configuration, you must
install the Lucene Index Server on one or more additional remote servers, and then reconfigure
Novell Vibe for additional Lucene nodes.
1 Bring down your Vibe site:
la Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 16,
“Running Vibe on Multiple Servers,” on page 135, stop Vibe on all servers, or follow the
instructions in Section 17.2.4, “Changing Your Lucene Configuration without Vibe Site Down
Time,” on page 152.

1b Ensure that the existing remote Lucene Index Server also stops.
2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in
Section 15.1, “Installing the Lucene Software,” on page 131.

2b (Optional) Copy accumulated index data from the initial remote Lucene node to each
additional Lucene node.

The default location for the index files varies by platform:

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene

2c Start the Lucene Index Server on each Lucene node, as described in Section 15.3,
“Managing a Remote Lucene Index Server,” on page 133, but do not bring up your Vibe site.

3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields:
Lucene configuration type: Change server to high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed the Lucene Index Server.

Running Multiple Lucene Index Servers 147



148

Novell Vibe 4 Installation Program = x
Lucene Configuration

Use the following fields to configure the Lucene index. N

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software Is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannol be used.

Max booleans |100000

Merge factor i[l

Lucene configuration type: high availability j

Connection credentials to the lucene server(s):
Login name: ‘iucene service

Password:

o —
—

Number of high availability search nodes: 2

3e Click Next.

3f On the Configure High Availability Search Nodes page, specify the configuration information
for each Lucene node from the Advanced Vibe Installation Summary Sheet that you filled
out in Section 17.1, “Planning a High Availability Lucene Configuration,” on page 143, then

click Next.
Novell Vibe 4 Installation Program = x
Configure High Availablity Search Nodes
Cenfigure the high availability search nodes specified in the previous panel. N

Use the following fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep" check box.

Enter the high availability service name, host name and edit the RMI Port If the default port cannot
be used.

rHigh Availability Search Node 1

Iv'Keep Service name |LuceneLinux
Service title |Lucene on Linux
Host [172.16.5.2
AMI port|1129

rHigh Avallability Search Node 2

¥ Keep service name;i;ucene Windows

Service title El_LPCE.‘I'IE} on Windows

Host[172.16.5.9

RMI port 1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.
4b Click your linked name in the upper right corner of the page, then click the Administration

Console icon '+ .
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4c

4d
de

Under Search Index, click Nodes.

Lucene on Linux (lucenelinux)
Host 172.165.2
RMi part: 1199
User Mode Access
© Read and Write
- Write Only
- No Access

Enable Deferred Update Log
No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)
Host 17216 5.19
RMI port: 1199
User Mode Access
-~ Read and Write
@ write Only
2 No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe

updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a new Lucene node.

In the User Mode Access box, select Read and Write for all Lucene nodes.
Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to the
additional Lucene nodes.

5 Skip to Section 17.3, “Testing Your Lucene High Availability Configuration,” on page 156.

Expanding an Existing High Availability Lucene
Configuration

After you have set up an initial high availability Lucene configuration, you can add additional Lucene
nodes at any time.

1 Bring down your Vibe site:
la Stop Vibe.

1b

If you have installed the Vibe software on multiple servers, as described in Chapter 16,
“Running Vibe on Multiple Servers,” on page 135, stop Vibe on all servers, or follow the
instructions in Section 17.2.4, “Changing Your Lucene Configuration without Vibe Site Down
Time,” on page 152.

Stop all Lucene nodes, as described in Section 15.3, “Managing a Remote Lucene Index
Server,” on page 133.

2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in

2b

Section 15.1, “Installing the Lucene Software,” on page 131.

(Optional) Copy accumulated index data from an existing Lucene node to each additional
Lucene node.

The default location for the index files varies by platform:
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Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene

2c Start the Lucene Index Server on each Lucene node, as described in Section 15.3,
“Managing a Remote Lucene Index Server,” on page 133, but do not bring up your Vibe site.

3 Run the Vibe installation program to configure the Vibe server for the additional Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.

3d On the Lucene Configuration page, increase the number of nodes in the Number of high
availability search nodes field, then click Next.

Novell Vibe 4 Installation Program - x

Lucene Configuration

i

Use the following fields to configure the Lucene index.

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannot be used.

Max booleans | 100000

Merge factor 10

Lucene configuration type: high avallability j

Connecticn credentials to the lucene server(s):

Login name: lucene service

Password:

o —
-—

MNumber of high availability search nodes: 2

3e Onthe Configure High Availability Search Nodes page, specify the configuration information
for each additional Lucene node, then click Next.
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Novell Vibe 4 Installation Program = X
Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel. N

Use the following fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep" check box.

Enter the high availabllity service name, host name and edit the RMI Port if the default port cannot
be used.

RMI port 1199 ‘ S

~High Availability Search Node 2

v Keep Service name !Lucene Windows

Service title iLucene on Windows

Host 172.16.5.3

RMI port 1199

rHigh Availability Search Node 3
¥ Keep Service name |

Service title|

Host |

RMI port 1199

If you need more than 3 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3f Click Next until you reach the Ready to Install page, then click Install.
3g On the Installation Complete page, click Finish.
3h Start Vibe.
3i (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.
4b Click your linked name in the upper right corner of the page, then click the Administration
Console icon ',

4c¢ Under Search Index, click Nodes.

Lucene on Linux (lucenelinux)

Host 1721652
RMI port. 1199

User Mode Access
© Read and Write
@ Write Only
© No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 172.16.5.19
RMI port: 1199

User Mode Access
© Read and Write
@ Write Only
© No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists

L 2oty I cose ]
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4d
4e

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe

updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a hew Lucene node.

In the User Mode Access box, select Read and Write for all Lucene nodes.
Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to the
additional Lucene nodes.

5 Skip to Section 17.3, “Testing Your Lucene High Availability Configuration,” on page 156.

Changing Your Lucene Configuration without Vibe Site
Down Time

Vibe site down time can be avoided only if you have installed the Vibe software on multiple servers,
as described in Chapter 16, “Running Vibe on Multiple Servers,” on page 135.

To change to a high availability Lucene configuration in a multiple Vibe server configuration:

1 Set up two or more Lucene nodes:

la

1b

Install the Lucene Index Server on each node, as described in Section 15.1, “Installing the
Lucene Software,” on page 131

Start the Lucene Index Server on each Lucene node, as described in Section 15.3,
“Managing a Remote Lucene Index Server,” on page 133.

2 Stop Vibe on one server.

The other Vibe servers remain in service for users and continue to communicate with the original
Lucene Index Server.

3 Run the Vibe installation program on the Vibe server that you stopped to configure it for multiple
Lucene Index Servers:

3a
3b
3c
3d

On the Installation Settings page, select Reconfigure Settings, then click Next.

On the Choose Installation Type page, select Advanced, then click Next.

Click Next to proceed through the installation pages where no changes are needed.
On the Lucene Configuration page, fill in the following fields.

Lucene configuration type: Select high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed the Lucene Index Server.
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Novell Vibe 4 Installation Program
Lucene Configuration

Use the following fields to configure the Lucene index. N

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software Is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannol be used.

Max booleans }166600
Merge factor ‘1 ]

Lucene configuration type: high availability j

Connection credentials o the lucene server(s):
Login name: \I-ucene service
Password: 7

Number of high availability search nodes: ‘2

3e Click Next.

3f On the Configure High Availability Search Nodes page, specify the configuration information
for each Lucene node from the Advanced Vibe Installation Summary Sheet that you filled
out in Section 17.1, “Planning a High Availability Lucene Configuration,” on page 143, then

click Next.

Novell Vibe 4 Installation Program = x
Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel. N

Use the following fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep" check box.

Enter the high availability service name, host name and edit the RMI Port If the default port cannot
be used.

rHigh Availability Search Node 1

v Keep Service name |LucenelLinux

Service title ELLscene on Linux

Host [172.16.5.2

RMI port |1199

rHigh Avallability Search Node 2

¥ Keep Service name |Lucene Windows

Service title |Lucene on Windows

Host[172.16.5.9

RMI port [1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
4 Start the reconfigured Vibe server.

5 Access the reconfigured Vibe server and prevent access to the additional Lucene nodes:
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IMPORTANT: All Vibe servers must be reconfigured before any of them access the additional
Lucene nodes.

5a Log in to the reconfigured Vibe server as the Vibe administrator, using the server hostname
rather than your Vibe site URL.

5b Click your linked name in the upper right corner of the page, then click the Administration
Console icon ‘%',
5¢c Under Search Index, click Nodes.

Lucene on Linux (lucenelinux)
Host: 172.16.5.2
RMi port: 1199
User Mode Access
@ Read and Write
Write Only
No Access

7| Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 172.16.5.19
RMI port: 1199

User Mode Access
Read and Write
@ Write Only
No Access
7| Enable Deferred Update Log

Mo Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. When you set up a high availability Lucene configuration without
Vibe site down time, you need to prevent write access during the reconfiguration process.

5d In the User Mode Access box, change Write Only to No Access for the additional Lucene
nodes.

5e Click Apply, then click Close.

The new setting is put into effect immediately, so that the reconfigured Vibe server does not
communicate with the additional Lucene nodes.

6 Reconfigure the rest of the Vibe servers:
6a Stop each Vibe server.
6b Repeat Step 3 to configure each Vibe server for the additional Lucene nodes.
6¢c Start each reconfigured Vibe server.
7 Access the reconfigured Vibe site and allow write access to the additional Lucene nodes:
7a Log in to the reconfigured Vibe as the Vibe administrator.
7b Click your linked name in the upper right corner of the page, then click the Administration
Console icon ‘%',
7c Under Search Index, click Nodes.
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Lucene on Linux {LuceneLimix)

Host172.16.5.19
RMI port: 1183

User Mode Access
@ Read and Write
O write Only
O No access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows {LuceneWindows)

Host: 137.65.67 222
RMI port: 1133

User Mode Access
O Read and Witz
© write Only
@ NoAccess

Enable Deferred Update Log

No Deferred Update Log Record Exists

7d In the User Mode Access box, change No Access to Write Only for the additional Lucene
nodes.

7e Click Apply, then click Close.

The new setting is put into effect immediately, so that the reconfigured Vibe servers can

now communicate with the additional Lucene nodes, although user access is still
disallowed.

8 Reindex the Vibe site, so that the additional Lucene nodes are updated with the same index data
that the original Lucene Index Server has:

8a On the Administration page, under Search Index, click Index.

Search Index @

Manage Search Index [

Re-Index Everything

Select the Places to Be Re-Indexed:
Selecting a folder or workspace automatically indexes all folders and workspaces within it.

[l Home Workspace

3P Users and Groups
- Global Workspaces
-i§§ Net Folders

+- 3§ Person
E} - Team v

Select the Nodes to Apolv Re-Indexina to:

Ifre-indexing all or large part ofthe tree, it is strongly recommended to change the access mode of the node(s) to write-only before starting
re-indexing so that all read requests can go to the other unselected node(s) while re-indexing is in progress. Atleast one node must allow

read-write at any given time. Once re-indexing is completed, change the access mode of the node(s) back to read-write so that search
requests can use them again

Lucene on Linux (lucenelinux) - Read and Write, Deferred Update Log Enabled, No Deferred Update Log Record Exists
Lucene on Windows (lucenewindows) - Write Only, Deferred Update Log Enabled, No Deferred Update Log Record Exists

8b On the Manage Search Index tab, select Re-Index Everything, so that the entire Vibe site is
reindexed.

8c Select the additional Lucene nodes, but do not select any previously existing nodes.
8d Click OK to start the indexing.
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Depending on the size of your Vibe site, reindexing can be a time-consuming process.
However, because one or more previously existing Lucene Index Servers are still servicing
the Vibe site, users are not affected by the reindexing process.

8e When the reindexing is complete, click Close.
9 Make the additional Lucene nodes available to Vibe users:
9a On the Administration page, under Search Index, click Nodes.

Lucene on Linux (lucenelinux)

Host: 172.16.5.2
RMi port: 1199

User Mode Access
@ Read and Write
2 Write Only
) No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 172.16.5.19
RMi part: 1199

User Mode Access
) Read and Write
@ Write Only
) No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

9b In the User Mode Access box, change Write Access to Read and Write for the additional

Lucene nodes.

9c Click Apply, then click Close.

The new setting is put into effect immediately, so that Vibe users have additional Lucene
Index Servers available as they use the Vibe site.

Testing Your Lucene High Availability
Configuration

When you first set up your high availability Lucene configuration, you can configure Novell Vibe to
write Lucene node information to the Tomcat log file so that you can observe the behavior of the
Lucene nodes. Then you can take nodes down and bring them up again to see the effect on your Vibe
site. This process helps you prepare for the situation where a Lucene node goes down unexpectedly
or you need to take one down on purpose, perhaps for maintenance.

¢ Section 17.3.1, “Configuring Vibe to Log Lucene Node Activity,” on page 157
¢ Section 17.3.2, “Observing Lucene Node Activity,” on page 157

NOTE: For background information about the Tomcat log file, see “Tomcat Log File” in “Site
Maintenance” in the Novell Vibe 4.0 Administration Guide.
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17.3.1 Configuring Vibe to Log Lucene Node Activity

By default, Vibe writes an error to the Tomcat log file whenever it cannot communicate with a Lucene
node. For testing purposes, you can change the logging level so that the Tomcat log file includes a
message for each time Vibe contacts a Lucene Index Server.

After observing and understanding the behavior, you should return the logging to normal levels.

1 Open the 1og47j.properties file in a text editor.
The location of the 1og4j .properties file varies by platform.

Linux: /opt/novell/teaming/apache-tomcat/webapps/ssf/WEB-INF

Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF

2 Search for the following line:

#log4j.category.com.novell.teaming. search=DEBUG

3 Remove the pound sign (#) from the beginning of the line to activate the DEBUG logging level for
the Lucene Index Server.

The DEBUG logging level adds a message for each time Vibe contacts a Lucene Index.
4 Save the 1og4j.properties file, then exit the text editor.
5 Stop Vibe, then start Vibe to put the new logging level into effect.

17.3.2 Observing Lucene Node Activity

After changing the Vibe logging level to include Lucene node activity, you can monitor the Tomcat log
file to see which Lucene nodes Vibe is contacting.
1 Change to the directory where the Tomcat log file is located.

For background information about the Tomcat log file, see “Tomcat Log File” in “Site
Maintenance” in the Novell Vibe 4.0 Administration Guide.

2 On Linux, use the tail command to monitor the end of the Tomcat log file.
tail -f catalina.out
or

On Windows, download an equivalent command from the Internet in order to perform the
following steps.

For example, there is a command available at SourceForge.net (http://sourceforge.net/projects/
tailforwin32).

3 Perform some activities on the Vibe site to create new content.

For example, you could create a blog entry. The Tomcat log file shows that Vibe is contacting
each available Lucene Index Server in turn as it submits the new information for indexing. Nodes
are considered available if they are marked Read and Write in the User Mode Access box on the
Lucene Nodes page.

4 Bring down one of the Lucene nodes.

For example, you might reboot the Lucene server, stop the Lucene Index Server on the node, or
otherwise prevent Vibe from contacting the Lucene node.

5 Observe that the Tomcat log file displays an error when the Lucene node becomes unavailable.
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17.4

Perform some additional activities on the Vibe site that create new content.

You might notice a pause as Vibe tries to connect with the Lucene node that is no longer
available.

Observe that the Tomcat log file shows when normal Vibe processing has resumed without
access to the unavailable Lucene node.

8 Make the unavailable Lucene node available again.

9 Observe that the Tomcat log file indicates that Vibe has created a journal record on the Lucene

10

node that was temporarily unavailable.

The journal record contains the indexing operations that failed to take place while the Lucene
node was unavailable. Even though the Lucene node is back up, Vibe does not start accessing it
until it has been synchronized with the latest index information.

To synchronize the out-of-date Lucene node, follow the steps in Section 17.4, “Synchronizing a
High Availability Lucene Configuration,” on page 158.

After the out-of-date Lucene node has been synchronized, Vibe starts accessing it again.

If a situation arises where no Lucene node is marked Read and Write in the User Mode Access box
on the Lucene Nodes page, Vibe temporarily accesses the first node in the list that is set to Write
Only. If no nodes are set to Write Only or Read and Write, Vibe temporarily accesses the first node in
the list, even though it is set to No Access. This functionality is required because you cannot log in to
the Vibe site without access to a Lucene Index Server.

Synchronizing a High Availability Lucene
Configuration

You should ensure that your Lucene node servers remain in sync with each other. Whenever a
Lucene node is down for a relatively short period of time (no more than one or two days), you can
synchronize it with other Lucene nodes whose index files are up-to-date.

1 Ensure that the out-of-date Lucene node is running reliably again.

2 Log in to the Novell Vibe site as the Vibe administrator.

3 Click your linked name in the upper right corner of the page, then click the Administration

Console icon * .

4 Under Search Index, click Nodes.

158 Novell Vibe 4.0 Installation Guide



5 To repair the out-of-date Lucene node, select Apply Deferred Update Log Records to the Index,
then click Apply.

The Deferred Update Log options disappear if the update is successful. If for some reason the
deferred update log records cannot be applied to the index, you can rebuild the index, as
described in “Rebuilding the Lucene Index” in “Site Maintenance” in the Novell Vibe 4.0
Administration Guide.

6 Click Close.
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Running Multiple Database Servers

Each of the three databases supported by Novell Vibe (MySQL, Microsoft SQL, and Oracle) has its
own approach to clustering the database server. Information about clustering database servers is

available on the Internet, for example:

+ MySQL Cluster (http://www.mysqgl.com/products/database/cluster)
+ SQL Server Clustering (http://www.sql-server-performance.com/articles/clustering/
clustering_intro_p1l.aspx)

+ Oracle Real Application Clusters (http://www.oracle.com/technology/products/database/
clustering)

NOTE: We highly recommend that you follow the instructions in Part Il, “Basic Installation,” on
page 37 before attempting a more complex Vibe configuration.
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V Upgrade

Chapter 19, “Upgrading From Novell Vibe 3.4 to Novell Vibe 4,” on page 165

*

*

Chapter 20, “Upgrading From Novell Vibe 3.3 to Novell Vibe 4,” on page 177

*

Chapter 21, “Upgrading to Novell Vibe 3.3 from Previous Versions,” on page 187

*

Chapter 22, “Updating the Operating System Where Vibe Is Running,” on page 189
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Upgrading From Novell Vibe 3.4 to
Novell Vibe 4

This section describes how to upgrade from Novell Vibe 3.4 to Novell Vibe 4. You can also upgrade
from Vibe 3.3 to Vibe 4, as described in Chapter 20, “Upgrading From Novell Vibe 3.3 to Novell Vibe
4,” on page 177. If you have not yet upgraded to Vibe 3.3, upgrade to Vibe 3.3 as described in
Chapter 21, “Upgrading to Novell Vibe 3.3 from Previous Versions,” on page 187. You cannot
upgrade from a version prior to Vibe 3.3 to Vibe 4.

After you upgrade your Vibe system, ensure that you check the Vibe download site where you
downloaded the Vibe software for any hot patches that might be available.

*

*

Section 19.1, “Understanding the Upgrade Process,” on page 165

Section 19.2, “Backing Up Vibe Data,” on page 166

Section 19.3, “Updating the Java Development Kit (JDK),” on page 166
Section 19.4, “Installing the Java Cryptography Extension (JCE),” on page 166
Section 19.5, “Remote Lucene Index Server Upgrade,” on page 166

Section 19.6, “Upgrading the Vibe Software,” on page 168

Section 19.7, “Upgrading the Vibe Database from 3.4 to 4,” on page 170
Section 19.8, “Performing Post-Upgrade Tasks,” on page 172

19.1 Understanding the Upgrade Process

During the upgrade from Novell Vibe 3.4 to Vibe 4, the following aspects of your Vibe system are
modified:

*

*

The software is upgraded from Vibe 3.4 to Vibe 4.
A backup copy of your existing Vibe 3.4 installation is created in the following directory:

Linux: /opt/novell/teaming/teaming-backup

Windows: C:\Program Files\Novell\Teaming\teaming-backup

If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell
Teaming), the backup copy is located in the following directory:

Linux: /opt/icecore

Windows: C:\Program Files\icecore
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19.2

19.3

19.4

19.5

19.5.1

Backing Up Vibe Data

Ensure that your Vibe data is backed up before you begin the upgrade process. For information about
the data that needs to be backed up, see “Backing Up Vibe Data” in the Novell Vibe 4.0
Administration Guide.

Because of significant changes to the database schema, Novell recommends that you use your
database backup software to back up your Vibe database before upgrading to Vibe 4.

Updating the Java Development Kit (JDK)

Vibe 4 requires the latest version of the IBM or Oracle JDK.

Before you begin the upgrade process, update to the latest JDK, as described in Section A.1, “Java
Development Kit (JDK),” on page 203.

Installing the Java Cryptography Extension (JCE)

Vibe 4 requires that you also install the Java Cryptography Extension (JCE) in addition to the JDK on
each server in your Vibe system. (This was not a requirement in Vibe 3.4 and earlier.)

Before you begin the upgrade process, install the JCE on each server in your Vibe system, as
described in Section A.2, “Java Cryptography Extension (JCE),” on page 205.

Remote Lucene Index Server Upgrade

IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you
do not need to upgrade it separately. Skip to Section 19.6, “Upgrading the Vibe Software,” on
page 168.

You have the following options when upgrading your remote Lucene search index to Vibe 4:
+ Create a new search index

Because a full re-index is required after upgrading to Vibe 4, creating a new search index is less
time-consuming than upgrading your existing search index. The benefit to creating a new
Lucene search index is that you are able to maintain the original search index in the unlikely
case of an emergency rollback.

+ Upgrade your existing Lucene search index

If you choose to upgrade your existing Lucene search index, you must perform a re-index after
the upgrade, as described in Section 19.8.1, “Resetting the Search Index,” on page 172.

These options are described in the following sections:

+ Section 19.5.1, “Creating a New Search Index,” on page 166
+ Section 19.5.2, “Upgrading an Existing Search Index,” on page 167

Creating a New Search Index

1 Stop Vibe.
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Linux: On the Vibe server, specify the following command:
/etc/init.d/teaming stop

Windows:  See “Stopping Vibe as an Application” on page 74.

2 Stop the Lucene search index.
On the Lucene index server, specify the following command:

Linux: /etc/init.d/indexserver stop

Windows: c:\Program
Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
shutdown.bat

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.4 system.

4 On a different server than where your original search index was running, create a new search
index, as described in Section 15.1, “Installing the Lucene Software,” on page 131.

19.5.2 Upgrading an Existing Search Index

The Vibe installation program cannot upgrade the Lucene search index when it is running on a
remote server. To upgrade your remote search index from Novell Vibe 3.4 to Novell Vibe 4, you need
to run the Remote Lucene Server installation program:

1 Stop Vibe.

Linux: On the Vibe server, specify the following command:
/etc/init.d/teaming stop

Windows:  See “Stopping Vibe as an Application” on page 74.

2 Stop the Lucene search index.
On the Lucene index server, specify the following command:

Linux: /etc/init.d/indexserver stop

Windows:  c¢:\Program
Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
shutdown.bat

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.4 system.

4 Copy the Vibe 4 Remote Lucene Server Installation program from the directory where the Vibe 4
Installation program is located to a convenient directory on the server where the remote Lucene
search index is located.

The name of the Remote Lucene Server Installation program varies by platform:

Upgrading From Novell Vibe 3.4 to Novell Vibe 4 167



© 0 N o O

10
11
12

13
14
15

16

17

18

Linux: lucene-installer.linux

Windows: lucene-installer.exe

Start the Vibe 4 Remote Lucene Server installation program.

Accept the License Agreement, then click Next.

Select Update software and settings.

Click Next to continue.

Click Next to accept the installation location.

Click Next to accept the Java JDK location.

In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see Section 10.6.2, “Changing Lucene
Configuration Settings,” on page 96.

Click Install to install the upgraded Lucene search index software.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Lucene search index server, reboot the server
where it is running to ensure that the 3.4 cache is cleared.

Start the Lucene Index Server.
On the Lucene index server, specify the following command:

Linux: /etc/init.d/indexserver start

Windows:  c:\Program
Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
startup.bat

Ensure that the index server is running.
/etc/init.d/indexserver status

Now that all remote Vibe components have been upgraded, follow the instructions in
Section 19.6, “Upgrading the Vibe Software,” on page 168.

19.6 Upgrading the Vibe Software

Complete the following steps for each server in your Vibe system that is running the Vibe software:

168

1
2

3

Ensure that you have a current backup of your Vibe 3.4 system.
Stop Vibe.

Linux: On the Vibe server, specify the following command:
/etc/init.d/teaming stop
Windows:  See “Stopping Vibe as an Application” on page 74.

Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.4 system.
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Copy the installer.xml file from the directory where the Vibe 3.4 Installation program is
located to the directory where you have extracted the Vibe 4 software.

The installer.xml file provides default values when you run the Vibe 3.4 Installation program.

Obtain a new license key from the location where you downloaded the Vibe 4 software, then
place it in the same directory with the Vibe software. (The Vibe installation program does not
start without a license file in the same directory.) Rename the license to license key.xml.

Vibe 4 requires an updated license. If you use a license from a previous version, not all features
are available.

Start the Vibe 4 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are upgrading Vibe:

¢ Section 5.1.2, “Running the Linux Vibe Installation Program,” on page 60
+ Section 5.2.2, “Running the Windows Vibe Installation Program,” on page 70

Accept the License Agreement, then click Next.

Novell Vibe 4 Installation Program = X

Installation Options

Select the action you want to perferm.

" New installation
* Update software and settings
" Recenfigure settings

Because you provided your Vibe 3.4 installer.xnl file in the directory with the Vibe 4
installation program, the Update software and settings installation option is selected by default.

8 Click Next to continue.

9 Click Yes to let the Installation program know that you have stopped Vibe.

10

11

12

13
14
15

16

Select the check box to let the installation program know that you have backed up all of your
data, then click Next.

Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then
click Next.

For more information about the differences between basic and advanced installations, see
Section 4.1, “What Is a Basic Vibe Installation?,” on page 39 and Section 10.1, “What Is an
Advanced Installation?,” on page 91.

Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 4 system.

Click Install when you are ready to perform the upgrade.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the
3.4 cache is cleared.

Continue with Section 19.7, “Upgrading the Vibe Database from 3.4 to 4,” on page 170.
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19.7 Upgrading the Vibe Database from 3.4to 4

170

Upgrade the Vibe software (as described in Section 20.5, “Upgrading the Vibe Software,” on
page 180) before upgrading the Vibe database.

When you upgrade to Vibe 4, the Vibe Installation program does not update the database as part of
the Vibe software upgrade. Therefore, you must manually update the database before you can start
Vibe:

1 (Conditional) When upgrading a MySQL database, ensure that the Vibe database character set
for the Vibe 3.4 system is in UTF-8 format.
la To view the character set format, run the following command:

SELECT default character set name FROM information schema.SCHEMATA S WHERE
schema name = 'sitescape';

In this command sitescape is the name of the Vibe database. Replace sitescape with the
name of your database.

1b If the character set format is anything other than UTF-8, run the following command to
change it:

In the following command, sitescape is the name of the Vibe database. Replace
sitescape with the name of your database.

ALTER DATABASE sitescape CHARACTER SET utfs§;
2 Change to the db directory in the Vibe installation:
cd /vibe installation/temp-installer/db
This directory contains the following properties files:
* mysgl-liquibase.properties
* Oracle-liquibase.properties
¢ sglserver-liquibase.properties

3 In atext editor, open the properties file that corresponds with your database type to make any of
the following changes. Save and close the text editor when you are finished making changes.

+ Change the database user name and password for accessing the database.
+ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace localhost with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database is
sitescape, the name of the company that previously developed the Vibe software).

4 Save your changes and close the properties file.

5 In the same directory (/vibe installation/temp-installer/db), execute the following
commands to update the database schema:
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Windows manage-database.bat databaseType mark33DatabaseAsUpdated
manage-database.bat databaseType updateDatabase

Possible database types (databaseType) are mysql, oracle, or sglserver, depending
on your type of database.

Linux ./manage-database.sh databaseType mark33DatabaseAsUpdated
./manage-database.sh databaseType updateDatabase

Possible database types (databaseType) are mysql, oracle, or sglserver, depending
on your type of database.

NOTE: Ensure that the manage-database. sh file is executable.

NOTE: You can safely ignore the following Liquibase log messages:

¢ Warning: modifyDataType will lose primary key/autoincrement/not null
settings for mysqgl

+ Any messages that contain the words info: failure Ofr info: failed, as long as they
are associated with a type INFO message

6 Start Vibe 4 in the same way that you have been starting Vibe 3.4.

When you start Vibe for the first time after the upgrade, it takes longer to start than usual
because data in the Vibe database must be upgraded before the Vibe site is ready to use.

Linux: On the Vibe server, specify the following command:
/etc/init.d/teaming start

Windows:  See “Starting Vibe as an Application” on page 74.
or
See “Starting Vibe as a Windows Service” on page 73.

NOTE: If you have been starting Vibe as a Windows service, you need to delete your
existing Windows service configuration and re-configure Vibe as a Windows service before
you can start Vibe. For information about how to configure Vibe as a Windows service, see
“Configuring Vibe as a Windows Service” on page 73.

7 (Recommended) For security reasons, delete the password that you specified in Step 7 in
“Creating the Vibe Database” on page 63.

7a Change to the db directory in the Vibe installation:
cd /vibe installation/temp-installer/db
This directory contains the following properties files:
¢ mysgl-liquibase.properties
*® Oracle-liquibase.properties
* sglserver-liquibase.properties

7b In a text editor, open the database type-liquibase.properties file that corresponds
with your database type, then delete the password.

7c Save and close the properties file.
8 Continue with Section 19.8, “Performing Post-Upgrade Tasks,” on page 172.
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19.8 Performing Post-Upgrade Tasks

After you start Novell Vibe 4, you can access your Vibe site as usual. However, you need to reset
some aspects of the interface before you allow users to access the upgraded site. The interface reset
affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

+ Section 19.8.1, “Resetting the Search Index,” on page 172
+ Section 19.8.2, “Resetting Your Definitions,” on page 173

*

Section 19.8.3, “Resetting the Standard Templates,” on page 174

*

Section 19.8.4, “Updating the Vibe License,” on page 174

*

Section 19.8.5, “Re-Installing the Windows Service,” on page 174

*

Section 19.8.6, “Updating the Server.xml File When Using Secure HTTP,” on page 175

19.8.1 Resetting the Search Index

In order for an upgraded search index to be compatible with Vibe 4, you need to re-index the search
index. Until you reset the search index, the search index and the vibe server are not in a compatible
state. The catalina.out and appserver.log files show errors until the search index is reset.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers. For more information about multiple search indexes, see Chapter 17, “Running Multiple
Lucene Index Servers,” on page 143.

Depending on the size of your Vibe site, this can be a very time-consuming process.

+ “Resetting a Single Search Index” on page 172
+ “Resetting the Search Index with Multiple Index Servers” on page 173

Resetting a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon '+,
3 In the Management section, click Search Index.
4 Select Re-Index Everything.
5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.
6 After the index server has been reset, ensure that no errors are contained in the following log

files:
Windows: ¢ C:\Program Files\Novell\Teaming\apache-tomcat\logs\catalina.out
¢ C:\Program Files\Novell\Teaming\apache-tomcat\logs\appserver.log
Linux: ¢ /opt/novell/teaming/apache-tomcat/logs/catalina.out

¢ /opt/novell/teaming/apache-tomcat/logs/appserver.log

172 Novell Vibe 4.0 Installation Guide



19.8.2

Resetting the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.

N

Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+ .

In the Search Index section, click Index.

Select Re-Index Everything.

Select each node that you want to re-index.

Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

o O~ W

A message notifies you when indexing is complete.
7 After the index server has been reset, ensure that no errors are contained in the following log

files:
Windows: ¢ C:\Program Files\Novell\Teaming\apache-tomcat\logs\catalina.out
¢ C:\Program Files\Novell\Teaming\apache-tomcat\logs\appserver.log
Linux: ¢ /opt/novell/teaming/apache-tomcat/logs/catalina.out

*

/opt/novell/teaming/apache-tomcat/logs/appserver.log

Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 3.4. Some of
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes you
have made in order to make it easier to reconstruct the definition after you reset it. This applies only
to definitions that you have modified; definitions that you have created are not affected.

To reset your Vibe definitions:

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.
6 Click OK.
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19.8.3

19.8.4

19.8.5

Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom modifications that you have previously
made to the default Vibe templates. If you have manually customized any default Vibe templates,
back up the files you have modified before performing the interface reset. This applies only to default
templates that you have modified; templates that you have created are not affected.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon * .

3 In the Management section, click Workspace and Folder Templates.

Workspace and Folder Templates
New - Reset Import Export

Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created. Blogs typically pro
larger group can make comments on the entries posted by the original author.

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Personal Workspace. Visitors ms
A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful for expanding users’ social networks.

Files - Afile folder is a place to put files. Comments or entire discussions can be posted about individual files. Additionally, the files can be automatical
user to add and delete files via any WebDAY client, such as the MS Windows File Manager.

Milestones - A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog - A micro-blog folder is a special folder that gets created automatically for each user. Itis intended to contain short text entries only. Each us
one that is created automatically will be accessed as the user's real micro-blog.

Mirrored Files - A mirrored file folder is a special type of file folderwhere it uses a server file system directory as its file storage area instead of the nom
knowledge about the folder contents in synch with whatever is in the directory. The mirrored folder feature can mirror any WebDAV or local file path.

4 Click Reset.
5 Click OK to confirm, then click Close.

Your Vibe 4 site is now ready for use.

Updating the Vibe License

After upgrading to Vibe 4, you need to update the Vibe license, as described in Chapter 7, “Updating
Your Vibe License,” on page 79.

Re-Installing the Windows Service

If you installed Vibe as a Windows service (as described in “Running Vibe as a Windows Service” on
page 73), you must remove the service and re-install it. This is necessary because the original
service references an unsupported version of Tomcat.
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19.8.6

Updating the Server.xml File When Using Secure HTTP

The server.xml Tomcat configuration file is overwritten during the upgrade to Vibe 4. If you set up
secure HTTP browser connections to the Vibe server, and if you changed the password for the
.keystore file to something other than the default changeit, you need to update the server.xml file

after upgrading to Vibe 4.

For information about how to update the .keystore password in the server.xml file, see “Changing
Your Password for the Keystore File” in the Novell Vibe 4.0 Administration Guide.
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Upgrading From Novell Vibe 3.3 to
Novell Vibe 4

This section describes how to upgrade from Novell Vibe 3.3 to Novell Vibe 4. You must upgrade to
Vibe 3.3 if you have not already, as described in Chapter 21, “Upgrading to Novell Vibe 3.3 from
Previous Versions,” on page 187. You cannot upgrade from a version prior to Vibe 3.3 to Vibe 4.

After you upgrade your Vibe system, ensure that you check the Vibe download site where you
downloaded the Vibe software for any hot patches that might be available.

¢ Section 20.1, “Understanding the Upgrade Process,” on page 177

+ Section 20.2, “Backing Up Vibe Data,” on page 177

+ Section 20.3, “Installing the Java Cryptography Extension (JCE),” on page 178
+ Section 20.4, “Remote Lucene Index Server Upgrade,” on page 178

+ Section 20.5, “Upgrading the Vibe Software,” on page 180

+ Section 20.6, “Updating the Vibe Database from 3.3 to 4,” on page 181

+ Section 20.7, “Performing Post-Upgrade Tasks,” on page 183

20.1 Understanding the Upgrade Process

During the upgrade from Novell Vibe 3.3 to Vibe 4, the following aspects of your Vibe system are
modified:

+ The software is upgraded from Vibe 3.3 to Vibe 4.
+ A backup copy of your existing Vibe 3.3 installation is created in the following directory:

Linux: /opt/novell/teaming/teaming-backup

Windows: C:\Program Files\Novell\Teaming\teaming-backup

If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell
Teaming), the backup copy is located in the following directory:

Linux: /opt/icecore

Windows: C:\Program Files\icecore

20.2 Backing Up Vibe Data

Ensure that your Vibe data is backed up before you begin the upgrade process. For information about
the data that needs to be backed up, see “Backing Up Vibe Data” in the Novell Vibe 4.0
Administration Guide.
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20.3 Installing the Java Cryptography Extension (JCE)

Vibe 4 requires that you also install the Java Cryptography Extension (JCE) in addition to the JDK on
each server in your Vibe system. (This was not a requirement in Vibe 3.4 and earlier.)

Before you begin the upgrade process, install the JCE on each server in your Vibe system, as
described in Section A.2, “Java Cryptography Extension (JCE),” on page 205.

20.4 Remote Lucene Index Server Upgrade

IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you
do not need to upgrade it separately. Skip to Section 20.5, “Upgrading the Vibe Software,” on
page 180.

You have the following options when upgrading your remote Lucene search index to Vibe 4.
+ Create a new search index

Because a full re-index is required after upgrading to Vibe 4, creating a new search index is less
time-consuming than upgrading your existing search index. The benefit to creating a new
Lucene search index is that you are able maintain the original search index in the unlikely case
of an emergency rollback.

+ Upgrade your existing Lucene search index

If you choose to upgrade your existing Lucene search index, you must perform a re-index after
the upgrade, as described in Section 19.8.1, “Resetting the Search Index,” on page 172.

These options are described in the following sections:

+ Section 20.4.1, “Creating a New Search Index,” on page 178
+ Section 20.4.2, “Upgrading an Existing Search Index,” on page 179

20.4.1 Creating a New Search Index

1 Stop Vibe.

Linux: On the Vibe server, specify the following command:
/etc/init.d/teaming stop

Windows:  See “Stopping Vibe as an Application” on page 74.

2 Stop the Lucene search index.
On the Lucene index server, specify the following command:

Linux: /etc/init.d/indexserver stop

Windows:  c¢:\Program
Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
shutdown.bat
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3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.3 system.

4 On a different server than where your original search index was running, create a new search
index, as described in Section 15.1, “Installing the Lucene Software,” on page 131.

20.4.2 Upgrading an Existing Search Index

The Vibe installation program cannot upgrade the Lucene search index when it is running on a
remote server. To upgrade your remote search index from Novell Vibe 3.3 to Novell Vibe 4, you need
to run the Remote Lucene Server installation program:

1 Stop Vibe.

Linux: On the Vibe server, specify the following command:
/etc/init.d/teaming stop

Windows:  See “Stopping Vibe as an Application” on page 74.

2 Stop the Lucene search index.
On the Lucene index server, specify the following command:

Linux: /etc/init.d/indexserver stop

Windows:  c¢:\Program
Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
shutdown.bat

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.3 system.

4 Copy the Vibe 4 Remote Lucene Server Installation program from the directory where the Vibe 4
Installation program is located to a convenient directory on the server where the remote Lucene
search index is located.

The name of the Remote Lucene Server Installation program varies by platform:

Linux: lucene-installer.linux

Windows: lucene-installer.exe

Start the Vibe 4 Remote Lucene Server installation program.
Accept the License Agreement, then click Next.

Select Update software and settings.

Click Next to continue.

© 00 N o O

Click Next to accept the installation location.

10 Click Next to accept the Java JDK location.

11 In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
12 Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see Section 10.6.2, “Changing Lucene
Configuration Settings,” on page 96.

13 Click Install to install the upgraded Lucene search index software.
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14
15

16

17

18

Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Lucene search index server, reboot the server
where it is running to ensure that the 3.3 cache is cleared.

Start the Lucene Index Server.
On the Lucene index server, specify the following command:

Linux: /etc/init.d/indexserver start

Windows:  c:\Program
Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
startup.bat

Ensure that the index server is running.
/etc/init.d/indexserver status

Now that all remote Vibe components have been upgraded, follow the instructions in
Section 20.5, “Upgrading the Vibe Software,” on page 180.

20.5 Upgrading the Vibe Software

180

N P

Ensure that you have a current backup of your Vibe 3.3 system.
Stop Vibe.

Linux: On the Vibe server, specify the following command:
/etc/init.d/teaming stop

Windows:  See “Stopping Vibe as an Application” on page 74.

Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.3 system.

Copy the installer.xml file from the directory where the Vibe 3.3 Installation program is
located to the directory where you have extracted the Vibe 4 software.

The installer.xml file provides default values when you run the Vibe 3.3 Installation program.

Obtain a new license key from the location where you downloaded the Vibe 4 software, then
place it in the same directory with the Vibe software. (The Vibe installation program does not
start without a license file in the same directory.) Rename the license to license key.xml.

Vibe 4 requires an updated license. If you use a license from a previous version, not all features
are available.

Start the Vibe 4 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are upgrading Vibe:

+ Section 5.1.2, “Running the Linux Vibe Installation Program,” on page 60
+ Section 5.2.2, “Running the Windows Vibe Installation Program,” on page 70

Accept the License Agreement, then click Next.

Novell Vibe 4.0 Installation Guide



20.6

Novell Vibe 4 Installation Program = x

Installation Options

Select the action you want to perform.

" New Installation
i+ Update software and settings
" Reconfigure settings

Because you provided your Vibe 3.3 installer.xml file in the directory with the Vibe 4
installation program, the Update software and settings installation option is selected by default.

8 Click Next to continue.

9 Click Yes to let the Installation program know that you have stopped Vibe.

10

11

12

13
14
15

16

Select the check box to let the installation program know that you have backed up all of your
data, then click Next.

Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then
click Next.

For more information about the differences between basic and advanced installations, see
Section 4.1, “What Is a Basic Vibe Installation?,” on page 39 and Section 10.1, “What Is an
Advanced Installation?,” on page 91.

Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 4 system.

Click Install when you are ready to perform the upgrade.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the
3.3 cache is cleared.

Continue with Section 20.6, “Updating the Vibe Database from 3.3 to 4,” on page 181.

Updating the Vibe Database from 3.3 to 4

Upgrade the Vibe software (as described in Section 20.5, “Upgrading the Vibe Software,” on
page 180) before upgrading the Vibe database.

When you upgrade to Vibe 4, the Vibe Installation program does not update the database as part of
the Vibe software upgrade. Therefore, you must manually update the database before you can start
Vibe:

1

(Conditional) When upgrading a MySQL database, ensure that the Vibe database character set
for the Vibe 3.4 system is in UTF-8 format.

la To view the character set format, run the following command:

In the following command, sitescape is the name of the Vibe database. Replace
sitescape with the name of your database.

SELECT default character set name FROM information schema.SCHEMATA S WHERE
schema name = 'sitescape';

1b If the character set format is anything other than UTF-8, run the following command to
change it:
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ALTER DATABASE sitescape CHARACTER SET utfs;

In this command sitescape is the name of the Vibe database. Replace sitescape with the
name of your database.

2 Change to the db directory in the Vibe installation:

cd /vibe installation/temp-installer/db
This directory contains the following properties files:
¢ mysqgl-liquibase.properties
¢ Oracle-liquibase.properties
¢ sqglserver-liquibase.properties

In a text editor, open the properties file that corresponds with your database type to make any of
the following changes. Save and close the text editor when you are finished making changes.

+ Change the database user name and password for accessing the database.
+ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace 1localhost with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database is
sitescape, the name of the company that previously developed the Vibe software).

Save your changes and close the properties file.

5 In the same directory (/vibe installation/temp-installer/db), execute the following

commands to update the database schema:

Windows manage-database.bat databaseType mark33DatabaseAsUpdated
manage-database.bat databaseType updateDatabase

Possible database types (databaseType) are mysql, oracle, or sglserver, depending
on your type of database.

Linux ./manage-database.sh databaseType mark33DatabaseAsUpdated
./manage-database.sh databaseType updateDatabase

Possible database types (databaseType) are mysql, oracle, or sglserver, depending
on your type of database.

NOTE: Ensure that the manage-database. sh file is executable.

NOTE: You can safely ignore the following Liquibase log messages:

¢ Warning: modifyDataType will lose primary key/autoincrement/not null
settings for mysqgl

+ Any messages that contain the words info: failure Of info: failed, as long as they
are associated with a type INFO message

Start Vibe 4 in the same way that you have been starting Vibe 3.3.

When you start Vibe for the first time after the upgrade, it takes longer to start than usual
because data in the Vibe database must be upgraded before the Vibe site is ready to use.
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20.7

Linux: On the Vibe server, specify the following command:

/etc/init.d/teaming start

Windows:  See “Starting Vibe as an Application” on page 74.

or
See “Starting Vibe as a Windows Service” on page 73.

NOTE: If you have been starting Vibe as a Windows service, you need to delete your
existing Windows service configuration and re-configure Vibe as a Windows service before
you can start Vibe. For information about how to configure Vibe as a Windows service, see
“Configuring Vibe as a Windows Service” on page 73.

7 (Recommended) For security reasons, delete the password that you specified in Step 7 in
“Creating the Vibe Database” on page 63.

7a

7b

7c

Change to the db directory in the Vibe installation:
cd /vibe installation/temp-installer/db
This directory contains the following properties files:

¢ mysqgl-liquibase.properties

¢ Oracle-liquibase.properties

¢ sqglserver-liquibase.properties

In a text editor, open the database type-liquibase.properties file that corresponds
with your database type, then delete the password.

Save and close the properties file.

8 Continue with Section 20.7, “Performing Post-Upgrade Tasks,” on page 183.

Performing Post-Upgrade Tasks

After you start Novell Vibe 4, you can access your Vibe site as usual. However, you need to reset
some aspects of the interface before you allow users to access the upgraded site. The interface reset
affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

+ Section 20.7.1, “Resetting the Search Index,” on page 184

¢ Section 20.7.2, “Resetting Your Definitions,” on page 184

+ Section 20.7.3, “Resetting the Standard Templates,” on page 185

+ Section 20.7.4, “Updating the Vibe License,” on page 186

¢ Section 20.7.5, “Re-Installing the Windows Service,” on page 186

+ Section 20.7.6, “Updating the Server.xml File When Using Secure HTTP,” on page 186
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20.7.1

20.7.2

Resetting the Search Index

In order for an upgraded search index to be compatible with Vibe 4, you need to re-index the search
index.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers. For more information about multiple search indexes, see Chapter 17, “Running Multiple
Lucene Index Servers,” on page 143.

Depending on the size of your Vibe site, this can be a very time-consuming process.

+ “Resetting a Single Search Index” on page 184
+ “Resetting the Search Index with Multiple Index Servers” on page 184

Resetting a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

3 In the Management section, click Search Index.

4 Select Re-Index Everything.

5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.

Resetting the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.

N

Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,

In the Search Index section, click Index.

Select Re-Index Everything.

Select each node that you want to re-index.

Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

o O~ W

A message notifies you when indexing is complete.

Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 3.3. Some of
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the
enhancements, as described in this section.
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20.7.3

WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes you
have made in order to make it easier to reconstruct the definition after you reset it. This applies only
to definitions that you have modified; definitions that you have created are not affected.

To reset your Vibe definitions:

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .
In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.
6 Click OK.

Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom modifications that you have previously
made to the default Vibe templates. If you have manually customized any default Vibe templates,
back up the files you have modified before performing the interface reset. This applies only to default
templates that you have modified; templates that you have created are not affected.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon * .
3 In the Management section, click Workspace and Folder Templates.

Workspace and Folder Templates
Mew - Reset Import Export

Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created. Blogs typically pro
larger group can make comments on the entries posted by the original author.

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Personal Workspace. Visitors ms
A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful for expanding users' social networks.

Files - Afile folder is a place to put files. Comments or entire discussions can be posted about individual files. Additionally, the files can be automatical
user to add and delete files via any WebDAY client, such as the MS Windows File Manager.

Milestones - A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog - A micro-blog folder is a special folder that gets created automatically for each user. Itis intended to contain short text entries only. Each us
one that is created automatically will be accessed as the user's real micro-blog.

Mirrored Files - A mirrored file folder is a special type of file folderwhere it uses a server file system directory as its file storage area instead of the nom
knowledge about the folder contents in synch with whatever is in the directory. The mirrored folder feature can mirror any WebDAV or local file path.

4 Click Reset.
5 Click OK to confirm, then click Close.
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20.7.4

20.7.5

20.7.6

Your Vibe 4 site is now ready for use.

Updating the Vibe License

After upgrading to Vibe 4, you need to update the Vibe license, as described in Chapter 7, “Updating
Your Vibe License,” on page 79.

Re-Installing the Windows Service

If you installed Vibe as a Windows service (as described in “Running Vibe as a Windows Service” on
page 73), you must remove the service and re-install it. This is necessary because the original
service references an unsupported version of Tomcat.

Updating the Server.xml File When Using Secure HTTP

The server.xml Tomcat configuration file is overwritten during the upgrade to Vibe 4. If you set up
secure HTTP browser connections to the Vibe server, and if you changed the password for the
.keystore file to something other than the default changeit, you need to update the server.xml file
after upgrading to Vibe 4.

For information about how to update the .keystore password in the server.xml file, see “Changing
Your Password for the Keystore File” in the Novell Vibe 4.0 Administration Guide.
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2 Upgrading to Novell Vibe 3.3 from
Previous Versions

For information about how to upgrade to Vibe 3.3, see “Update” (https://www.novell.com/
documentation/vibe33/vibe33_inst/data/bjOkxa6.html) in the Novell Vibe 3.3 Installation Guide (https:/
/www.novell.com/documentation/vibe33/vibe33_inst/data/bookinfo.html).
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Updating the Operating System Where
Vibe Is Running

You can update the operating system where Vibe is running.

1 Update the Linux or Windows operating system to a version that Vibe supports.

For information about which versions are supported, see Section 2.1, “Vibe Server
Requirements,” on page 17.

For information about how to update the operating system, view the appropriate documentation
for your operating system.

2 (Conditional) If you updated a Linux server, the TrueType font path that Vibe uses for document
conversion might be broken after the update. To fix this problem, you need to re-run the Vibe
installation after upgrading the Linux operating system.

For information on how to run the Vibe installation, see Section 5.1, “Linux: Installing and Setting
Up a Basic Vibe Site,” on page 59 for a basic installation, or Chapter 11, “Performing an
Advanced Vibe Installation,” on page 115 for an advanced installation.

Updating the Operating System Where Vibe Is Running 189



190 Novell Vibe 4.0 Installation Guide



I Migrate

+ Chapter 23, “Migrating Existing Novell Vibe 4 Data into a New Vibe 4 System,” on page 193
+ Chapter 24, “Migrating from SiteScape Forum or Other Collaboration Software,” on page 199
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Migrating Existing Novell Vibe 4 Data
Into a New Vibe 4 System

IMPORTANT: The term “data migration” as used in this section, is essentially about creating a clone
of an existing Vibe system.

Data migration between servers running different versions of Vibe is not supported. However, you can
use data migration in conjunction with an upgrade (see Section 23.1, “Using Data Migration in
Conjunction with an Upgrade to Vibe 4,” on page 194).

This section describes how to migrate data from an existing Vibe 4 server to a new Vibe 4 server. You
might want to do this for any of the following reasons:

+ Your existing Vibe system has outgrown the server where you originally set it up.

+ You want to move your existing Vibe system to a different operating system.

In this case, you can install Vibe 4 on a new server, then migrate your existing Vibe 4 data to
your new Vibe 4 system.

+ You want to preserve your old system in its current state.

+ You created your Vibe system by using the Virtual Eval version of the Novell Vibe Starter Pack
(http://download.novell.com/Download?buildid=Y7J2HFucjfw~).

+ You are upgrading from Kablink Vibe to Novell Vibe.

NOTE: In the instructions that follow, “target server” refers to the server where you install the Vibe 4
software, and “source server” refers to the existing server from which you are migrating Vibe data.

The instructions in this section are based on a single-server Vibe configuration. If you have a multi-
server Vibe configuration, the single-server instructions can serve as a foundation to get you started
with your more complex migration process.

This section does not include instructions for migrating an Oracle database. Use the instructions for
your Vibe platform as a guideline for the tasks that are involved in migrating Vibe data, then apply
these guidelines to your Oracle database migration.

+ Section 23.1, “Using Data Migration in Conjunction with an Upgrade to Vibe 4,” on page 194
¢ Section 23.2, “Linux Migration with a MySQL Database,” on page 194
+ Section 23.3, “Windows Migration with an MS SQL Database,” on page 196
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23.1 Using Data Migration in Conjunction with an
Upgrade to Vibe 4

As stated above, data migration between servers running different versions of Vibe is not supported.
If you want to migrate data from Vibe 3.4 to a new Vibe 4 system, you have two basic choices:

+ You can
1. Upgrade the Vibe 3.4 server to Vibe 4.
2. Install a new Vibe 4 server
3. Migrate the data from the old Vibe 4 server to the new Vibe 4 system.

Or
+ You can
1. Install Vibe 3.4 on the new server.
2. Migrate the data from the existing Vibe 3.4 server to the new Vibe 3.4 server

3. When you are assured that everything is running as expected, upgrade the new server to
Vibe 4.

23.2 Linux Migration with a MySQL Database

+ Section 23.2.1, “Preparing the Target Linux Server,” on page 194
+ Section 23.2.2, “Preparing the Source Linux Server,” on page 195

*

Section 23.2.3, “Transferring Data from the Source Server to the Target Server,” on page 195

*

Section 23.2.4, “Importing the Vibe Database to the Target Server,” on page 195

*

Section 23.2.5, “Finalizing Your New Vibe 4 Site,” on page 196

23.2.1 Preparing the Target Linux Server

On the target server:
1 Install the Vibe 4 software on the target server, as described in Part Il, “Basic Installation,” on
page 37, paying special attention to these important details:

+ Set up the same Linux user to run the Vibe software that has been used to run the Vibe
software in the source Vibe server.

+ Select the same encryption algorithm for the Vibe database that was used for the source
Vibe server.

IMPORTANT: If the database encryption algorithms do not match between the source and
target Vibe systems, you cannot log in to the new Vibe 4 site.

2 Start Vibe on the target server.
3 Verify that the new Vibe site is working as expected.
4 Stop Vibe on the target server.

5 Rename the teaming directory to teaming backup. In a future step, you will copy the teaming
directory from the source server to the target server.

The location of the teaming directory varies by platform:

194 Novell Vibe 4.0 Installation Guide



Linux: /var/opt/novell/teaming

Windows: c:\novell\teaming

6 Continue with Section 23.2.2, “Preparing the Source Linux Server,” on page 195.

23.2.2 Preparing the Source Linux Server

On the source server:

1 Stop Vibe.
2 Back up your existing database:

mysgldump -uusername -ppassword sitescape > sitescape.sgl

This creates a file named sitescape.sql in the directory where you executed the mysgldump
command.
3 Ensure that you have a recent backup of your entire Vibe system.

i

4 Continue with Section 23.2.3, “Transferring Data from the Source Server to the Target Server,’
on page 195.

23.2.3 Transferring Data from the Source Server to the Target
Server

On the source server:
1 Mount the target server to the source server so that data can be copied from one server to the
other.
2 In a terminal window on the source server, become the Linux user that runs the Vibe software.

3 Copy the database backup of your existing Vibe database (sitescape.sql file) that you created
in Step 2 in Section 23.2.2, “Preparing the Source Linux Server,” on page 195 to a convenient
temporary location on the target server.

4 Copy the entire data area from /var/opt/novell/teaming on the source server to the same
location on the target server.

5 (Conditional) If you are using secure LDAP (LDAPS), you need to copy the cacerts file to the
same location on the target server.

6 Continue with Section 23.2.4, “Importing the Vibe Database to the Target Server,” on page 195.

23.24 Importing the Vibe Database to the Target Server

On the target server:
1 Remove the empty Vibe database that was created when you installed the Vibe 4 software:

mysgl>drop database sitescape;

2 Change to the directory where you copied the sitescape.sql file in Step 3 in Section 23.2.3,
“Transferring Data from the Source Server to the Target Server,” on page 195.

3 Create an empty database called sitescape:

mysqgl -uusername -ppassword -e "create database sitescape"
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4 Manually re-create the Vibe database with the data that you copied from the source server:

mysqgl -uusername -ppassword sitescape < sitescape.sqgl

23.2.5 Finalizing Your New Vibe 4 Site

1 Start Vibe 4, as described in “Starting Vibe on Linux” on page 67.

2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in the
Novell Vibe 4.0 Administration Guide.

Your Vibe site should now function just as it did on the original source server.

23.3  Windows Migration with an MS SQL Database

+ Section 23.3.1, “Preparing the Target Windows Server,” on page 196

+ Section 23.3.2, “Preparing the Source Windows Server,” on page 196

+ Section 23.3.3, “Transferring Data from the Source Server to the Target Server,” on page 197
¢ Section 23.3.4, “Importing the Database to the Target Server,” on page 197

¢ Section 23.3.5, “Finalizing Your New Vibe 4 Site,” on page 198

23.3.1 Preparing the Target Windows Server

On the target server:

1 Install the Vibe 4 software, as described in Part I, “Basic Installation,” on page 37.

IMPORTANT: Select the same encryption algorithm for the Vibe 4 database that you selected
for the source Vibe server. If the database encryption algorithms do not match between the
source and target systems, you cannot log in to the new Vibe 4 site.

Start Vibe on the target server.
Verify that the new Vibe site is working as expected.
Stop Vibe on the target server.

a A W N

Rename the teaming directory to teaming backup. In a future step you will copy the teaming
directory from the source server to the target server.

The location of the teaming directory varies by platform:

Linux: /var/opt/novell/teaming

Windows: c:\Program Files\Novell\Teaming

6 Continue with Section 23.3.2, “Preparing the Source Windows Server,” on page 196.

23.3.2 Preparing the Source Windows Server

On the source server:

1 Stop Vibe.
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2 Back up your existing database:

2a In Microsoft SQL Server Management Studio, browse to and right-click the existing
database (named sitescape), then click Tasks > Back Up.

2b For Backup type, select Full.
2c Set other backup options as desired, then click OK.
This creates a file named sitescape.bak in the following directory:

c:\Program Files\Microsoft SQL Server\MSSQL\Backup

3 Ensure that you have a recent backup of your entire system.

4 Continue with Section 23.3.3, “Transferring Data from the Source Server to the Target Server,”
on page 197.

23.3.3 Transferring Data from the Source Server to the Target
Server

On the source server:

1 Map a drive from the target server to the source server so that data can be copied from one
server to the other.

2 Copy your existing software extensions to the target server:

From: c¢:\home\icecoredata\extensions

To: c:\novell\teaming\extensions

Beginning with Vibe 3, the extensions directory now contains kablink and liferay.com
directories.

3 Delete the empty kablink directory.
4 Delete or rename the following directories to make room for the corresponding directories that
you are copying from the source server:

c:\novell\teaming
c:\novell\teaming\lucene
c:\novell\teaming\extensions

5 Copy the entire data area from c: \novell\teaming on the source server to the same location
on the target server.

6 (Conditional) If you are using secure LDAP (LDAPS), you need to copy the cacerts file to the
same location on the target server.

7 Continue with Section 23.3.4, “Importing the Database to the Target Server,” on page 197.

23.3.4 Importing the Database to the Target Server

On the target server:

1 In Microsoft SQL Server Management Studio, browse to and right-click the existing Vibe
database (named sitescape) that was created when you installed the Vibe 4 software, then
click Delete.

2 To import the data from your source database, browse to and right-click Databases, then click
Tasks > Restore.
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3 In the To database field, specify sitescape.

4 In the From device field, browse to and select the sitescape.bak file that you transferred to the
target server.

5 Set other restore options as desired, then click OK.
This creates the sitescape database in the following directory on the target server:
c¢:\Program Files\Microsoft SQL Server\MSSQL

Backed-up data from the source database is imported into the database for your new Vibe 4
system.

23.35 Finalizing Your New Vibe 4 Site

1 Start Vibe 4, as described in “Starting Vibe on Linux” on page 67.

2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in the
Novell Vibe 4.0 Administration Guide.

Your Vibe site should now function just as it did on the original source server.
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2 Migrating from SiteScape Forum or
Other Collaboration Software

Moving legacy corporate data into a new collaboration system can look like a long, challenging
process. To make the job easier, see the Novell Teaming Migration Services Flyer. (http://
www.novell.com/docrep/2009/04/Novell_Teaming_Migration_Flyer_en.pdf)
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Vibe System Requirements
Assistance

The system requirements for Novell Vibe include supporting components that might or might not
already be installed on your Vibe server. This section helps you meet the Vibe system requirements if
you are not familiar with how to install these supporting components.

+ Section A.1, “Java Development Kit (JDK),” on page 203

+ Section A.2, “Java Cryptography Extension (JCE),” on page 205

+ Section A.3, “MySQL Database Server,” on page 206

A.1 Java Development Kit (JDK)

The Novell Vibe software runs inside a Java Virtual Machine (JVM). At present, Vibe requires a Java
Development Kit (JDK), not a Java Runtime Environment (JRE), in order to run properly. You can use
either the Oracle JDK or the IBM JDK. Follow the instructions in the section below for your operating
system and JDK preference:

If you want to use an SSL connection between your Novell Vibe site and a WebDAV server, and if the
WebDAV server has a self-signed certificate rather than a certificate provided by a certificate
authority, you must use the Oracle JDK. The existing Vibe functionality for handling self-signed
certificates is not compatible with the way the IBM JDK handles self-signed certificates.

¢ Section A.1.1, “Oracle JDK on Linux,” on page 203

+ Section A.1.2, “IBM JDK on Linux,” on page 204

+ Section A.1.3, “Oracle JDK on Windows,” on page 204

A.1.1 Oracle JDK on Linux

This section describes how to install the Java Development Kit (JDK) for 64-bit Linux, using the
following archive binary file: jdk-version-linux-x64.tar.gz.
1 Go to the following URL:
Java SE Downloads (http://www.oracle.com/technetwork/java/javase/downloads/index.html)

2 Download the jdk-version-linux-x64.tar.gz file to the /usr/java directory on your Linux
server.

3 Accept the License Agreement.

4 As the root user, change to the /usr/java directory where you downloaded the file, then use
the following command to ensure that the download arrived safely:

1s -1
You should see a file named jdk-version-linux-x64.tar.gz.

5 Extract the file:

tar -xvf jdk-version-linux-x64.tar.gz
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A.l1.2

The Oracle JDK is how installed on your Linux server.

(Conditional) You might need to remove a symbolic link and create a new one:
rm /usr/java/latest

ln -s /usr/java/jdkversion /usr/java/latest

Run the following two commands:

chmod -R 755 /usr/java/jdkversion

chown -R root:root /usr/java/jdkversion

Install the JCE, as described in Section A.2, “Java Cryptography Extension (JCE),” on page 205.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you
plan to install the JDK. The Vibe installation program prompts you for this location.

IBM JDK on Linux

The IBM JDK is available with SUSE Linux Enterprise Server (SLES). You can install it by using
YaST.

1
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Enable the SDK online repositories.

For information about how to enable the SDK repositories on SLES, see TID 7015337 (https://
www.novell.com/support/kb/doc.php?id=7015337) in the Novell Support Knowledgebase (https:/
/www.novell.com/support/kb/).

In YaST, click Software > Software Management.
In the Search field, type java, then click Search.
Select Java version SDK, Standard Edition (java-version-ibm-devel), then click Accept.

Click Continue to accept the suggested dependencies, then click No (because you don’t need
any more packages).

Exit YaST.

This creates a directory named /usr/lib/jvm/java-version-ibm-version sr3 with the IBM
JDK software in it.

Install the JCE, as described in Section A.2, “Java Cryptography Extension (JCE),” on page 205.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you
plan to install the JDK. The Vibe installation program prompts you for this location.

A.1.3 Oracle JDK on Windows

204

1

Go to the following URL:
Java SE Downloads (http://www.oracle.com/technetwork/java/javase/downloads/index.html)

Download the latest Java SE version that is appropriate for your operating system.

3 Accept the license agreement.

Click the jdk-version-windows-version.exe file in the Download column, then save the file to
an empty temporary directory on your Windows server.
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5 Change to that temporary directory, then run the downloaded executable.

This creates a directory named c:\Program Files\Java\jdkversion with the Oracle JDK
software in it.

The Oracle JDK is now installed on your Windows server.
6 Install the JCE, as described in Section A.2, “Java Cryptography Extension (JCE),” on page 205.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you
plan to install the JDK. The Vibe installation program prompts you for this location.

A.2 Java Cryptography Extension (JCE)

You must install the Java Cryptography Extension (JCE) in addition to the JDK.

A.2.1 Oracle JCE on Linux and Windows

1 On your management workstation, download the Java Cryptography Extension (JCE) Unlimited
Strength Jurisdiction Policy files (http://www.oracle.com/technetwork/java/javase/downloads/
jce8-download-2133166.html) from Oracle.

2 Follow the instructions from the Readme that is downloaded with the Oracle JCE.

A.2.2 IBMJCE on Linux

To install the JCE on Linux:
1 On the Vibe server, verify that the following files exist:

/etc/alternatives/jce version ibm local policy
/etc/alternatives/jce version ibm us_export policy

2 On your management workstation, download the Java Cryptography Extension (JCE) Unlimited
Strength Jurisdiction Policy files (https://www14.software.ibm.com/webapp/iwm/web/reg/
pick.do?source=jcesdk&lang=en_US) from IBM.

3 Log in to the Vibe server as the root user (or equivalent), then create the following directory:
mkdir -p /usr/libé4/jvm-private/java-version-ibm/jce/unrestricted

4 Copy the JCE Unlimited Strength Jurisdiction Policy z1p file to the folder on the Vibe server that
you created in Step 3.

cp ~/Downloads/unrestrictedpolicyfiles.zip /usr/libé4/jvm-private/java-
version-ibm/jce/urestricted

5 Unzip the files:

unzip /usr/libé4/jvm-private/java-version-ibm/jce/unrestricted/
urestrictedpolicyfiles.zip

6 Stop Vibe.
/etc/init.d/teaming stop
7 Remove the existing links:
rm /etc/alternatives/jce version ibm local policy

rm /etc/alternatives/jce version ibm us_export policy
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8 Create a new link to the JCE that you downloaded:

In -s /usr/lib64/jvm-private/java-version-ibm/jce/unrestricted/
local policy.jar /etc/alternatives/jce version ibm local policy

In -s /usr/lib64/jvm-private/java-version-ibm/jce/unrestricted/
US_export policy.jar /etc/alternatives/jce version ibm us export policy

9 Verify that the links were created:
ls -1 /etc/alternatives/jce*
10 Start Vibe.
/etc/init.d/teaming start
tailf /opt/novell/teaming/apache-tomcat/logs/catalina.out

tailf /opt/novell/teaming/apache-tomcat/logs/appserver.log

A.3 MySQL Database Server

+ Section A.3.1, “MySQL on Linux,” on page 206
+ Section A.3.2, “MySQL on Windows,” on page 208

A.3.1 MySQL on Linux

IMPORTANT: The steps in this section are optimized for SUSE Linux Enterprise Server (SLES) 11.
For information regarding other version of SLES or other flavors of Linux, see Installing and
Upgrading MySQL (http://dev.mysgl.com/doc/refman/5.1/en/installing.html) in the MySQL
documentation (http://dev.mysqgl.com/doc/).

Depending on the options you select when installing Open Enterprise Server 2 and SUSE Linux
Enterprise Server (SLES), the MySQL database server might be installed along with the operating
system. Check for the following directory:

/usr/bin/mysqgl

If the /usr/bin/mysql directory does not exist, you need to install the MySQL database server. If
MySQL is already installed, you still need to configure it for use with Vibe.

+ ‘“Installing MySQL” on page 206
+ “Configuring MySQL” on page 207
+ “Learning More about MySQL" on page 207

Installing MySQL

Ensure you have access to your operating system installation media.
In YaST, click Software > Software Management.

In the Search field, type mysql, then click Search.

1

2

3

4 Select mysq|, then click Accept.

5 Click Continue to resolve dependencies.
6

Click Continue to acknowledge package support status.
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MySQL is then installed from the SLES media.
7 Continue with “Configuring MySQL” on page 207.

Configuring MySQL

When MySQL is initially installed, it is not configured with an administrator password, nor is it

configured to start automatically. Follow the steps below to set up the MySQL database server for use

with Vibe:

1 In YaST, click System > System Services.

2 Scroll to and select the MySQL service, then click Enable.

3 Click Continue to install dependencies, then click OK to close the status box.

4 Click OK > Yes to finish the installation, then exit YaST.

5 In a terminal window, become the root user.

6 To verify that the MySQL database server has started, use the following command:

ps -eaf | grep mysql
You should see MySQL processes running.

7 Set the administrator password for the MySQL database server:

mysgladmin -u root password new password

This command changes the password for the MySQL root user, which is the default

administrator user name for the MySQL database server. This command is part of the MySQL

client package.

IMPORTANT: The MySQL root user hame is not the same as the Linux root user. The Linux

root user has a password established for it when you install Linux. In a parallel fashion, the

MySQL root user needs to have a password established for it when you install MySQL.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the MySQL
administrator password. The Vibe installation program prompts you for this information.

Learning More about MySQL

The following table includes some basic and useful MySQL commands:

Action Command
Stop MySQL /etc/initd/mysqgl stop
Start MySQL /etc/initd/mysql start

Show MySQL status  mysgladmin -u root -p extended-status

If you want to administer MySQL through a GUI interface, you can download tools from:
MySQL GUI Tools Downloads (http://dev.mysgl.com/downloads/gui-tools/5.0.html)

For more information about MySQL, see:
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MySQL Documentation (http://dev.mysql.com/doc)

A.3.2 MySQL on Windows

208

1
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10

11

12

In your web browser, go to the following URL:
MySQL 5.1 Downloads (http://dev.mysgl.com/downloads/mysql/5.1.html)

Scroll down if necessary, then click the type of Windows operating system you are using (32-bit
or 64-bit).

On the Windows Essentials line, click Download.

Click Save File, browse to and select a convenient temporary directory, then click Save.
In Windows Explorer, browse to the directory where you saved the MySQL . exe file.
Double-click the MySQL . exe file to start the MySQL Setup Wizard.

Follow the online instructions to install the MySQL software on the Windows server, then
continue with Step 8 to configure the server.

Unless you are already familiar with configuring MySQL on a Windows server, select Standard
Configuration, then click Next.

Select Include Bin Directory in Windows PATH, then click Next.
Set the MySQL root user password, then click Next.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the MySQL
administrator password. The Vibe installation program prompts you for this information.

Click Execute to configure the MySQL database server, then click Finish.
Some messages report the status of your MySQL installation.

To monitor the MySQL database server, click Start > All Programs, then click MySQL > MySQL
Server 5.1 > MySQL Command Line Client.
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Memcached Caching with Novell
Vibe

Novell Vibe contains two caching options for the hibernate caching provider: ehcache and
memcached. For more information about ehcache, see Ehcache (http://ehcache.sourceforge.net).
¢ Section B.1, “About Memcached,” on page 209
+ Section B.2, “Downloading and Installing Memcached,” on page 209
+ Section B.3, “Configuring Memcached,” on page 210
+ Section B.4, “Configuring Memcached in the Vibe Installation Program,” on page 211

+ Section B.5, “Memcached Logging,” on page 211

B.1 About Memcached

Memcached is a high-performance, distributed memory object caching system used by a number of
large Internet sites such as Wikipedia, Flickr, Twitter, and Youtube, as well as enterprise systems.

¢ Section B.1.1, “Advantages for Using Memcached,” on page 209

+ Section B.1.2, “Hardware Requirements and Configurations,” on page 209

B.1.1 Advantages for Using Memcached

Memcached offers the following advantages over other caching systems:

+ Better utilization of memory resources from the server farm.

+ No replication (and therefore no overhead involved in replication). This results in a reduction of
60 or more threads per Vibe node in a two-node cluster.

+ The number of servers and the size of data scale together.

+ Scales out much better than replication-based cluster cache.

B.1.2 Hardware Requirements and Configurations

Novell Vibe supports memcached only on the SUSE Linux operating system. For detailed hardware
requirements and layouts, see Memcached Hardware Requirements and Layouts (http://
code.google.com/p/memcached/wiki/NewHardware).

B.2 Downloading and Installing Memcached

NOTE: You should run memcached only on a SUSE Linux operating system. 64-bit is recommended.

Memcached is included with the SUSE Linux Enterprise High Availability Extension. You simply need
to install it on the server where the Lucene search index is running as you would any other Linux
package.
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B.3

If you do not have the SUSE Linux Enterprise High Availability Extension, you can download and
install memcached by completing the following steps on the Lucene search index server:

o 00~ W N P

Navigate to the openSUSE Software Download page (http://software.opensuse.org).
In the Search field, type memcached, then click Search.

Download the rpM file after it is returned in the search results.

Install the downloaded rpM file.

Repeat Step 1 through Step 4 on the Lucene search index server.

Continue with Section B.3, “Configuring Memcached,” on page 210.

Configuring Memcached

After you have downloaded and installed memcached on the server where the Lucene search index
is running, as described in Section B.2, “Downloading and Installing Memcached,” on page 209, you
need to configure it on each node.

You configure memcached by adding the desired switches to the MEMCACHED PARAMS variable.

1
2
3

Navigate to the etc/sysconfig directory.
Open the memcached file in a text editor.

Uncomment the MEMCACHED PARAMS variable and add any switches that you feel are appropriate.
When you uncomment the MEMCACHED PARAMS variable, the following switches are already
present:

+ -d: Runs as a daemon. This is recommended.

+ -I: Determines the interface to listen on. The default value is the localhost. You should either
delete this switch with its default address (this is recommended for a simple setup) or
change the default address to the address that you want memcached to listen on. For
example, -1 172.17.2.3.

To see a complete list of switches that are available with memcached, type memcached -h from
the command line of a machine where memcached is installed.

(Recommended) Increase the maximum memory to use for items to 1024 MB. You do this by
adding the -m switch to the MEMCACHED PARAMS variable. For example:

-m 1024

(Recommended) You should configure memcached to start automatically each time you reboot
the server where the Lucene search index is running. To configure memcached to start
automatically, enter the following command from the command line:

chkconfig --add memcached

To verify that automatic startup is enabled, enter the following command from the command line:

chkconfig memcached

Validate that memcached is running from the local server by typing the following command:

netstat -ap|grep memcached

After you have verified that memcached is running on the local server, log in to a remote server,
then validate that memcached is running to ensure that no networking problems exist:

7a From the command line of a remote server, make a network connection to the server where
memcached is running. For example, you can use the telnet command.
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B.4

B.5

telnet 172.17.2.3 11211

7b Type a simple memcached command, such as stats and stats settings.
7c After you have verified that memcached is running as expected, type quit to exit telnet.
Following is an example of what you see:

07309:~/Desktop # telnet xxx.xXxx.xxxX.xx 11211
Trying XxXX.XXX.XXX.XX. ..
Connected to XxXX.XXX.XXX.XX.
Escape character is '"]'.
stats

STAT pid 2486

STAT uptime 313

STAT time 1334337169

STAT version 1.2.6

STAT pointer size 64

STAT rusage user 0.028001
STAT rusage_system 0.000000
STAT curr_items 10

STAT total items 17

STAT bytes 7971

STAT curr_ connections 4

STAT total connections 6
STAT connection structures 5
STAT cmd_get 79

STAT cmd_set 17

STAT get_hits 62

STAT get misses 17

STAT evictions 0

STAT bytes_read 14249

STAT bytes written 67674
STAT limit_maxbytes 67108864
STAT threads 1

END

quit

Connection closed by foreign host.
07309:~/Desktop #

8 Continue with Section B.4, “Configuring Memcached in the Vibe Installation Program,” on
page 211.

Configuring Memcached in the Vibe Installation
Program

After you have installed and configured memcached, you need to configure the Vibe installation
program to use memcached as the hibernate caching provider. For more information, see
Section 5.1.2, “Running the Linux Vibe Installation Program,” on page 60.

Memcached Logging

To trace activities on the Vibe server that are related to memcached:

1 Navigate to the following directory: /opt /novell/teaming/apache-tomcat/webapps/ssf/
WEB-INF
2 Openthe log4j.properties file in a text editor.

3 Uncomment the following lines in the 1og4j .properties file:
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# Tracing of memcached

#log4j
#log4j
#log4j
#log4j
#log4j

.category.
.category.
.category.
.category.
.category.

net.
net.
com.

com

spy . memcached=DEBUG
rubyeye .xmemcached=DEBUG
googlecode.hibernate.memcached=DEBUG

.novell.teaming.memcached=DEBUG
com.

novell.teaming.hibernate.memcached=DEBUG

4 Save and close the 1log47 .properties file.

5 Restart the Vibe server.
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C Third-Party Materials

C.1

¢ Section C.1, “ANTLR 3 License,” on page 213

¢ Section C.2, “Colt License Agreement,” on page 214

+ Section C.3, “Domd4j License,” on page 214

+ Section C.4, “iCal4j License,” on page 215

+ Section C.5, “ICU4J license (ICU4J 1.3.1 and later),” on page 215
+ Section C.6, “JAXEN License,” on page 216

+ Section C.7, “Jung,” on page 216

+ Section C.8, “ASM,” on page 217

+ Section C.9, “Firebug Lite,” on page 218

ANTLR 3 License

Copyright (c) 2003-2008, Terence Parr
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the author nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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C.3

Colt License Agreement

Packages cern.colt*, cern.jet*, cern.clhep
Copyright (c) 1999 CERN - European Organization for Nuclear Research.

Permission to use, copy, modify, distribute and sell this software and its documentation for any
purpose is hereby granted without fee, provided that the above copyright notice appear in all
copies and that both that copyright notice and this permission notice appear in supporting
documentation. CERN makes no representations about the suitability of this software for any
purpose. It is provided “as is” without expressed or implied warranty.

Packages hep.aida.*

Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or
redistribute this work is granted under the terms of the LGPL License, with the exception that any
usage related to military applications is expressly forbidden. The software and documentation
made available under the terms of this license are provided with no warranty.

Dom4j License

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation (“Software”), with or without
modification, are permitted provided that the following conditions are met:

1. 1.Redistributions of source code must retain copyright statements and notices. Redistributions
must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. The name “DOM4J” must not be used to endorse or promote products derived from this
Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact dom4j-info@metastuff.com.

4. The name “DOM4J” must not be used to endorse or promote products derived from this
Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact dom4j-info@metastuff.com.

5. Products derived from this Software may not be called “DOM4J” nor may “DOMA4J” appear in
their names without prior written permission of MetaStuff, Ltd. DOMA4J is a registered trademark
of MetaStuff, Ltd.

6. Due credit should be given to the DOM4J Project (http://www.dom4j.org).

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “AS IS™ AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.
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C.5

ICal4j License

Copyright (c) 2008, Ben Fortuna
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of Ben Fortuna nor the names of any other contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 1IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

ICU4J license (ICU4J 1.3.1 and later)

COPYRIGHT AND PERMISSION NOTICE
Copyright (c) 1995-2001 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, provided that the above
copyright notice(s) and this permission notice appear in all copies of the Software and that both the
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS.
IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE
LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR
ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.
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Except as contained in this notice, the name of a copyright holder shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

JAXEN License

Copyright (C) 2000-2002 Bob McWhirter & James Strachan.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
and the disclaimer that follows these conditions in the documentation and/or other materials
provided with the distribution.

3. The name “Jaxen” must not be used to endorse or promote products derived from this software
without prior written permission. For written permission, please contact license@jaxen.org.

4. Products derived from this software may not be called “Jaxen,” nor may “Jaxen” appear in their
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation provided
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:

“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
WWW.jaxen.org.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE Jaxen
AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Jaxen
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://
www.jaxen.org.

Jung

THE JUNG LICENSE
Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project

All rights reserved.

216 Novell Vibe 4.0 Installation Guide



C.38

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the University of California nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ASM

Copyright (c) 2000-2005, INRIA, France Telecom
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 1S”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Third-Party Materials 217



C.9

Firebug Lite

Copyright (c) 2006-2007, Joe Hewitt
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 1IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Documentation Updates

Changes made to this guide since the initial release of Vibe 4.0 are listed below.

Section Changed Summary of Changes

no changes
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